Contents

1 Introduction .................................................................................................................. 11
  1.1 Target group ............................................................................................................. 11
  1.2 Industrial robot documentation ............................................................................... 11
  1.3 Representation of warnings and notes .................................................................... 11
  1.4 Trademarks .............................................................................................................. 12

2 Product description ...................................................................................................... 13
  2.1 Overview of the industrial robot ............................................................................ 13
  2.2 Overview of KUKA System Software (KSS) ......................................................... 13
  2.3 System requirements ............................................................................................. 14
  2.4 Intended use of the KUKA System Software ......................................................... 14
  2.5 KUKA USB sticks .................................................................................................. 14

3 Safety ........................................................................................................................... 17
  3.1 General .................................................................................................................... 17
  3.1.1 Liability ............................................................................................................... 17
  3.1.2 Intended use of the industrial robot ................................................................... 17
  3.1.3 EC declaration of conformity and declaration of incorporation ....................... 18
  3.1.4 Terms used ......................................................................................................... 18
  3.2 Personnel ................................................................................................................ 20
  3.3 Workspace, safety zone and danger zone ............................................................. 22
  3.4 Triggers for stop reactions ..................................................................................... 22
  3.5 Safety functions ..................................................................................................... 23
    3.5.1 Overview of the safety functions ...................................................................... 23
    3.5.2 Safety controller ............................................................................................. 24
    3.5.3 Mode selection ............................................................................................... 24
    3.5.4 Operator safety ............................................................................................... 25
    3.5.5 EMERGENCY STOP device .......................................................................... 25
    3.5.6 Logging off from the higher-level safety controller ....................................... 26
    3.5.7 External EMERGENCY STOP device ............................................................ 26
    3.5.8 Enabling device ............................................................................................. 27
    3.5.9 External enabling device ................................................................................. 27
    3.5.10 External safe operational stop ....................................................................... 27
    3.5.11 External safety stop 1 and external safety stop 2 ........................................ 27
    3.5.12 Velocity monitoring in T1 and CRR .............................................................. 28
  3.6 Additional protective equipment ............................................................................. 28
    3.6.1 Jog mode .......................................................................................................... 28
    3.6.2 Software limit switches .................................................................................... 28
    3.6.3 Mechanical end stops ..................................................................................... 28
    3.6.4 Mechanical axis range limitation (optional) .................................................. 28
    3.6.5 Axis range monitoring (optional) .................................................................... 29
    3.6.6 Devices for moving the manipulator without the robot controller (options) ...... 29
    3.6.7 Labeling on the industrial robot ...................................................................... 30
    3.6.8 External safeguards ......................................................................................... 31
  3.7 Overview of operating modes and safety functions ............................................... 31
  3.8 Safety measures ..................................................................................................... 32
    3.8.1 General safety measures ............................................................................... 32
4 Operation ............................................................................................................. 43

4.1 KUKA smartPAD teach pendant ........................................................................ 43
  4.1.1 Front view ............................................................................................................. 43
  4.1.2 Rear view ............................................................................................................. 45
  4.1.3 Disconnecting and connecting the smartPAD ...................................................... 46

4.2 KUKA smartHMI user interface ........................................................................... 47
  4.2.1 Status bar ............................................................................................................. 48
  4.2.2 “Submit interpreter” status indicator ..................................................................... 49
  4.2.3 Keypad ................................................................................................................. 50

4.3 Switching on the robot controller and starting the KSS ........................................... 50

4.4 Calling the main menu ........................................................................................... 50

4.5 Exiting or restarting KSS ........................................................................................ 51

4.6 Switching the robot controller off ........................................................................... 54

4.7 Setting the user interface language ......................................................................... 54

4.8 Online documentation and online help .................................................................... 55
  4.8.1 Calling online documentation ............................................................................... 55
  4.8.2 Calling online help ............................................................................................... 55

4.9 Changing user group ............................................................................................... 58

4.10 Changing operating mode ...................................................................................... 59

4.11 Coordinate systems ............................................................................................... 60

4.12 Jogging the robot .................................................................................................... 61
  4.12.1 "Jog options" window .......................................................................................... 62
    4.12.1.1 "General" tab .................................................................................................... 63
    4.12.1.2 "Keys" tab ......................................................................................................... 63
    4.12.1.3 "Mouse" tab ....................................................................................................... 64
    4.12.1.4 "KCP pos." tab .................................................................................................. 65
    4.12.1.5 "Cur. tool/base" tab .......................................................................................... 65
  4.12.2 Activating the jog mode ....................................................................................... 66
  4.12.3 Setting the jog override (HOV) ........................................................................... 66
  4.12.4 Selecting the tool and base ................................................................................ 66
  4.12.5 Axis-specific jogging with the jog keys ................................................................. 67
  4.12.6 Cartesian jogging with the jog keys ..................................................................... 67
  4.12.7 Configuring the Space Mouse ............................................................................. 67
  4.12.8 Defining the alignment of the Space Mouse ......................................................... 69
  4.12.9 Cartesian jogging with the Space Mouse ............................................................. 70
  4.12.10 Incremental jogging .......................................................................................... 71
  4.12.11 Jogging external axes ......................................................................................... 72
5 Start-up and recommissioning

5.1 Start-up wizard
5.2 Checking the machine data
5.3 Jogging the robot without a higher-level safety controller
5.4 Checking the activation of the positionally accurate robot model
5.5 Mastering
5.6 Modifying software limit switches
5.7 Calibration
5.8 Manually unmastering axes
5.9 Modifying external axes
5.10 Reference mastering
5.11 Mastering with the MEMD and mark
5.12 First mastering (with MEMD)
5.13 Teach offset (with MEMD)
5.14 Check load mastering with offset (with MEMD)
5.15 Mastering with the dial gauge
5.16 Mastering with the EMD
5.17 Moving axes to the pre-mastering position
5.18 Mastering with the EMD
5.19 First mastering (with EMD)
5.20 Teach offset (with EMD)
5.21 Check load mastering with offset (with EMD)
5.22 Mastering methods
5.23 Moving axes to the pre-mastering position
5.24 Mastering with the EMD
5.25 First mastering (with EMD)
5.26 Teach offset (with EMD)
5.27 Check load mastering with offset (with EMD)
5.28 Mastering methods
5.29 Moving axes to the pre-mastering position
5.30 Mastering with the EMD
5.31 First mastering (with EMD)
5.32 Teach offset (with EMD)
5.33 Check load mastering with offset (with EMD)
5.34 Mastering methods
5.35 Moving axes to the pre-mastering position
5.36 Mastering with the EMD
5.37 First mastering (with EMD)
5.38 Teach offset (with EMD)
5.39 Check load mastering with offset (with EMD)
5.7.4 Renaming the tool/base .......................................................... 122
5.7.5 Linear unit .............................................................................. 123
5.7.5.1 Checking whether the linear unit needs to be calibrated .......... 123
5.7.5.2 Calibrating the linear unit .................................................... 124
5.7.5.3 Entering the linear unit numerically ...................................... 125
5.7.6 Calibrating an external kinematic system ............................... 126
5.7.6.2 Entering the root point numerically ...................................... 127
5.7.6.3 Workpiece base calibration .................................................. 128
5.7.6.4 Entering the workpiece base numerically .............................. 130
5.7.6.5 Calibrating an external tool .................................................. 130
5.7.6.6 Entering the external tool numerically ................................... 131
5.7.6.7 Entering the external tool numerically ................................... 131
5.7.6.8 Entering the external tool numerically ................................... 131
5.7.7 Load data .............................................................................. 132
5.7.7.1 Checking loads with KUKA.Load ......................................... 132
5.7.7.2 Calculating payloads with KUKA.LoadDataDetermination ....... 132
5.7.7.3 Entering payload data .......................................................... 132
5.7.7.4 Entering supplementary load data ........................................ 133
5.7.7.5 Online load data check ......................................................... 133
5.9 Exporting/importing long texts .................................................. 134
5.10 Maintenance handbook ........................................................... 136
5.10.1 Logging maintenance ......................................................... 136
5.10.2 Displaying a maintenance log ................................................. 137

6 Program management ................................................................. 139
6.1 Navigator file manager ............................................................. 139
6.1.1 Selecting filters ...................................................................... 140
6.1.2 Creating a new folder ............................................................. 140
6.1.3 Creating a new program ........................................................ 141
6.1.4 Renaming a file ...................................................................... 141
6.2 Selecting or opening a program ............................................... 141
6.2.1 Selecting and deselecting a program ....................................... 142
6.2.2 Opening a program ............................................................... 143
6.2.3 Toggling between the Navigator and the program ..................... 143
6.3 Structure of a KRL program ..................................................... 144
6.3.1 HOME position .................................................................... 145
6.4 Displaying/hiding program sections .......................................... 145
6.4.1 Displaying/hiding the DEF line ............................................. 145
6.4.2 Activating detail view ............................................................ 145
6.4.3 Activating/deactivating the line break function ......................... 146
6.5 Starting a program ................................................................. 146
6.5.1 Selecting the program run mode ............................................. 146
6.5.2 Program run modes .............................................................. 146
6.5.3 Advance run ......................................................................... 147
6.5.4 Setting the program override (POV) ....................................... 147
6.5.5 Switching drives on/off ......................................................... 147
6.5.6 Robot interpreter status indicator .......................................... 148
6.5.7 Starting a program forwards (manual) ..................................... 148
## Contents

7 Basic principles of motion programming ........................................ 159
  7.1 Overview of motion types ...................................................... 159
  7.2 Motion type PTP ................................................................. 159
  7.3 Motion type LIN ................................................................. 160
  7.4 Motion type CIRC ............................................................... 160
  7.5 Approximate positioning ..................................................... 161
  7.6 Orientation control LIN, CIRC .......................................... 162
  7.7 Motion type “Spline” .......................................................... 163
    7.7.1 Velocity profile for spline motions ................................. 165
    7.7.2 Block selection with spline motions ............................... 166
    7.7.3 Modifications to spline blocks ................................... 167
    7.7.4 Approximation of spline motions ................................. 170
    7.7.5 Replacing an approximated CP motion with a spline block 170
    7.7.5.1 SLIN-SPL-SLIN transition ....................................... 173
  7.8 Orientation control for CP spline motions .............................. 174
    7.8.1 Combinations of “Orientation control” and “Circle orientation control” 176
  7.9 Singularities ....................................................................... 177

8 Programming for user group “User” (inline forms) ......................... 179
  8.1 Names in inline forms ......................................................... 179
  8.2 Programming PTP, LIN and CIRC motions ............................ 179
    8.2.1 Programming a PTP motion ........................................ 179
    8.2.2 Inline form “PTP” ....................................................... 180
    8.2.3 Programming a LIN motion ........................................ 180
    8.2.4 Inline form “LIN” ....................................................... 181
    8.2.5 Programming a CIRC motion ...................................... 181
    8.2.6 Inline form “CIRC” .................................................... 182
    8.2.7 Option window “Frames” ............................................ 182
    8.2.8 Option window “Motion parameters” (LIN, CIRC, PTP) 183
  8.3 Programming spline motions ................................................ 184
    8.3.1 Programming tips for spline motions ............................ 184
8.3.2 Programming a spline block ................................................................. 185
8.3.2.1 Inline form for CP spline block ......................................................... 186
8.3.2.2 Inline form “PTP SPLINE block” ....................................................... 187
8.3.2.3 Option window “Frames” (CP and PTP spline block) ......................... 187
8.3.2.4 Option window “Motion parameters” (CP spline block) ..................... 188
8.3.2.5 Option window “Motion parameters” (PTP spline block) ..................... 189
8.3.3 Programming segments for a spline block ............................................ 189
8.3.3.1 Programming an SPL or SLIN segment ............................................. 189
8.3.3.2 Programming an SCIRC segment ...................................................... 190
8.3.3.3 Inline form for CP spline segment ..................................................... 190
8.3.3.4 Programming an SPTP segment ....................................................... 191
8.3.3.5 Inline form for SPTP segment ........................................................... 191
8.3.3.6 Option window “Frames” (CP and PTP spline segments) ................... 193
8.3.3.7 Option window “Motion parameters” (CP spline segment) ................. 193
8.3.3.8 Option window “Motion parameters” (SPTP) ..................................... 194
8.3.4 Programming individual spline motions ............................................. 199
8.3.4.1 Programming an individual SLIN motion ........................................... 199
8.3.4.2 Inline form “SLIN” ........................................................................... 199
8.3.4.3 Option window “Motion parameters” (SLIN) .................................... 200
8.3.4.4 Programming an individual SCIRC motion ....................................... 201
8.3.4.5 Inline form “SCIRC” ........................................................................ 201
8.3.4.6 Option window “Motion parameters” (SCIRC) ................................. 203
8.3.4.7 Programming an individual SPTP motion ......................................... 204
8.3.4.8 Inline form “SPTP” ......................................................................... 204
8.3.5 Conditional stop .................................................................................. 205
8.3.5.1 Inline form “Spline Stop Condition” ................................................ 205
8.3.5.2 Stop condition: example and braking characteristics ....................... 207
8.3.6 Constant velocity range in the CP spline block .................................... 208
8.3.6.1 Block selection to the constant velocity range .................................... 208
8.3.6.2 Maximum limits .............................................................................. 209
8.4 Modifying motion parameters .............................................................. 210
8.5 Re-teaching a point .............................................................................. 210
8.6 Programming logic instructions ............................................................. 211
8.6.1 Inputs/outputs .................................................................................... 211
8.6.2 Setting a digital output - OUT ............................................................. 211
8.6.3 Inline form “OUT” ............................................................................. 211
8.6.4 Setting a pulse output - PULSE .......................................................... 212
8.6.5 Inline form “PULSE” .......................................................................... 212
8.6.6 Setting an analog output - ANOUT .................................................... 212
8.6.7 Inline form “ANOUT” (static) .............................................................. 213
8.6.8 Inline form “ANOUT” (dynamic) .......................................................... 213
8.6.9 Programming a wait time - WAIT ...................................................... 214
8.6.10 Inline form “WAIT” .......................................................................... 214
8.6.11 Programming a signal-dependent wait function - WAITFOR ............... 214
8.6.12 Inline form “WAITFOR” ................................................................. 215
8.6.13 Switching on the path - SYN OUT ................................................... 216
8.6.14 Inline form “SYN OUT”, option “START/END” ................................. 216
8.6.15 Inline form “SYN OUT”, option “PATH” ............................................ 219
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

- Basic knowledge of the industrial robot

For optimal use of our products, we recommend that our customers take part in a course of training at KUKA College. Information about the training program can be found at www.kuka.com or can be obtained directly from our subsidiaries.

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

- Documentation for the manipulator
- Documentation for the robot controller
- Operating and programming instructions for the KUKA System Software
- Documentation relating to options and accessories
- Parts catalog on storage medium

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety

These warnings are relevant to safety and must be observed.

⚠️ DANGER

These warnings mean that it is certain or highly probable that death or severe injuries will occur, if no precautions are taken.

⚠️ WARNING

These warnings mean that death or severe injuries may occur, if no precautions are taken.

⚠️ CAUTION

These warnings mean that minor injuries may occur, if no precautions are taken.

⚠️ NOTICE

These warnings mean that damage to property may occur, if no precautions are taken.

These warnings contain references to safety-relevant information or general safety measures. These warnings do not refer to individual hazards or individual precautionary measures.

This warning draws attention to procedures which serve to prevent or remedy emergencies or malfunctions:

⚠️ SAFETY INSTRUCTIONS

Procedures marked with this warning must be followed exactly.

Notes

These hints serve to make your work easier or contain references to further information.
1.4 Trademarks

Windows is a trademark of Microsoft Corporation.

WordPad is a trademark of Microsoft Corporation.
# Product description

## 2.1 Overview of the industrial robot

The industrial robot consists of the following components:

- Manipulator
- Robot controller
- Teach pendant
- Connecting cables
- Software
- Options, accessories

## 2.2 Overview of KUKA System Software (KSS)

### Description

The KUKA System Software (KSS) is responsible for all the basic operator control functions of the industrial robot.

- Path planning
- I/O management
- Data and file management
- etc.

Additional technology packages, containing application-specific instructions and configurations, can be installed.

### smartHMI

The user interface of the KUKA System Software is called KUKA smartHMI (smart Human-Machine Interface).

Features:

- User administration
2.3 System requirements

KSS 8.3 can be run on the following robot controller:
- KR C4
- with Windows Embedded Standard 7 V4.x
- and with 2 GB RAM

2.4 Intended use of the KUKA System Software

Use
The KUKA System Software is intended exclusively for the operation of a KUKA industrial robot or customer-specific kinematic system.

Each version of the KUKA System Software may be operated exclusively in accordance with the specified system requirements.

Misuse
Any use or application deviating from the intended use is deemed to be impermissible misuse. The manufacturer cannot be held liable for any damage resulting from such use. The risk lies entirely with the user.

Examples of such misuse include:
- Operation of a kinematic system that is neither a KUKA industrial robot nor a customer-specific kinematic system
- Operation of the KSS not in accordance with the specified system requirements

2.5 KUKA USB sticks

The following KUKA USB sticks exist for the KR C4 robot controller:

- **KUKA USB stick 2.0 NB 4 GB**
  - Not bootable
  - Art. no. 00-197-266

- **KUKA USB stick 2.0 Recovery 4 GB**
  - Bootable
  - Component of the product KUKA.RecoveryUSB 1.0, art. no. 00-198-642

If a task requires the use of a specific stick, this is indicated in the description of the task.
Fig. 2-2: KUKA USB stick 2.0 NB 4 GB, not bootable (art. no. 00-197-266)

Fig. 2-3: KUKA USB stick 2.0 Recovery 4 GB, bootable (art. no. 00-198-642)
3 Safety

3.1 General

3.1.1 Liability

The device described in this document is either an industrial robot or a component thereof.

Components of the industrial robot:

- Manipulator
- Robot controller
- Teach pendant
- Connecting cables
- External axes (optional)
  e.g. linear unit, turn-tilt table, positioner
- Software
- Options, accessories

The industrial robot is built using state-of-the-art technology and in accordance with the recognized safety rules. Nevertheless, misuse of the industrial robot may constitute a risk to life and limb or cause damage to the industrial robot and to other material property.

The industrial robot may only be used in perfect technical condition in accordance with its designated use and only by safety-conscious persons who are fully aware of the risks involved in its operation. Use of the industrial robot is subject to compliance with this document and with the declaration of incorporation supplied together with the industrial robot. Any functional disorders affecting safety must be rectified immediately.

Safety information

Safety information cannot be held against KUKA Roboter GmbH. Even if all safety instructions are followed, this is not a guarantee that the industrial robot will not cause personal injuries or material damage.

No modifications may be carried out to the industrial robot without the authorization of KUKA Roboter GmbH. Additional components (tools, software, etc.), not supplied by KUKA Roboter GmbH, may be integrated into the industrial robot. The user is liable for any damage these components may cause to the industrial robot or to other material property.

In addition to the Safety chapter, this document contains further safety instructions. These must also be observed.

3.1.2 Intended use of the industrial robot

The industrial robot is intended exclusively for the use designated in the “Purpose” chapter of the operating instructions or assembly instructions.

Further information is contained in the “Purpose” chapter of the operating instructions or assembly instructions of the industrial robot.

Using the industrial robot for any other or additional purpose is considered impermissible misuse. The manufacturer cannot be held liable for any damage resulting from such use. The risk lies entirely with the user.

Operating the industrial robot and its options within the limits of its intended use also involves observance of the operating and assembly instructions for
the individual components, with particular reference to the maintenance specifications.

**Misuse**

Any use or application deviating from the intended use is deemed to be impermissible misuse. This includes e.g.:

- Transportation of persons and animals
- Use as a climbing aid
- Operation outside the permissible operating parameters
- Use in potentially explosive environments
- Operation without additional safeguards
- Outdoor operation
- Underground operation

### 3.1.3 EC declaration of conformity and declaration of incorporation

This industrial robot constitutes partly completed machinery as defined by the EC Machinery Directive. The industrial robot may only be put into operation if the following preconditions are met:

- The industrial robot is integrated into a complete system.
  - Or: The industrial robot, together with other machinery, constitutes a complete system.
  - Or: All safety functions and safeguards required for operation in the complete machine as defined by the EC Machinery Directive have been added to the industrial robot.
- The complete system complies with the EC Machinery Directive. This has been confirmed by means of an assessment of conformity.

**Declaration of conformity**

The system integrator must issue a declaration of conformity for the complete system in accordance with the Machinery Directive. The declaration of conformity forms the basis for the CE mark for the system. The industrial robot must be operated in accordance with the applicable national laws, regulations and standards.

The robot controller is CE certified under the EMC Directive and the Low Voltage Directive.

**Declaration of incorporation**

The industrial robot as partly completed machinery is supplied with a declaration of incorporation in accordance with Annex II B of the EC Machinery Directive 2006/42/EC. The assembly instructions and a list of essential requirements complied with in accordance with Annex I are integral parts of this declaration of incorporation.

The declaration of incorporation declares that the start-up of the partly completed machinery remains impermissible until the partly completed machinery has been incorporated into machinery, or has been assembled with other parts to form machinery, and this machinery complies with the terms of the EC Machinery Directive, and the EC declaration of conformity is present in accordance with Annex II A.

The declaration of incorporation, together with its annexes, remains with the system integrator as an integral part of the technical documentation of the complete machinery.

### 3.1.4 Terms used

STOP 0, STOP 1 and STOP 2 are the stop definitions according to EN 60204-1:2006.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis range</td>
<td>Range of each axis, in degrees or millimeters, within which it may move. The axis range must be defined for each axis.</td>
</tr>
<tr>
<td>Stopping distance</td>
<td>Stopping distance = reaction distance + braking distance. The stopping distance is part of the danger zone.</td>
</tr>
<tr>
<td>Workspace</td>
<td>The manipulator is allowed to move within its workspace. The workspace is derived from the individual axis ranges.</td>
</tr>
<tr>
<td>Operator (User)</td>
<td>The user of the industrial robot can be the management, employer or delegated person responsible for use of the industrial robot.</td>
</tr>
<tr>
<td>Danger zone</td>
<td>The danger zone consists of the workspace and the stopping distances.</td>
</tr>
<tr>
<td>Service life</td>
<td>The service life of a safety-relevant component begins at the time of delivery of the component to the customer.</td>
</tr>
<tr>
<td></td>
<td>The service life is not affected by whether the component is used in a robot controller or elsewhere or not, as safety-relevant components are also subject to ageing during storage.</td>
</tr>
<tr>
<td>KCP</td>
<td>The KCP (KUKA Control Panel) teach pendant has all the operator control and display functions required for operating and programming the industrial robot.</td>
</tr>
<tr>
<td></td>
<td>The KCP variant for the KR C4 is called KUKA smartPAD. The general term “KCP”, however, is generally used in this documentation.</td>
</tr>
<tr>
<td>CRR</td>
<td>Controlled Robot Retraction</td>
</tr>
<tr>
<td></td>
<td>CRR is an operating mode only available when KUKA.SafeOperation or KUKA.SafeRangeMonitoring is used. If the robot has violated a monitoring function and been stopped by the safety controller, it can only be moved out of the violated area in CRR mode.</td>
</tr>
<tr>
<td>Manipulator</td>
<td>The robot arm and the associated electrical installations</td>
</tr>
<tr>
<td>Safety zone</td>
<td>The safety zone is situated outside the danger zone.</td>
</tr>
<tr>
<td>Safe operational stop</td>
<td>The safe operational stop is a standstill monitoring function. It does not stop the robot motion, but monitors whether the robot axes are stationary. If these are moved during the safe operational stop, a safety stop STOP 0 is triggered. The safe operational stop can also be triggered externally. When a safe operational stop is triggered, the robot controller sets an output to the field bus. The output is set even if not all the axes were stationary at the time of triggering, thereby causing a safety stop STOP 0 to be triggered.</td>
</tr>
<tr>
<td>Safety STOP 0</td>
<td>A stop that is triggered and executed by the safety controller. The safety controller immediately switches off the drives and the power supply to the brakes. <strong>Note:</strong> This stop is called safety STOP 0 in this document.</td>
</tr>
<tr>
<td>Safety STOP 1</td>
<td>A stop that is triggered and monitored by the safety controller. The braking process is performed by the non-safety-oriented part of the robot controller and monitored by the safety controller. As soon as the manipulator is at a standstill, the safety controller switches off the drives and the power supply to the brakes. When a safety STOP 1 is triggered, the robot controller sets an output to the field bus. The safety STOP 1 can also be triggered externally. <strong>Note:</strong> This stop is called safety STOP 1 in this document.</td>
</tr>
</tbody>
</table>
3.2 Personnel

The following persons or groups of persons are defined for the industrial robot:

- User
- Personnel

All persons working with the industrial robot must have read and understood the industrial robot documentation, including the safety chapter.

User

The user must observe the labor laws and regulations. This includes e.g.:

- The user must comply with his monitoring obligations.
- The user must carry out instructions at defined intervals.

Personnel

Personnel must be instructed, before any work is commenced, in the type of work involved and what exactly it entails as well as any hazards which may exist. Instruction must be carried out regularly. Instruction is also required after particular incidents or technical modifications.

Personnel includes:

- System integrator
Operators, subdivided into:
- Start-up, maintenance and service personnel
- Operating personnel
- Cleaning personnel

Installation, exchange, adjustment, operation, maintenance and repair must be performed only as specified in the operating or assembly instructions for the relevant component of the industrial robot and only by personnel specially trained for this purpose.

System integrator

The industrial robot is safely integrated into a complete system by the system integrator.

The system integrator is responsible for the following tasks:
- Installing the industrial robot
- Connecting the industrial robot
- Performing risk assessment
- Implementing the required safety functions and safeguards
- Issuing the declaration of conformity
- Attaching the CE mark
- Creating the operating instructions for the complete system

Operator

The operator must meet the following preconditions:
- The operator must be trained for the work to be carried out.
- Work on the industrial robot must only be carried out by qualified personnel. These are people who, due to their specialist training, knowledge and experience, and their familiarization with the relevant standards, are able to assess the work to be carried out and detect any potential hazards.

Example

The tasks can be distributed as shown in the following table.

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Operator</th>
<th>Programmer</th>
<th>System integrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch robot controller on/off</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Start program</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Select program</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Select operating mode</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Calibration (tool, base)</td>
<td>x</td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Master the manipulator</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Programming</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Start-up</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Repair</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decommissioning</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Transportation</td>
<td></td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>

Work on the electrical and mechanical equipment of the industrial robot may only be carried out by specially trained personnel.
3.3   Workspace, safety zone and danger zone

Workspaces are to be restricted to the necessary minimum size. A workspace must be safeguarded using appropriate safeguards.

The safeguards (e.g. safety gate) must be situated inside the safety zone. In the case of a stop, the manipulator and external axes (optional) are braked and come to a stop within the danger zone.

The danger zone consists of the workspace and the stopping distances of the manipulator and external axes (optional). It must be safeguarded by means of physical safeguards to prevent danger to persons or the risk of material damage.

Fig. 3-1: Example of axis range A1

1    Workspace      3    Stopping distance
2    Manipulator    4    Safety zone

3.4   Triggers for stop reactions

Stop reactions of the industrial robot are triggered in response to operator actions or as a reaction to monitoring functions and error messages. The following tables show the different stop reactions according to the operating mode that has been set.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>T1, T2, CRR</th>
<th>AUT, AUT EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start key released</td>
<td>STOP 2</td>
<td></td>
</tr>
<tr>
<td>STOP key pressed</td>
<td>STOP 2</td>
<td></td>
</tr>
<tr>
<td>Drives OFF</td>
<td>STOP 1</td>
<td></td>
</tr>
<tr>
<td>“Motion enable” input drops out</td>
<td>STOP 2</td>
<td></td>
</tr>
<tr>
<td>Robot controller switched off (power failure)</td>
<td>STOP 0</td>
<td></td>
</tr>
<tr>
<td>Internal error in non-safety-oriented part of the robot controller</td>
<td>STOP 0 or STOP 1 (dependent on the cause of the error)</td>
<td></td>
</tr>
</tbody>
</table>
3.5 Safety functions

3.5.1 Overview of the safety functions

The following safety functions are present in the industrial robot:

- Mode selection
- Operator safety (= connection for the guard interlock)
- EMERGENCY STOP device
- Enabling device
- External safe operational stop
- External safety stop 1 (not for the controller variant “KR C4 compact”)
- External safety stop 2
- Velocity monitoring in T1

The safety functions of the industrial robot meet the following requirements:

- **Category 3** and **Performance Level d** in accordance with EN ISO 13849-1:2008
- **SIL 2** according to EN 62061

The requirements are only met on the following condition, however:

- The EMERGENCY STOP device is pressed at least once every 6 months.

The following components are involved in the safety functions:

- Safety controller in the control PC
- KUKA Control Panel (KUKA smartPAD)
- Cabinet Control Unit (CCU)
- Resolver Digital Converter (RDC)
- KUKA Power Pack (KPP)
- KUKA Servo Pack (KSP)
- Safety Interface Board (SIB) (if used)

There are also interfaces to components outside the industrial robot and to other robot controllers.

In the absence of operational safety functions and safeguards, the industrial robot can cause personal injury or material damage. If safety functions or safeguards are dismantled or deactivated, the industrial robot may not be operated.
3.5.2 Safety controller

The safety controller is a unit inside the control PC. It links safety-relevant signals and safety-relevant monitoring functions.

Safety controller tasks:
- Switching off the drives; applying the brakes
- Monitoring the braking ramp
- Standstill monitoring (after the stop)
- Velocity monitoring in T1
- Evaluation of safety-relevant signals
- Setting of safety-oriented outputs

3.5.3 Mode selection

The industrial robot can be operated in the following modes:
- Manual Reduced Velocity (T1)
- Manual High Velocity (T2)
- Automatic (AUT)
- Automatic External (AUT EXT)
- CRR

During system planning, the safety functions of the overall system must also be planned and designed. The industrial robot must be integrated into this safety system of the overall system.

Do not change the operating mode while a program is running. If the operating mode is changed during program execution, the industrial robot is stopped with a safety stop 2.

<table>
<thead>
<tr>
<th>Operating mode</th>
<th>Use</th>
<th>Velocities</th>
</tr>
</thead>
</table>
| **T1**         | For test operation, programming and teaching | Program verification: Programmed velocity, maximum 250 mm/s  
|                |     | Jog mode: Jog velocity, maximum 250 mm/s |
| **T2**         | For test operation | Program verification: Programmed velocity  
|                |     | Jog mode: Not possible |
| **AUT**        | For industrial robots without higher-level controllers | Program mode: Programmed velocity  
|                |     | Jog mode: Not possible |
### 3.5.4 Operator safety

The operator safety signal is used for interlocking physical safeguards, e.g. safety gates. Automatic operation is not possible without this signal. In the event of a loss of signal during automatic operation (e.g. safety gate is opened), the manipulator stops with a safety stop 1.

Operator safety is not active in the modes T1 (Manual Reduced Velocity), T2 (Manual High Velocity) and CRR.

#### WARNING

Following a loss of signal, automatic operation must not be resumed merely by closing the safeguard; it must first additionally be acknowledged. It is the responsibility of the system integrator to ensure this. This is to prevent automatic operation from being resumed inadvertently while there are still persons in the danger zone, e.g. due to the safety gate closing accidentally.

- The acknowledgement must be designed in such a way that an actual check of the danger zone can be carried out first. Acknowledgement functions that do not allow this (e.g. because they are automatically triggered by closure of the safeguard) are not permissible.
- Failure to observe this may result in death to persons, severe injuries or considerable damage to property.

### 3.5.5 EMERGENCY STOP device

The EMERGENCY STOP device for the industrial robot is the EMERGENCY STOP device on the KCP. The device must be pressed in the event of a hazardous situation or emergency.

Reactions of the industrial robot if the EMERGENCY STOP device is pressed:

- The manipulator and any external axes (optional) are stopped with a safety stop 1.

Before operation can be resumed, the EMERGENCY STOP device must be turned to release it.

#### WARNING

Tools and other equipment connected to the manipulator must be integrated into the EMERGENCY STOP circuit on the system side if they could constitute a potential hazard.

Failure to observe this precaution may result in death, severe injuries or considerable damage to property.

There must always be at least one external EMERGENCY STOP device installed. This ensures that an EMERGENCY STOP device is available even when the KCP is disconnected.
3.5.6 Logging off from the higher-level safety controller

If the robot controller is connected to a higher-level safety controller, this connection will inevitably be terminated in the following cases:

- Switching off of the robot controller via the main switch or due to a power failure
  In this case, it does not matter whether the Cold start or Hibernate start type has been selected.
- Shutdown of the robot controller via the smartHMI
- Activation of a WorkVisual project in WorkVisual or directly on the robot controller
- Changes to Start-up > Network configuration
- Changes to Configuration > Safety configuration
- I/O drivers > Reconfigure
- Restoration of an archive

Effect of the interruption:

- If the X11 interface is used, this triggers an EMERGENCY STOP for the overall system.
- If the Ethernet interface is used, the KUKA safety controller generates a signal that prevents the higher-level controller from triggering an EMERGENCY STOP for the overall system.

**WARNING** If the Ethernet safety interface is used: In his risk assessment, the system integrator must take into consideration whether the fact that switching off the robot controller does not trigger an EMERGENCY STOP of the overall system could constitute a hazard and, if so, how this hazard can be countered. Failure to take this into consideration may result in death to persons, severe injuries or considerable damage to property.

**WARNING** If a robot controller is switched off, the E-STOP device on the KCP is no longer functional. The user is responsible for ensuring that the KCP is either covered or removed from the system. This serves to prevent operational and non-operational EMERGENCY STOP devices from becoming interchanged. Failure to observe this precaution may result in death to persons, severe injuries or considerable damage to property.

3.5.7 External EMERGENCY STOP device

There must be EMERGENCY STOP devices available at every operator station that can initiate a robot motion or other potentially hazardous situation. The system integrator is responsible for ensuring this.

There must always be at least one external EMERGENCY STOP device installed. This ensures that an EMERGENCY STOP device is available even when the KCP is disconnected.

External EMERGENCY STOP devices are connected via the customer interface. External EMERGENCY STOP devices are not included in the scope of supply of the industrial robot.
3.5.8 Enabling device

The enabling devices of the industrial robot are the enabling switches on the KCP.

There are 3 enabling switches installed on the KCP. The enabling switches have 3 positions:
- Not pressed
- Center position
- Panic position

In the test modes and in CRR, the manipulator can only be moved if one of the enabling switches is held in the central position.

- Releasing the enabling switch triggers a safety stop 2.
- Pressing the enabling switch down fully (panic position) triggers a safety stop 1.
- It is possible, for a short time, to hold 2 enabling switches in the center position simultaneously. This makes it possible to adjust grip from one enabling switch to another one. If 2 enabling switches are held simultaneously in the center position for a longer period of time, this triggers a safety stop after several seconds.

If an enabling switch malfunctions (jams), the industrial robot can be stopped using the following methods:
- Press the enabling switch down fully
- Actuate the EMERGENCY STOP system
- Release the Start key

**WARNING**
The enabling switches must not be held down by adhesive tape or other means or manipulated in any other way. Death, injuries or damage to property may result.

3.5.9 External enabling device

External enabling devices are required if it is necessary for more than one person to be in the danger zone of the industrial robot. They are connected to the robot controller via an interface.

External enabling devices are not included in the scope of supply of the industrial robot.

3.5.10 External safe operational stop

The safe operational stop can be triggered via an input on the customer interface. The state is maintained as long as the external signal is FALSE. If the external signal is TRUE, the manipulator can be moved again. No acknowledgement is required.

3.5.11 External safety stop 1 and external safety stop 2

Safety stop 1 and safety stop 2 can be triggered via an input on the customer interface. The state is maintained as long as the external signal is FALSE. If
If the external signal is TRUE, the manipulator can be moved again. No acknowledgement is required.

No external safety stop 1 is available for the controller variant "KR C4 compact".

3.5.12 Velocity monitoring in T1 and CRR

The velocity at the TCP is monitored in the T1 and CRR modes. If, due to an error, the velocity exceeds 250 mm/s, a safety stop 0 is triggered.

3.6 Additional protective equipment

3.6.1 Jog mode

In the operating modes T1 (Manual Reduced Velocity), T2 (Manual High Velocity) and CRR, the robot controller can only execute programs in jog mode. This means that it is necessary to hold down an enabling switch and the Start key in order to execute a program.

- Releasing the enabling switch triggers a safety stop 2.
- Pressing the enabling switch down fully (panic position) triggers a safety stop 1.
- Releasing the Start key triggers a STOP 2.

3.6.2 Software limit switches

The axis ranges of all manipulator and positioner axes are limited by means of adjustable software limit switches. These software limit switches only serve as machine protection and must be adjusted in such a way that the manipulator/positioner cannot hit the mechanical end stops.

The software limit switches are set during commissioning of an industrial robot.

Further information is contained in the operating and programming instructions.

3.6.3 Mechanical end stops

Depending on the robot variant, the axis ranges of the main and wrist axes of the manipulator are partially limited by mechanical end stops.

Additional mechanical end stops can be installed on the external axes.

If the manipulator or an external axis hits an obstruction or a mechanical end stop or axis range limitation, this can result in material damage to the industrial robot. The manipulator must be taken out of operation and KUKA Roboter GmbH must be consulted before it is put back into operation (>>> 10 "KUKA Service" Page 225).

3.6.4 Mechanical axis range limitation (optional)

Some manipulators can be fitted with mechanical axis range limitation in axes A1 to A3. The adjustable axis range limitation systems restrict the working
range to the required minimum. This increases personal safety and protection of the system.

In the case of manipulators that are not designed to be fitted with mechanical axis range limitation, the workspace must be laid out in such a way that there is no danger to persons or material property, even in the absence of mechanical axis range limitation.

If this is not possible, the workspace must be limited by means of photoelectric barriers, photoelectric curtains or obstacles on the system side. There must be no shearing or crushing hazards at the loading and transfer areas.

3.6.5 Axis range monitoring (optional)

Some manipulators can be fitted with dual-channel axis range monitoring systems in main axes A1 to A3. The positioner axes may be fitted with additional axis range monitoring systems. The safety zone for an axis can be adjusted and monitored using an axis range monitoring system. This increases personal safety and protection of the system.

3.6.6 Devices for moving the manipulator without the robot controller (options)

Description

The following devices are available for moving the manipulator after an accident or malfunction:

- Release device
  The release device can be used for the main axis drive motors and, depending on the robot variant, also for the wrist axis drive motors.

- Brake release device
  The brake release device is designed for robot variants whose motors are not freely accessible.

The devices are only for use in exceptional circumstances and emergencies, e.g. for freeing people.

Procedure

Moving the manipulator with the release device:

1. Switch off the robot controller and secure it (e.g. with a padlock) to prevent unauthorized persons from switching it on again.
2. Remove the protective cap from the motor.

This option is not available for all robot models. Information on specific robot models can be obtained from KUKA Roboter GmbH.

These options are not available for all robot models. Information on specific robot models can be obtained from KUKA Roboter GmbH.

CAUTION

The motors reach temperatures during operation which can cause burns to the skin. Contact must be avoided. Appropriate safety precautions must be taken, e.g. protective gloves must be worn.

These options are not available for all robot models. Information on specific robot models can be obtained from KUKA Roboter GmbH.

These options are not available for all robot models. Information on specific robot models can be obtained from KUKA Roboter GmbH.

These options are not available for all robot models. Information on specific robot models can be obtained from KUKA Roboter GmbH.
3. Push the release device onto the corresponding motor and move the axis in the desired direction.
   The directions are indicated with arrows on the motors. It is necessary to overcome the resistance of the mechanical motor brake and any other loads acting on the axis.

**WARNING** Moving an axis with the release device can damage the motor brake. This can result in personal injury and material damage. After using the release device, the motor must be exchanged.

**WARNING** If a robot axis has been moved by the release device, all robot axes must be remastered. Serious injuries or damage to property may otherwise result.

### Procedure

**Moving the manipulator with the brake release device:**

**WARNING** Use of the brake release device may result in unexpected robot motions, especially sagging of the axes. During use of the brake release device, attention must be paid to motion of this kind in order to be able to prevent physical injuries or damage to property. Standing under moving axes is not permitted.

**SAFETY INSTRUCTIONS** The following procedure must be followed exactly!

1. Switch off the robot controller and secure it (e.g. with a padlock) to prevent unauthorized persons from switching it on again.

2. Connect the brake release device to the base frame of the robot:

3. Select the brakes to be released (main axes, wrist axes) via the selection switch on the brake release device.

4. Press the button on the hand-held device.
   - The brakes of the main axes or wrist axes are released and the robot can be moved manually.

**Further information about the brake release device can be found in the documentation for the brake release device.**

### 3.6.7 Labeling on the industrial robot

All plates, labels, symbols and marks constitute safety-relevant parts of the industrial robot. They must not be modified or removed.

Labeling on the industrial robot consists of:
- Identification plates
- Warning labels
- Safety symbols
- Designation labels
- Cable markings
- Rating plates

**Further information is contained in the technical data of the operating instructions or assembly instructions of the components of the industrial robot.**
3.6.8 External safeguards

The access of persons to the danger zone of the industrial robot must be prevented by means of safeguards. It is the responsibility of the system integrator to ensure this.

Physical safeguards must meet the following requirements:
- They meet the requirements of EN 953.
- They prevent access of persons to the danger zone and cannot be easily circumvented.
- They are sufficiently fastened and can withstand all forces that are likely to occur in the course of operation, whether from inside or outside the enclosure.
- They do not, themselves, represent a hazard or potential hazard.
- The prescribed minimum clearance from the danger zone is maintained.

Safety gates (maintenance gates) must meet the following requirements:
- They are reduced to an absolute minimum.
- The interlocks (e.g. safety gate switches) are linked to the operator safety input of the robot controller via safety gate switching devices or safety PLC.
- Switching devices, switches and the type of switching conform to the requirements of Performance Level d and category 3 according to EN ISO 13849-1.
- Depending on the risk situation: the safety gate is additionally safeguarded by means of a locking mechanism that only allows the gate to be opened if the manipulator is safely at a standstill.
- The button for acknowledging the safety gate is located outside the space limited by the safeguards.

Further information is contained in the corresponding standards and regulations. These also include EN 953.

3.7 Overview of operating modes and safety functions

The following table indicates the operating modes in which the safety functions are active.

<table>
<thead>
<tr>
<th>Safety functions</th>
<th>T1, CRR</th>
<th>T2</th>
<th>AUT</th>
<th>AUT EXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator safety</td>
<td>-</td>
<td>-</td>
<td>active</td>
<td>active</td>
</tr>
<tr>
<td>EMERGENCY STOP device</td>
<td>active</td>
<td>active</td>
<td>active</td>
<td>active</td>
</tr>
<tr>
<td>Enabling device</td>
<td>active</td>
<td>active</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Reduced velocity during program verificaion</td>
<td>active</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Jog mode</td>
<td>active</td>
<td>active</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Software limit switches</td>
<td>active</td>
<td>active</td>
<td>active</td>
<td>active</td>
</tr>
</tbody>
</table>
3.8 Safety measures

3.8.1 General safety measures

The industrial robot may only be used in perfect technical condition in accordance with its intended use and only by safety-conscious persons. Operator errors can result in personal injury and damage to property.

It is important to be prepared for possible movements of the industrial robot even after the robot controller has been switched off and locked. Incorrect installation (e.g. overload) or mechanical defects (e.g. brake defect) can cause the manipulator or external axes to sag. If work is to be carried out on a switched-off industrial robot, the manipulator and external axes must first be moved into a position in which they are unable to move on their own, whether the payload is mounted or not. If this is not possible, the manipulator and external axes must be secured by appropriate means.

**DANGER**

In the absence of operational safety functions and safeguards, the industrial robot can cause personal injury or material damage. If safety functions or safeguards are dismantled or deactivated, the industrial robot may not be operated.

**WARNING**

Standing underneath the robot arm can cause death or serious injuries. For this reason, standing underneath the robot arm is prohibited!

**CAUTION**

The motors reach temperatures during operation which can cause burns to the skin. Contact must be avoided. Appropriate safety precautions must be taken, e.g. protective gloves must be worn.

**KCP**

The user must ensure that the industrial robot is only operated with the KCP by authorized persons.

If more than one KCP is used in the overall system, it must be ensured that each KCP is unambiguously assigned to the corresponding industrial robot. They must not be interchanged.

**WARNING**

The operator must ensure that decoupled KCPs are immediately removed from the system and stored out of sight and reach of personnel working on the industrial robot. This serves to prevent operational and non-operational EMERGENCY STOP devices from becoming interchanged. Failure to observe this precaution may result in death, severe injuries or considerable damage to property.

**Faults**

The following tasks must be carried out in the case of faults in the industrial robot:

- Switch off the robot controller and secure it (e.g. with a padlock) to prevent unauthorized persons from switching it on again.
- Indicate the fault by means of a label with a corresponding warning (tag-out).
- Keep a record of the faults.
- Eliminate the fault and carry out a function test.

**Modifications**

After modifications to the industrial robot, checks must be carried out to ensure the required safety level. The valid national or regional work safety regulations...
must be observed for this check. The correct functioning of all safety circuits must also be tested.

New or modified programs must always be tested first in Manual Reduced Velocity mode (T1).

After modifications to the industrial robot, existing programs must always be tested first in Manual Reduced Velocity mode (T1). This applies to all components of the industrial robot and includes modifications to the software and configuration settings.

3.8.2 Transportation

**Manipulator**

The prescribed transport position of the manipulator must be observed. Transportation must be carried out in accordance with the operating instructions or assembly instructions of the robot.

**Robot controller**

The prescribed transport position of the robot controller must be observed. Transportation must be carried out in accordance with the operating instructions or assembly instructions of the robot controller.

Avoid vibrations and impacts during transportation in order to prevent damage to the robot controller.

**External axis (optional)**

The prescribed transport position of the external axis (e.g. KUKA linear unit, turn-tilt table, positioner) must be observed. Transportation must be carried out in accordance with the operating instructions or assembly instructions of the external axis.

3.8.3 Start-up and recommissioning

Before starting up systems and devices for the first time, a check must be carried out to ensure that the systems and devices are complete and operational, that they can be operated safely and that any damage is detected.

The valid national or regional work safety regulations must be observed for this check. The correct functioning of all safety circuits must also be tested.

The passwords for the user groups must be changed in the KUKA System Software before start-up. The passwords must only be communicated to authorized personnel.

**DANGER**

The robot controller is preconfigured for the specific industrial robot. If cables are interchanged, the manipulator and the external axes (optional) may receive incorrect data and can thus cause personal injury or material damage. If a system consists of more than one manipulator, always connect the connecting cables to the manipulators and their corresponding robot controllers.

If additional components (e.g. cables), which are not part of the scope of supply of KUKA Roboter GmbH, are integrated into the industrial robot, the user is responsible for ensuring that these components do not adversely affect or disable safety functions.

**NOTICE**

If the internal cabinet temperature of the robot controller differs greatly from the ambient temperature, condensation can form, which may cause damage to the electrical components. Do not put the robot controller into operation until the internal temperature of the cabinet has adjusted to the ambient temperature.
**Function test**

The following tests must be carried out before start-up and recommissioning:

**General test:**

It must be ensured that:

- The industrial robot is correctly installed and fastened in accordance with the specifications in the documentation.
- There are no foreign bodies or loose parts on the industrial robot.
- All required safety equipment is correctly installed and operational.
- The power supply ratings of the industrial robot correspond to the local supply voltage and mains type.
- The ground conductor and the equipotential bonding cable are sufficiently rated and correctly connected.
- The connecting cables are correctly connected and the connectors are locked.

**Test of the safety functions:**

A function test must be carried out for the following safety functions to ensure that they are functioning correctly:

- Local EMERGENCY STOP device
- External EMERGENCY STOP device (input and output)
- Enabling device (in the test modes)
- Operator safety
- All other safety-relevant inputs and outputs used
- Other external safety functions

**3.8.3.1 Checking machine data and safety-relevant control configuration**

**WARNING**

The industrial robot must not be moved if incorrect machine data are loaded. Death, severe injuries or considerable damage to property may otherwise result. The correct machine data must be loaded.

- It must be ensured that the rating plate on the robot controller has the same machine data as those entered in the declaration of incorporation.
- The machine data on the rating plate of the manipulator and the external axes (optional) must be entered during start-up.
- The practical tests for the machine data must be carried out within the scope of the start-up procedure.
- Following modifications to the machine data, the safety configuration must always be checked.
- If changes are made to the machine data when checking the safety configuration (regardless of the reason for the safety configuration check), the practical tests for the machine data must be carried out.

Information about checking the safety configuration is contained in the Operating and Programming Instructions for System Integrators.

If the practical tests are not successfully completed in the initial start-up, KUKA Roboter GmbH must be contacted.

If the practical test is not successfully completed during a different procedure, the machine data must be checked and corrected.

**General practical test**

If practical tests are required for the machine data, this test must always be carried out.

The following methods are available for performing the practical test:
- TCP calibration with the XYZ 4-point method
  The practical test is passed if the TCP has been successfully calibrated.

Or:
1. Align the TCP with a freely selected point.
   The point serves as a reference point. It must be located so that reorientation is possible.
2. Move the TCP manually at least 45° once in each of the A, B and C directions.
   The movements do not have to be accumulative, i.e. after motion in one direction it is possible to return to the original position before moving in the next direction.
   The practical test is passed if the TCP does not deviate from the reference point by more than 2 cm in total.

Practical test for axes that are not mathematically coupled
If practical tests are required for the machine data, this test must be carried out when axes are present that are not mathematically coupled.
1. Mark the starting position of the axis that is not mathematically coupled.
2. Move the axis manually by a freely selected path length. Determine the path length from the display Actual position on the smartHMI.
   - Move linear axes a specific distance.
   - Move rotational axes through a specific angle.
3. Measure the length of the path covered and compare it with the value displayed on the smartHMI.
   The practical test is passed if the values differ by no more than 10%.
4. Repeat the test for each axis that is not mathematically coupled.

Practical test for couplable axes
If practical tests are required for the machine data, this test must be carried out when axes are present that can be physically coupled and uncoupled, e.g. a servo gun.
1. Physically uncouple the couplable axis.
2. Move all the remaining axes individually.
   The practical test is passed if it has been possible to move all the remaining axes.

3.8.3.2 Start-up mode

Description
The industrial robot can be set to Start-up mode via the smartHMI user interface. In this mode, the manipulator can be moved in T1 or CRR mode in the absence of the safety periphery.

- If the X11 interface is used:
  Start-up mode is always possible if all input signals have the state “logic zero”. If this is not the case, the robot controller prevents or terminates Start-up mode.

- If the Ethernet safety interface is used:
  If a connection to a higher-level safety system exists or is established, the robot controller prevents or terminates Start-up mode.

Hazards
Possible hazards and risks involved in using Start-up mode:

- A person walks into the manipulator’s danger zone.
- An unauthorized person moves the manipulator.
- In a hazardous situation, a disabled external EMERGENCY STOP device is actuated and the manipulator is not shut down.
Additional measures for avoiding risks in Start-up mode:

- Cover disabled EMERGENCY STOP devices or attach a warning sign indicating that the EMERGENCY STOP device is out of operation.
- If there is no safety fence, other measures must be taken to prevent persons from entering the manipulator’s danger zone, e.g. use of warning tape.
- Use of Start-up mode must be minimized – and avoided where possible – by means of organizational measures.

**Use**

Intended use of Start-up mode:

- Only service personnel who have received safety instruction may use Start-up mode.
- Start-up in T1 mode or CRR mode when the external safeguards have not yet been installed or put into operation. The danger zone must be delimited at least by means of warning tape.
- Fault localization (periphery fault).

**Misuse**

Any use or application deviating from the designated use is deemed to be impermissible misuse. This includes, for example, use by any other personnel. KUKA Roboter GmbH accepts no liability for damage or injury caused thereby. The risk lies entirely with the user.

**3.8.4 Manual mode**

Manual mode is the mode for setup work. Setup work is all the tasks that have to be carried out on the industrial robot to enable automatic operation. Setup work includes:

- Jog mode
- Teach
- Programming
- Program verification

The following must be taken into consideration in manual mode:

- If the drives are not required, they must be switched off to prevent the manipulator or the external axes (optional) from being moved unintentionally.
  - New or modified programs must always be tested first in Manual Reduced Velocity mode (T1).
- The manipulator, tooling or external axes (optional) must never touch or project beyond the safety fence.
- Workpieces, tooling and other objects must not become jammed as a result of the industrial robot motion, nor must they lead to short-circuits or be liable to fall off.
- All setup work must be carried out, where possible, from outside the safeguarded area.

If the setup work has to be carried out inside the safeguarded area, the following must be taken into consideration:
In **Manual Reduced Velocity mode (T1)**:
- If it can be avoided, there must be no other persons inside the safeguarded area.

If it is necessary for there to be several persons inside the safeguarded area, the following must be observed:
- Each person must have an enabling device.
- All persons must have an unimpeded view of the industrial robot.
- Eye-contact between all persons must be possible at all times.

- The operator must be so positioned that he can see into the danger area and get out of harm’s way.

In **Manual High Velocity mode (T2)**:
- This mode may only be used if the application requires a test at a velocity higher than Manual Reduced Velocity.
- Teaching and programming are not permissible in this operating mode.
- Before commencing the test, the operator must ensure that the enabling devices are operational.
- The operator must be positioned outside the danger zone.
- There must be no other persons inside the safeguarded area. It is the responsibility of the operator to ensure this.

### 3.8.5 Simulation

Simulation programs do not correspond exactly to reality. Robot programs created in simulation programs must be tested in the system in **Manual Reduced Velocity mode (T1)**. It may be necessary to modify the program.

### 3.8.6 Automatic mode

Automatic mode is only permissible in compliance with the following safety measures:
- All safety equipment and safeguards are present and operational.
- There are no persons in the system.
- The defined working procedures are adhered to.

If the manipulator or an external axis (optional) comes to a standstill for no apparent reason, the danger zone must not be entered until an EMERGENCY STOP has been triggered.

### 3.8.7 Maintenance and repair

After maintenance and repair work, checks must be carried out to ensure the required safety level. The valid national or regional work safety regulations must be observed for this check. The correct functioning of all safety circuits must also be tested.

The purpose of maintenance and repair work is to ensure that the system is kept operational or, in the event of a fault, to return the system to an operational state. Repair work includes troubleshooting in addition to the actual repair itself.

The following safety measures must be carried out when working on the industrial robot:
- Carry out work outside the danger zone. If work inside the danger zone is necessary, the user must define additional safety measures to ensure the safe protection of personnel.
Switch off the industrial robot and secure it (e.g. with a padlock) to prevent it from being switched on again. If it is necessary to carry out work with the robot controller switched on, the user must define additional safety measures to ensure the safe protection of personnel.

If it is necessary to carry out work with the robot controller switched on, this may only be done in operating mode T1.

Label the system with a sign indicating that work is in progress. This sign must remain in place, even during temporary interruptions to the work.

The EMERGENCY STOP systems must remain active. If safety functions or safeguards are deactivated during maintenance or repair work, they must be reactivated immediately after the work is completed.

**WARNING**

Before work is commenced on live parts of the robot system, the main switch must be turned off and secured against being switched on again. The system must then be checked to ensure that it is deenergized.

It is not sufficient, before commencing work on live parts, to execute an EMERGENCY STOP or a safety stop, or to switch off the drives, as this does not disconnect the robot system from the mains power supply in the case of the drives of the new generation. Parts remain energized. Death or severe injuries may result.

Faulty components must be replaced using new components with the same article numbers or equivalent components approved by KUKA Roboter GmbH for this purpose.

Cleaning and preventive maintenance work is to be carried out in accordance with the operating instructions.

**Robot controller**

Even when the robot controller is switched off, parts connected to peripheral devices may still carry voltage. The external power sources must therefore be switched off if work is to be carried out on the robot controller.

The ESD regulations must be adhered to when working on components in the robot controller.

Voltages in excess of 50 V (up to 780 V) can be present in various components for several minutes after the robot controller has been switched off! To prevent life-threatening injuries, no work may be carried out on the industrial robot in this time.

Water and dust must be prevented from entering the robot controller.

**Counterbalancing system**

Some robot variants are equipped with a hydropneumatic, spring or gas cylinder counterbalancing system.

The hydropneumatic and gas cylinder counterbalancing systems are pressure equipment and, as such, are subject to obligatory equipment monitoring. Depending on the robot variant, the counterbalancing systems correspond to category 0, II or III, fluid group 2, of the Pressure Equipment Directive.

The user must comply with the applicable national laws, regulations and standards pertaining to pressure equipment.

Inspection intervals in Germany in accordance with Industrial Safety Order, Sections 14 and 15. Inspection by the user before commissioning at the installation site.

The following safety measures must be carried out when working on the counterbalancing system:

- The manipulator assemblies supported by the counterbalancing systems must be secured.
- Work on the counterbalancing systems must only be carried out by qualified personnel.
Hazardous substances

The following safety measures must be carried out when handling hazardous substances:

- Avoid prolonged and repeated intensive contact with the skin.
- Avoid breathing in oil spray or vapors.
- Clean skin and apply skin cream.

⚠️ To ensure safe use of our products, we recommend that our customers regularly request up-to-date safety data sheets from the manufacturers of hazardous substances.

3.8.8 Decommissioning, storage and disposal

The industrial robot must be decommissioned, stored and disposed of in accordance with the applicable national laws, regulations and standards.

3.8.9 Safety measures for “single point of control”

Overview

If certain components in the industrial robot are operated, safety measures must be taken to ensure complete implementation of the principle of “single point of control” (SPOC).

Components:

- Submit interpreter
- PLC
- OPC Server
- Remote control tools
- Tools for configuration of bus systems with online functionality
- KUKA.RobotSensorInterface

⚠️ The implementation of additional safety measures may be required. This must be clarified for each specific application; this is the responsibility of the system integrator, programmer or user of the system.

Since only the system integrator knows the safe states of actuators in the periphery of the robot controller, it is his task to set these actuators to a safe state, e.g. in the event of an EMERGENCY STOP.

T1, T2, CRR

In the test modes T1, T2 and CRR, the components referred to above may only access the industrial robot if the following signals have the following states:

<table>
<thead>
<tr>
<th>Signal</th>
<th>State required for SPOC</th>
</tr>
</thead>
<tbody>
<tr>
<td>$USER_SAF</td>
<td>TRUE</td>
</tr>
<tr>
<td>$SPOC_MOTION_ENABLE</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

Submit interpreter, PLC

If motions, (e.g. drives or grippers) are controlled with the submit interpreter or the PLC via the I/O system, and if they are not safeguarded by other means, then this control will take effect even in T1, T2 and CRR modes or while an EMERGENCY STOP is active.

If variables that affect the robot motion (e.g. override) are modified with the submit interpreter or the PLC, this takes effect even in T1, T2 and CRR modes or while an EMERGENCY STOP is active.

Safety measures:

- In T1, T2 and CRR, the system variable $OV_PRO must not be written to by the submit interpreter or the PLC.
- Do not modify safety-relevant signals and variables (e.g. operating mode, EMERGENCY STOP, safety gate contact) via the submit interpreter or PLC.

If modifications are nonetheless required, all safety-relevant signals and variables must be linked in such a way that they cannot be set to a dangerous state by the submit interpreter or PLC.

**OPC server, remote control tools**

These components can be used with write access to modify programs, outputs or other parameters of the robot controller, without this being noticed by any persons located inside the system.

Safety measures:

- KUKA stipulates that these components are to be used exclusively for diagnosis and visualization.

  Programs, outputs or other parameters of the robot controller must not be modified using these components.

- If these components are used, outputs that could cause a hazard must be determined in a risk assessment. These outputs must be designed in such a way that they cannot be set without being enabled. This can be done using an external enabling device, for example.

**Tools for configuration of bus systems**

If these components have an online functionality, they can be used with write access to modify programs, outputs or other parameters of the robot controller, without this being noticed by any persons located inside the system.

- WorkVisual from KUKA
- Tools from other manufacturers

Safety measures:

- In the test modes, programs, outputs or other parameters of the robot controller must not be modified using these components.

### 3.9 Applied norms and regulations

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN ISO 13850</td>
<td>Safety of machinery: Emergency stop - Principles for design</td>
<td>2008</td>
</tr>
<tr>
<td>EN ISO 13849-1</td>
<td>Safety of machinery: Safety-related parts of control systems - Part 1: General principles of design</td>
<td>2008</td>
</tr>
<tr>
<td>Name</td>
<td>Definition</td>
<td>Edition</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>EN ISO 12100</td>
<td>Safety of machinery: General principles of design, risk assessment and risk reduction</td>
<td>2010</td>
</tr>
<tr>
<td>EN ISO 10218-1</td>
<td>Industrial robots: Safety</td>
<td>2011</td>
</tr>
<tr>
<td>EN 614-1</td>
<td>Safety of machinery: Ergonomic design principles - Part 1: Terms and general principles</td>
<td>2006</td>
</tr>
<tr>
<td>EN 61000-6-2</td>
<td>Electromagnetic compatibility (EMC): Part 6-2: Generic standards; Immunity for industrial environments</td>
<td>2005</td>
</tr>
<tr>
<td>EN 61000-6-4</td>
<td>Electromagnetic compatibility (EMC): Part 6-4: Generic standards; Emission standard for industrial environments</td>
<td>2007</td>
</tr>
<tr>
<td>EN 60204-1</td>
<td>Safety of machinery: Electrical equipment of machines - Part 1: General requirements</td>
<td>2006</td>
</tr>
</tbody>
</table>
4 Operation

4.1 KUKA smartPAD teach pendant

4.1.1 Front view

Function

The smartPAD is the teach pendant for the industrial robot. The smartPAD has all the operator control and display functions required for operating and programming the industrial robot.

The smartPAD has a touch screen: the smartHMI can be operated with a finger or stylus. An external mouse or external keyboard is not necessary.

Overview

The general term "KCP" (KUKA Control Panel) is often used in this documentation for the smartPAD.

Fig. 4-1: KUKA smartPAD, front view
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Button for disconnecting the smartPAD  
      (>>> 4.1.3 "Disconnecting and connecting the smartPAD" Page 46) |
| 2    | Keyswitch for calling the connection manager. The switch can only be turned if the key is inserted.  
      The operating mode can be changed by using the connection manager.  
      (>>> 4.10 "Changing operating mode" Page 59) |
| 3    | EMERGENCY STOP button. Stops the robot in hazardous situations. The EMERGENCY STOP button locks itself in place when it is pressed. |
| 4    | Space Mouse: For moving the robot manually.  
      (>>> 4.12 "Jogging the robot" Page 61) |
| 5    | Jog keys: For moving the robot manually.  
      (>>> 4.12 "Jogging the robot" Page 61) |
| 6    | Key for setting the program override |
| 7    | Key for setting the jog override |
| 8    | Main menu key: Shows the menu items on the smartHMI  
      (>>> 4.4 "Calling the main menu" Page 50) |
| 9    | Status keys. The status keys are used primarily for setting parameters in technology packages. Their exact function depends on the technology packages installed. |
| 10   | Start key: The Start key is used to start a program. |
| 11   | Start backwards key: The Start backwards key is used to start a program backwards. The program is executed step by step. |
| 12   | STOP key: The STOP key is used to stop a program that is running. |
| 13   | Keyboard key  
      Displays the keyboard. It is generally not necessary to press this key to display the keyboard, as the smartHMI detects when keyboard input is required and displays the keyboard automatically.  
      (>>> 4.2.3 "Keypad" Page 50) |
4.1.2 Rear view

Overview

Fig. 4-2: KUKA smartPAD, rear view

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identification plate</td>
<td>Identification plate</td>
</tr>
<tr>
<td>Start key</td>
<td>The Start key is used to start a program.</td>
</tr>
<tr>
<td>Enabling switch</td>
<td>The enabling switch has 3 positions:</td>
</tr>
<tr>
<td></td>
<td>- Not pressed</td>
</tr>
<tr>
<td></td>
<td>- Center position</td>
</tr>
<tr>
<td></td>
<td>- Panic position</td>
</tr>
<tr>
<td></td>
<td>The enabling switch must be held in the center position in operating modes T1 and T2 in order to be able to jog the manipulator.</td>
</tr>
<tr>
<td></td>
<td>In the operating modes Automatic and Automatic External, the enabling switch has no function.</td>
</tr>
<tr>
<td>USB connection</td>
<td>The USB connection is used, for example, for archiving and restoring data.</td>
</tr>
<tr>
<td></td>
<td>Only for FAT32-formatted USB sticks.</td>
</tr>
</tbody>
</table>
4.1.3 Disconnecting and connecting the smartPAD

Description
The smartPAD can be disconnected while the robot controller is running.

**WARNING** If the smartPAD is disconnected, the system can no longer be switched off by means of the EMERGENCY STOP device on the smartPAD. For this reason, an external EMERGENCY STOP must be connected to the robot controller. The user is responsible for ensuring that the smartPAD is immediately removed from the system when it has been disconnected. The smartPAD must be stored out of sight and reach of personnel working on the industrial robot. This prevents operational and non-operational EMERGENCY STOP devices from becoming interchanged. Failure to observe these precautions may result in death to persons, severe injuries or considerable damage to property.

Procedure

**Disconnection:**

1. Press the disconnect button on the smartPAD.
   
   A message and a counter are displayed on the smartHMI. The counter runs for 30 s. During this time, the smartPAD can be disconnected from the robot controller.

   **i** If the smartPAD is disconnected without the counter running, this triggers an EMERGENCY STOP. The EMERGENCY STOP can only be canceled by plugging the smartPAD back in.

2. Disconnect the smartPAD from the robot controller.
   
   If the counter expires without the smartPAD having been disconnected, this has no effect. The disconnect button can be pressed again at any time to display the counter again.

**Connection:**

- Connect the smartPAD to the robot controller.

A smartPAD can be connected at any time. Precondition: Same smartPAD variant as the disconnected device. The EMERGENCY STOP and enabling switches are operational again 30 s after connection. The smartHMI is automatically displayed again. (This may take longer than 30 s.)

The connected smartPAD assumes the current operating mode of the robot controller.

**i** The current operating mode is not, in all cases, the same as that before the smartPAD was disconnected: if the robot controller is part of a RoboTeam, the operating mode may have been changed after disconnection, e.g. by the master.

**WARNING** The user connecting a smartPAD to the robot controller must subsequently stay with the smartPAD for at least 30 s, i.e. until the EMERGENCY STOP and enabling switches are operational once again. This prevents another user from trying to activate a non-operational EMERGENCY STOP in an emergency situation, for example. Failure to observe this may result in death to persons, injuries or damage to property.
## 4.2 KUKA smartHMI user interface

### Fig. 4-3: KUKA smartHMI user interface

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Status bar (&gt;&gt;&gt; 4.2.1 &quot;Status bar&quot; Page 48)</td>
</tr>
</tbody>
</table>
| 2    | Message counter  
   - The message counter indicates how many messages of each message type are active. Touching the message counter enlarges the display. |
| 3    | Message window  
   - By default, only the last message is displayed. Touching the message window expands it so that all active messages are displayed.  
   - An acknowledgeable message can be acknowledged with **OK**. All acknowledgeable messages can be acknowledged at once with **All OK**. |
| 4    | **Space Mouse** status indicator  
   - This indicator shows the current coordinate system for jogging with the Space Mouse. Touching the indicator displays all coordinate systems, allowing a different one to be selected. |
4.2.1 Status bar

The status bar indicates the status of certain central settings of the industrial robot. In most cases, touching the display opens a window in which the settings can be modified.

Overview

Fig. 4-4: KUKA smartHMI status bar
4 Operation

4.2.2 “Submit interpreter” status indicator

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Main menu key. Shows the menu items on the smartHMI. (&gt;&gt;&gt; 4.4 &quot;Calling the main menu&quot; Page 50)</td>
</tr>
<tr>
<td>2</td>
<td>Robot name. The robot name can be changed. (&gt;&gt;&gt; 4.15.12 &quot;Displaying/editing robot data&quot; Page 83)</td>
</tr>
<tr>
<td>3</td>
<td>If a program has been selected, the name is displayed here.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Submit interpreter</strong> status indicator (&gt;&gt;&gt; 4.2.2 “Submit interpreter” status indicator&quot; Page 49)</td>
</tr>
<tr>
<td>5</td>
<td><strong>Drives</strong> status indicator. The drives can be switched on or off here. (&gt;&gt;&gt; 6.5.5 &quot;Switching drives on/off&quot; Page 147)</td>
</tr>
<tr>
<td>6</td>
<td><strong>Robot interpreter</strong> status indicator. Programs can be reset or canceled here. (&gt;&gt;&gt; 6.5.6 &quot;Robot interpreter status indicator&quot; Page 148) (&gt;&gt;&gt; 6.2.1 &quot;Selecting and deselecting a program&quot; Page 142) (&gt;&gt;&gt; 6.5.11 &quot;Resetting a program&quot; Page 150)</td>
</tr>
<tr>
<td>7</td>
<td>Current operating mode (&gt;&gt;&gt; 4.10 &quot;Changing operating mode&quot; Page 59)</td>
</tr>
<tr>
<td>8</td>
<td><strong>POV/HOV</strong> status indicator. Indicates the current program override and the current jog override. (&gt;&gt;&gt; 6.5.4 &quot;Setting the program override (POV)&quot; Page 147) (&gt;&gt;&gt; 4.12.3 &quot;Setting the jog override (HOV)&quot; Page 66)</td>
</tr>
<tr>
<td>9</td>
<td><strong>Program run mode</strong> status indicator. Indicates the current program run mode. (&gt;&gt;&gt; 6.5.2 &quot;Program run modes&quot; Page 146)</td>
</tr>
<tr>
<td>10</td>
<td><strong>Tool/base</strong> status indicator. Indicates the current tool and base. (&gt;&gt;&gt; 4.12.4 &quot;Selecting the tool and base&quot; Page 66)</td>
</tr>
<tr>
<td>11</td>
<td><strong>Incremental jogging</strong> status indicator. (&gt;&gt;&gt; 4.12.10 &quot;Incremental jogging&quot; Page 71)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Yellow Icon" /></td>
<td>Yellow</td>
<td>Submit interpreter is selected. The block pointer is situated on the first line of the selected SUB program.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Green Icon" /></td>
<td>Green</td>
<td>Submit interpreter is running.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Red Icon" /></td>
<td>Red</td>
<td>Submit interpreter has been stopped.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Gray Icon" /></td>
<td>Gray</td>
<td>Submit interpreter is deselected.</td>
</tr>
</tbody>
</table>
4.2.3 Keypad

The smartPAD has a touch screen: the smartHMI can be operated with a finger or stylus.

There is a keypad on the smartHMI for entering letters and numbers. The smartHMI detects when the entry of letters or numbers is required and automatically displays the keypad.

The keypad only ever displays the characters that are required. If, for example, a box is edited in which only numbers can be entered, then only numbers are displayed and not letters.

**Fig. 4-5: Example keypad**

4.3 Switching on the robot controller and starting the KSS

**Procedure**
- Turn the main switch on the robot controller to ON. The operating system and the KSS start automatically.
  
  If the KSS does not start automatically, e.g. because the Startup function has been disabled, execute the file StartKRC.exe in the directory C:\KRC.

  If the robot controller is logged onto the network, the start may take longer.

4.4 Calling the main menu

**Procedure**
- Press “Main menu” key on the KCP. The Main menu window is opened. The display is always the same as that which was in the window before it was last closed.

**Description**
- Properties of the Main Menu window:
  - The main menu is displayed in the left-hand column.
  - Touching a menu item that contains an arrow opens the corresponding submenu (e.g. Configure).
    Depending on how many nested submenus are open, the Main Menu column may no longer be visible, with only the submenus remaining visible.
  - The arrow key in the top right-hand corner closes the most recently opened submenu.
  - The Home key in the top right-hand corner closes all open submenus.
The most recently selected menu items are displayed in the bottom section (maximum 6). This makes it possible to select these menu items again directly without first having to close other submenus that might be open.

The white cross on the left-hand side closes the window.

---

4.5 Exiting or restarting KSS

Precondition

- For certain options: "Expert" user group

**NOTICE**

If, on shutting down, the option **Reboot control PC** is selected, the main switch on the robot controller must not be pressed until the reboot has been completed. System files may otherwise be destroyed. If this option was not selected on shutting down, the main switch can be pressed once the controller has shut down.

Procedure

1. Select the menu item **Shutdown** in the main menu.
2. Select the desired options.
3. Press **Shut down control PC** or **Reboot control PC**.
4. Confirm the request for confirmation with **Yes**. The System Software is terminated and restarted in accordance with the selected option.

After the restart, the following message is displayed:

- **Cold start of controller**
- Or, if **Reload files** has been selected: **Initial cold start of controller**
# Description

**Fig. 4-7: Shutdown window**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default settings for switching off the controller via main switch</strong></td>
<td></td>
</tr>
<tr>
<td>Cold start</td>
<td>After a power failure, the robot controller starts with a cold start. (A power failure and start are generally triggered by switching the main switch on the robot controller off and on.) Can only be selected in the “Expert” user group. (&gt;&gt;&gt; &quot;Start types&quot; Page 54)</td>
</tr>
<tr>
<td>Hibernate</td>
<td>After a power failure, the robot controller starts with Hibernate. Can only be selected in the “Expert” user group. (&gt;&gt;&gt; &quot;Start types&quot; Page 54)</td>
</tr>
<tr>
<td>Power-off delay time</td>
<td>Wait time before the robot controller is shut down. This ensures that the system does not immediately shut down, for example, in the event of very brief power failures, but bridges the power failure. Can only be changed in the “Expert” user group.</td>
</tr>
<tr>
<td><strong>Settings valid next time the system is switched off using the main switch</strong></td>
<td></td>
</tr>
<tr>
<td>These settings only apply to the next start.</td>
<td></td>
</tr>
<tr>
<td>Force cold start</td>
<td>Activated: The next start is a cold start. Only available if Hibernate has been selected.</td>
</tr>
</tbody>
</table>
### Reload files
Activated: The next start is an initial cold start. This option must be selected in the following cases:
- If XML files have been changed directly, i.e. the user has opened the file and modified it. (Any other changes to XML files, e.g. if the robot controller modifies them in the background, are irrelevant.)
- If hardware components are to be exchanged after shutdown.

Can only be selected in the “Expert” user group. Only available if **Cold start** or **Force cold start** has been selected.

Depending on the hardware, the initial cold start takes approx. 30 to 150 seconds longer than a normal cold start.

### Power-off delay time
Activated: The wait time is adhered to the next time the system is shut down.
Deactivated: The wait time is ignored the next time the system is shut down.

### Instant actions
**Shut down control PC**
Only available in operating modes T1 and T2. The robot controller is shut down.

**Reboot control PC**
Only available in operating modes T1 and T2. The robot controller is shut down and then restarted.

**Drive bus OFF / ON**
Only available in operating modes T1 and T2. The drive bus can be switched off or on.

**Drive bus status** indicator:
- Green: Drive bus is on.
- Red: Drive bus is off.
- Gray: Status of the drive bus is unknown.
4.6 Switching the robot controller off

Procedure
- Turn the main switch on the robot controller to OFF.
  The robot controller automatically backs up data.

**NOTICE** The main switch on the robot controller must not be operated if the KSS has been exited with the option Reboot control PC and the reboot has not yet been completed. System files may otherwise be destroyed.

4.7 Setting the user interface language

Procedure
1. In the main menu, select Configuration > Miscellaneous > Language.
2. Select the desired language. Confirm with OK.

Description
The following languages are available:

<table>
<thead>
<tr>
<th>Start type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cold start</td>
<td>After a cold start the robot controller displays the Navigator. No program is selected. The robot controller is reinitialized, e.g. all user outputs are set to FALSE. <strong>Note</strong>: If XML files have been changed directly, i.e. the user has opened the file and modified it, these changes are taken into consideration in the case of a cold start with <strong>Reload files</strong>. This cold start is called an “initial cold start”. In the case of a cold start without <strong>Reload files</strong>, these changes are not taken into consideration.</td>
</tr>
<tr>
<td>Hibernate</td>
<td>After a start with Hibernate, the previously selected robot program can be resumed. The state of the kernel system: programs, block pointer, variable contents and outputs, is completely restored. Additionally, all programs that were open parallel to the robot controller are reopened and have the same state that they had before the system was shut down. The last state of Windows is also restored.</td>
</tr>
</tbody>
</table>
4.8 Online documentation and online help

4.8.1 Calling online documentation

Description
The documentation of the KUKA System Software can be displayed on the robot controller. Certain technology packages also have documentation that can be displayed on the robot controller.

Procedure
1. In the main menu, select Help > Documentation. Then select either System Software or the menu item for the technology package.
   The KUKA Embedded Information Service window is opened. The table of contents of the documentation is displayed.
2. Touch a chapter. The topics it contains are displayed.
3. Touch a topic. The description is displayed.

Example

Fig. 4-8: Online documentation – Example from the KUKA System Software

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 2</td>
<td>Displays the table of contents.</td>
</tr>
<tr>
<td>3</td>
<td>Displays the previous topic in the table of contents.</td>
</tr>
<tr>
<td>4</td>
<td>Displays the next topic.</td>
</tr>
</tbody>
</table>

4.8.2 Calling online help

Description
The online help refers to the messages. The online help can be called in the following ways:
- Call the help for a message that is currently displayed in the message window.
Display an overview of the possible messages and call the help for a message there.

**Procedure**

**Calling the online help for a message in the message window**

Most messages contain a button with a question mark. Online help is available for these messages.

1. Touch the button containing the question mark. The **KUKA Embedded Information Service – Message page** window is opened. The window contains a variety of information about the message. 
   (>>> Fig. 4-9 )

2. The window often also contains information about the causes of the message and the corresponding solutions. Details can be displayed:
   a. Touch the magnifying glass button next to the cause. The detail page is opened. (>>> Fig. 4-10 )
   b. Open the descriptions of the cause and solution.
   c. If the message has several possible causes: the magnifying glass buttons with arrows can be used to jump to the previous or next detail page.

**Procedure**

**Displaying an overview of the messages and calling the online help for a message there**

1. In the main menu, select **Help > Messages**. Then select either **System Software** or the menu item for the technology package. The **KUKA Embedded Information Service – Index page** window is opened. The messages are sorted by module ("module" refers here to a subsection of the software).

2. Touch an entry. The messages of this module are displayed.

3. Touch a message. The message page is displayed. The window contains a variety of information about the message. 
   (>>> Fig. 4-9 )

4. The window often also contains information about the causes of the message and the corresponding solutions. Details can be displayed:
   a. Touch the magnifying glass button next to the cause. The detail page is opened. (>>> Fig. 4-10 )
   b. Open the descriptions of the cause and solution.
   c. If the message has several possible causes: the magnifying glass buttons with arrows can be used to jump to the previous or next detail page.
Message page

![Message page – Example from the KUKA System Software](image)

**Fig. 4-9: Message page – Example from the KUKA System Software**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Displays the previous page.</td>
</tr>
<tr>
<td>2</td>
<td>This button is only active if the other arrow button has been used to jump to the previous page. This button can then be used to return to the original page.</td>
</tr>
<tr>
<td>3</td>
<td>Displays the list with the software modules.</td>
</tr>
<tr>
<td>4</td>
<td>Message number and text</td>
</tr>
</tbody>
</table>
| 5    | Information about the message  

There may be less information available than in the example. |
| 6    | Displays details about this cause/solution. (>>> Fig. 4-10 ) |
4.9 Changing user group

Procedure

1. Select Configuration > User group in the main menu. The current user group is displayed.
2. Press Default to switch to the default user group. (Default is not available if the default user group is already selected.)
   Press Login... to switch to a different user group. Select the desired user group.
3. If prompted: Enter password and confirm with Log-on.

Description

Different functions are available in the KSS, depending on the user group. The following user groups are available:

- Operator
  User group for the operator. This is the default user group.
- User
  User group for the operator. (By default, the user groups “Operator” and “User” are defined for the same target group.)
- Expert
  User group for the programmer. This user group is protected by means of a password.
4 Operation

- **Safety recovery**
  User group for the start-up technician. This user can activate and configure the safety configuration of the robot.
  This user group is protected by means of a password.

- **Safety maintenance**
  This user group is only relevant if KUKA.SafeOperation or KUKA.SafeRangeMonitoring is used. The user group is protected by means of a password.

- **Administrator**
  The range of functions is the same as that for the user group “Expert”. It is additionally possible, in this user group, to integrate plug-ins into the robot controller.
  This user group is protected by means of a password.

The default password is “kuka”.

When the system is booted, the default user group is selected.

If the mode is switched to AUT or AUT EXT, the robot controller switches to the default user group for safety reasons. If a different user group is desired, this must be selected subsequently.

If no actions are carried out in the user interface within a certain period of time, the robot controller switches to the default user group for safety reasons. The default setting is 300 s.

4.10 Changing operating mode

**Precondition**

- The robot controller is not executing a program.
- Key for the switch for calling the connection manager

**Procedure**

1. On the smartPAD, turn the switch for the connection manager. The connection manager is displayed.
2. Select the operating mode.
3. Return the switch for the connection manager to its original position.

The selected operating mode is displayed in the status bar of the smartPAD.

<table>
<thead>
<tr>
<th>Operating mode</th>
<th>Use</th>
<th>Velocities</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>For test operation, programming and teaching</td>
<td>Program verification: Programmed velocity, maximum 250 mm/s</td>
</tr>
<tr>
<td>T2</td>
<td>For test operation</td>
<td>Program verification: Programmed velocity</td>
</tr>
<tr>
<td>AUT</td>
<td>For industrial robots without higher-level controllers</td>
<td>Program mode: Programmed velocity</td>
</tr>
</tbody>
</table>

Do not change the operating mode while a program is running. If the operating mode is changed during program execution, the industrial robot is stopped with a safety stop 2.
4.11 Coordinate systems

Overview

The following Cartesian coordinate systems are defined in the robot controller:

- WORLD
- ROBROOT
- BASE
- TOOL

Description

WORLD

The WORLD coordinate system is a permanently defined Cartesian coordinate system. It is the root coordinate system for the ROBROOT and BASE coordinate systems.

By default, the WORLD coordinate system is located at the robot base.

ROBROOT
The ROBROOT coordinate system is a Cartesian coordinate system, which is always located at the robot base. It defines the position of the robot relative to the WORLD coordinate system.

By default, the ROBROOT coordinate system is identical to the WORLD coordinate system. $ROBROOT allows the definition of an offset of the robot relative to the WORLD coordinate system.

**BASE**

The BASE coordinate system is a Cartesian coordinate system that defines the position of the workpiece. It is relative to the WORLD coordinate system.

By default, the BASE coordinate system is identical to the WORLD coordinate system. It is offset to the workpiece by the user. (>>> 5.7.2 "Base calibration" Page 114)

**TOOL**

The TOOL coordinate system is a Cartesian coordinate system which is located at the tool center point.

By default, the origin of the TOOL coordinate system is located at the flange center point. (In this case it is called the FLANGE coordinate system.) The TOOL coordinate system is offset to the tool center point by the user. (>>> 5.7.1 "Tool calibration" Page 107)

**Angles of rotation of the robot coordinate systems**

<table>
<thead>
<tr>
<th>Angle</th>
<th>Rotation about axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle A</td>
<td>Rotation about the Z axis</td>
</tr>
<tr>
<td>Angle B</td>
<td>Rotation about the Y axis</td>
</tr>
<tr>
<td>Angle C</td>
<td>Rotation about the X axis</td>
</tr>
</tbody>
</table>

### 4.12 Jogging the robot

**Description**

There are 2 ways of jogging the robot:

- **Cartesian jogging**
  
  The TCP is jogged in the positive or negative direction along the axes of a coordinate system.

- **Axis-specific jogging**
  
  Each axis can be moved individually in a positive and negative direction.
There are 2 operator control elements that can be used for jogging the robot:

- Jog keys
- Space Mouse

### Overview

<table>
<thead>
<tr>
<th></th>
<th>Cartesian jogging</th>
<th>Axis-specific jogging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jog keys</td>
<td>(&gt;&gt; 4.12.6 &quot;Cartesian jogging with the jog keys&quot; Page 67)</td>
<td>(&gt;&gt; 4.12.5 &quot;Axis-specific jogging with the jog keys&quot; Page 67)</td>
</tr>
<tr>
<td>Space Mouse</td>
<td>(&gt;&gt; 4.12.9 &quot;Cartesian jogging with the Space Mouse&quot; Page 70)</td>
<td>Axis-specific jogging with the Space Mouse is possible, but is not described here.</td>
</tr>
</tbody>
</table>

#### 4.12.1 “Jog options” window

**Description**  
All parameters for jogging the robot can be set in the Jogging Options window.

**Procedure**  
Open the Jogging Options window:

1. Open a status indicator on the smartHMI, e.g. the POV status indicator.  
   (Not possible for the Submit interpreter, Drives and Robot interpreter status indicators.)
   A window opens.
2. Press Options. The Jogging Options window is opened.

For most parameters, it is not necessary to open the Jogging Options window. They can be set directly via the smartHMI status indicators.
4.12.1.1 “General” tab

![General tab](image)

**Fig. 4-13: General tab**

<table>
<thead>
<tr>
<th>Description</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set program override</td>
<td>1</td>
</tr>
<tr>
<td>Set jog override</td>
<td>2</td>
</tr>
<tr>
<td>Select the program run mode</td>
<td>3</td>
</tr>
</tbody>
</table>

**Description**

- **1** Set program override
  
   (>>> 6.5.4 “Setting the program override (POV)” Page 147)

- **2** Set jog override
  
   (>>> 4.12.3 “Setting the jog override (HOV)” Page 66)

- **3** Select the program run mode
  
   (>>> 6.5.2 “Program run modes” Page 146)

4.12.1.2 “Keys” tab

![Keys tab](image)

**Fig. 4-14: Keys tab**
### 4.12.1.3 “Mouse” tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Activate jog mode “Space Mouse”  
(>>> 4.12.2 "Activating the jog mode” Page 66) |
| 2    | Configure the Space Mouse  
(>>> 4.12.7 "Configuring the Space Mouse” Page 67) |
| 3    | Select the coordinate system for jogging with the Space Mouse |

### Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Activate jog mode “Jog keys”  
(>>> 4.12.2 "Activating the jog mode” Page 66) |
| 2    | Select a kinematics group. The kinematics group defines the axes to which the jog keys refer.  
Default: **Robot axes** (= A1 to A6)  
Depending on the system configuration, other kinematics groups may be available.  
(>>> 4.13 "Jogging external axes" Page 72) |
| 3    | Select the coordinate system for jogging with the jog keys |
| 4    | Incremental jogging  
(>>> 4.12.10 "Incremental jogging” Page 71) |
4.12.1.4 “KCP pos.” tab

![Image of Kcp Pos. tab]

Fig. 4-16: Kcp Pos. tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(&gt;&gt;&gt; 4.12.8 &quot;Defining the alignment of the Space Mouse&quot; Page 69)</td>
</tr>
</tbody>
</table>

4.12.1.5 “Cur. tool/base” tab

![Image of Act. Tool/Base tab]

Fig. 4-17: Act. Tool/Base tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The current tool is displayed here. A different tool can be selected. (&gt;&gt;&gt; 4.12.4 &quot;Selecting the tool and base&quot; Page 66)</td>
</tr>
<tr>
<td>2</td>
<td>The display <strong>Unknown [?]</strong> means that no tool has yet been calibrated.</td>
</tr>
</tbody>
</table>
4.12.2 Activating the jog mode

**Procedure**
1. Open the Jogging Options window.
   (>>> 4.12.1 "Jog options" window Page 62)
2. To activate the jog mode “Jog keys”:
   - On the Keys tab, activate the Activate Keys check box.
3. To activate the jog mode “Space Mouse”:
   - On the Mouse tab, activate the Activate Mouse check box.

**Description**
Both jog modes “Jog keys” and “Space Mouse” can be activated simultaneously. If the robot is jogged using the keys, the Space Mouse is disabled until the robot comes to a standstill. If the Space Mouse is actuated, the keys are disabled.

4.12.3 Setting the jog override (HOV)

**Description**
Jog override determines the velocity of the robot during jogging. The velocity actually achieved by the robot with a jog override setting of 100% depends on various factors, including the robot type. The velocity cannot exceed 250 mm/s however.

**Procedure**
1. Touch the POV/HOV status indicator. The Overrides window is opened.
2. Set the desired jog override. It can be set using either the plus/minus keys or by means of the slide controller.
   - Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%
   - Slide controller: The override can be adjusted in 1% steps.
3. Touch the POV/HOV status indicator again. (Or touch the area outside the window.)
   - The window closes and the selected override value is applied.

**Alternative procedure**
Alternatively, the override can be set using the plus/minus key on the right-hand side of the KCP.
   - The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

4.12.4 Selecting the tool and base

**Description**
A maximum of 16 TOOL and 32 BASE coordinate systems can be saved in the robot controller. One tool (TOOL coordinate system) and one base (BASE coordinate system) must be selected for Cartesian jogging.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>The current base is displayed here. A different base can be selected.</td>
</tr>
<tr>
<td></td>
<td>(&gt;&gt;&gt; 4.12.4 &quot;Selecting the tool and base&quot; Page 66)</td>
</tr>
<tr>
<td></td>
<td>The display Unknown (?) means that no base has yet been calibrated.</td>
</tr>
<tr>
<td>3</td>
<td>Select the interpolation mode:</td>
</tr>
<tr>
<td></td>
<td>- Flange: The tool is mounted on the mounting flange.</td>
</tr>
<tr>
<td></td>
<td>- ext. Tool: The tool is a fixed tool.</td>
</tr>
</tbody>
</table>
| Procedure | 1. Touch the **Tool/base** status indicator. The **Act. Tool/Base** window is opened.  
2. Select the desired tool and base.  
3. The window closes and the selection is applied. |

### 4.12.5 Axis-specific jogging with the jog keys

**Precondition**
- The jog mode “Jog keys” is active.
- Operating mode T1

**Procedure**
1. Select **Axes** as the coordinate system for the jog keys.
2. Set jog override.
3. Hold down the enabling switch.
   - Axes A1 to A6 are displayed next to the jog keys.
4. Press the Plus or Minus jog key to move an axis in the positive or negative direction.

<i>The position of the robot during jogging can be displayed: select **Display > Actual position** in the main menu.</i>

### 4.12.6 Cartesian jogging with the jog keys

**Precondition**
- The jog mode “Jog keys” is active.
- Operating mode T1
- Tool and base have been selected.  
  (>>> 4.12.4 “Selecting the tool and base” Page 66)

**Procedure**
1. Select **World**, **Base** or **Tool** as the coordinate system for the jog keys.
2. Set jog override.
3. Hold down the enabling switch.
   - The following designations are displayed next to the jog keys:  
     - **X, Y, Z**: for the linear motions along the axes of the selected coordinate system  
     - **A, B, C**: for the rotational motions about the axes of the selected coordinate system
4. Press the Plus or Minus jog key to move the robot in the positive or negative direction.

<i>The position of the robot during jogging can be displayed: select **Display > Actual position** in the main menu.</i>

### 4.12.7 Configuring the Space Mouse

**Procedure**
1. Open the **Jogging Options** window and select the **Mouse** tab.  
  (>>> 4.12.1 “Jog options” window” Page 62)
2. **Mouse Settings** group:
   - **Dominant** check box:  
     Activate or deactivate dominant mode as desired.
   - **6D/XYZ/ABC** option box:  
     Select whether the TCP is to be moved using translational motions, rotational motions, or both.
3. Close the **Jogging Options** window.

**Description**

![Mouse Settings](image)

**Fig. 4-18: Mouse settings**

**Dominant** check box:

Depending on the dominant mode, the Space Mouse can be used to move just one axis or several axes simultaneously.

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Dominant mode is activated. Only the coordinate axis with the greatest deflection of the Space Mouse is moved.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Dominant mode is deactivated. Depending on the axis selection, either 3 or 6 axes can be moved simultaneously.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **6D** | The robot can be moved by pulling, pushing, rotating or tilting the Space Mouse.  
The following motions are possible with Cartesian jogging:  
- Translational motions in the X, Y and Z directions  
- Rotational motions about the X, Y and Z axes |
| **XYZ** | The robot can only be moved by pulling or pushing the Space Mouse.  
The following motions are possible with Cartesian jogging:  
- Translational motions in the X, Y and Z directions |
| **ABC** | The robot can only be moved by rotating or tilting the Space Mouse.  
The following motions are possible with Cartesian jogging:  
- Rotational motions about the X, Y and Z axes |
### 4.12.8 Defining the alignment of the Space Mouse

**Description**

The functioning of the Space Mouse can be adapted to the location of the user so that the motion direction of the TCP corresponds to the deflection of the Space Mouse.

The location of the user is specified in degrees. The reference point for the specification in degrees is the junction box on the base frame. The position of the robot arm or axes is irrelevant.

Default setting: $0^\circ$. This corresponds to a user standing opposite the junction box.

---

**Fig. 4-19: Pushing and pulling the Space Mouse**

**Fig. 4-20: Rotating and tilting the Space Mouse**
Precondition
- Operating mode T1

Procedure
1. Open the Jog options window and select the KCP pos. tab.

2. Drag the KCP to the position corresponding to the location of the user (in 45° steps).

3. Close the Jog options window.

4. Switching to Automatic External mode automatically resets the alignment of the Space Mouse to 0°.

---

4.12.9 Cartesian jogging with the Space Mouse

Precondition
- The jog mode “Space Mouse” is active.
- Operating mode T1
- Tool and base have been selected.
  (>>> 4.12.4 "Selecting the tool and base" Page 66)
- The Space Mouse is configured.
  (>>> 4.12.7 "Configuring the Space Mouse" Page 67)
The alignment of the Space Mouse has been defined.

>>> 4.12.8 "Defining the alignment of the Space Mouse" Page 69

**Procedure**

1. Select **World**, **Base** or **Tool** as the coordinate system for the Space Mouse.
2. Set jog override.
3. Hold down the enabling switch.
4. Move the robot in the desired direction using the Space Mouse.

The position of the robot during jogging can be displayed: select **Display > Actual position** in the main menu.

### 4.12.10 Incremental jogging

**Description**

Incremental jogging makes it possible to move the robot a defined distance, e.g. 10 mm or 3°. The robot then stops by itself.

Incremental jogging can be activated for jogging with the jog keys. Incremental jogging is not possible in the case of jogging with the Space Mouse.

**Areas of application:**

- Positioning of equidistant points
- Moving a defined distance away from a position, e.g. in the event of a fault
- Mastering with the dial gauge

The following options are available:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous</td>
<td>Incremental jogging is deactivated.</td>
</tr>
<tr>
<td>100 mm / 10°</td>
<td>1 increment = 100 mm or 10°</td>
</tr>
<tr>
<td>10 mm / 3°</td>
<td>1 increment = 10 mm or 10°</td>
</tr>
<tr>
<td>1 mm / 1°</td>
<td>1 increment = 1 mm or 1°</td>
</tr>
<tr>
<td>0.1 mm / 0.005°</td>
<td>1 increment = 0.1 mm or 0.005°</td>
</tr>
</tbody>
</table>

Increments in mm:

- Valid for Cartesian jogging in the X, Y or Z direction.

Increments in degrees:

- Valid for Cartesian jogging in the A, B or C direction.
- Valid for axis-specific jogging.

**Precondition**

- The jog mode “Jog keys” is active.
- Operating mode T1

**Procedure**

1. Select the size of the increment in the status bar.
2. Jog the robot using the jog keys. Jogging can be Cartesian or axis-specific.

   Once the set increment has been reached, the robot stops.

If the robot motion is interrupted, e.g. by releasing the enabling switch, the interrupted increment is not resumed with the next motion; a new increment is started instead.
4.13 Jogging external axes

External axes cannot be moved using the Space Mouse. If “Space Mouse” mode is selected, only the robot can be jogged with the Space Mouse. The external axes, on the other hand, must be jogged using the jog keys.

Precondition

- The jog mode “Jog keys” is active.
- Operating mode T1

Procedure

1. Select the desired kinematics group, e.g. External axes, on the Keys tab in the Jog options window. The type and number of kinematics groups available depend on the system configuration.
2. Set jog override.
3. Hold down the enabling switch.
4. Press the Plus or Minus jog key to move an axis in the positive or negative direction.

Description

Depending on the system configuration, the following kinematics groups may be available.

<table>
<thead>
<tr>
<th>Kinematics group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Robot Axes</td>
<td>The robot axes can be moved using the jog keys. The external axes cannot be jogged.</td>
</tr>
<tr>
<td>External Axes</td>
<td>All configured external axes (e.g. external axes E1 to E5) can be moved using the jog keys.</td>
</tr>
<tr>
<td>NAME</td>
<td>The axes of an external kinematics group can be moved using the jog keys. The name is taken from the system variable $ET_{name} (n = number of the external kinematic system). If $ET_{name} is empty, the default name External Kinematics Groupn is displayed.</td>
</tr>
<tr>
<td>[User-defined kinematics group]</td>
<td>The axes of a user-defined kinematics group can be moved using the jog keys. The name corresponds to the name of the user-defined kinematics group.</td>
</tr>
</tbody>
</table>

4.14 Bypassing workspace monitoring

Description

Workspaces can be configured for a robot. Workspaces serve to protect the system.

There are 2 types of workspace:

- The workspace is an exclusion zone. The robot may only move outside the workspace.
- Only the workspace is a permitted zone. The robot may not move outside the workspace.

Exactly what reactions occur when the robot violates a workspace depends on the configuration.

One possible reaction, for example, is that the robot stops and an error message is generated. The workspace monitoring must be bypassed in such a case. The robot can then move back out of the prohibited workspace.
Precondition

- User group "Expert"
- Operating mode T1

Procedure

1. In the main menu, select **Configuration > Miscellaneous > Workspace monitoring > Override**.
2. Move the robot manually out of the prohibited workspace.
   
   Once the robot has left the prohibited workspace, the workspace monitoring is automatically active again.

4.15 Monitor functions

4.15.1 Measuring and displaying energy consumption

Description

The overall energy consumption of the robot and robot controller can be displayed on the smartHMI. A prerequisite for this is that measurement of energy consumption is possible for the robot type used.

The energy consumption of optional robot controller components (e.g. US1, US2, etc.) and of other controllers is not taken into consideration. It is always the consumption for the last 60 minutes since the most recent cold start that is displayed. Furthermore, the user has the option of starting and stopping measurements manually.

Traces can be made for the consumption values. The predefined configuration Tracedef_KRC_EnergyCalc is available for this.

The data can also be transferred to a higher-level controller by means of PROFIenergy. PROFIenergy is a component of KR C4 PROFINET for KSS/VSS 8.3.

There are two ways of starting and stopping measurements:

- In the **Energy consumption** window (>>> Fig. 4-23 )
- Via KRL

Precondition

- Measurement of energy consumption is possible for the robot type used.
  
  If not, the boxes in the **Energy consumption** window are grayed out.

Procedure

Starting and stopping a measurement in the **Energy consumption** window:

1. In the main menu, select **Display > Energy consumption**. The **Energy consumption** window is opened.
2. If required, activate the check box **Refresh**.
3. Press **Start measuring**. A red dot to the right of the top line now indicates that a measurement is in progress.
4. To stop the measurement, press **Stop measuring**. The result is displayed.

Starting and stopping a measurement via KRL:

1. Start the measurement via $ENERGY_MEASURING.ACTIVE = TRUE (possible via the KRL program or variable correction function). The measurement starts.
2. In the main menu, select **Display > Energy consumption**. The **Energy consumption** window is opened. A red dot to the right of the top line indicates the measurement that is in progress.
3. If required, activate the check box **Refresh**.
4. Stop the measurement by means of $ENERGY_MEASURING.ACTIVE = FALSE.

The **Energy consumption** window can also be opened independently of the measurement. The top line always indicates the result of the active or most recent measurement.
Measurement properties

- A measurement that has been started runs until it is stopped. This is not dependent on whether the Energy consumption window is open or closed.
- A measurement that has been started via KRL can be stopped via KRL or via the Stop measuring button.
- A measurement that has been started by means of Start measuring can only be stopped by means of Stop measuring as long as the Energy consumption window remains open. If an attempt is made to stop the measurement via KRL, the robot controller displays the following message: Energy measurement cannot currently be stopped.

Once the Energy consumption window has been closed again, the measurement can also be stopped via KRL. This prevents a measurement started in the Energy consumption window from permanently blocking measurements via KRL.

- It is not possible to start a measurement while a measurement is already active. In this case, the robot controller displays the following message: An energy measurement is already active. The active measurement must be stopped first.

Energy consumption window

Fig. 4-23: Energy consumption window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Results of the measurements started by the user  
      The last 3 results are displayed. The most recent result is displayed in the top line. If a measurement is currently active, this is indicated by means of a red dot to the right of the line. |
| 2    | Energy consumption for the last 60 minutes since the most recent cold start |
| 3    | Starts a measurement.  
      Start measuring is not available if a measurement is currently active. |
| 4    | Stops an active measurement.  
      How the measurement was started (by means of Start measuring or via KRL) is irrelevant. |
| 5    | Check box active: While a measurement is being carried out, the result display is continually refreshed.  
      Check box not active: While a measurement is being carried out, the most recently refreshed value is displayed. The result is not displayed until the measurement is stopped. |
4.15.2 Displaying the actual position

**Procedure**

1. In the main menu, select **Display > Actual position**. The Cartesian actual position is displayed.
2. To display the axis-specific actual position, press **Axis-specific**.
3. To display the Cartesian actual position again, press **Cartesian**.

**Description**

**Actual position, Cartesian:**

The current position (X, Y, Z) and orientation (A, B, C) of the TCP are displayed. Status and Turn are also displayed.

**Actual position, axis-specific:**

The current position of axes A1 to A6 is indicated. If external axes are being used, the position of the external axes is also displayed.

The actual position can also be displayed while the robot is moving.

![Robot Position (Axis Specific)](image)

Fig. 4-24: Actual position, axis-specific

4.15.3 Displaying digital inputs/outputs

**Procedure**

1. In the main menu, select **Display > Inputs/outputs > Digital I/O**.
2. To display a specific input/output:
   - Click on the **Go to** button. The **Go to** box is displayed.
   - Enter the number and confirm with the Enter key.
   - The display jumps to the input/output with this number.
Description

![Digital inputs](image1)

Fig. 4-25: Digital inputs

![Digital outputs](image2)

Fig. 4-26: Digital outputs

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input/output number</td>
</tr>
<tr>
<td>2</td>
<td>Value of the input/output. The icon is red if the input or output is TRUE.</td>
</tr>
<tr>
<td>3</td>
<td>SIM entry: The input/output is simulated. SYS entry: The value of the input/output is saved in a system variable. This input/output is write-protected.</td>
</tr>
<tr>
<td>4</td>
<td>Name of the input/output</td>
</tr>
</tbody>
</table>

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-100</td>
<td>Toggles back 100 inputs or outputs in the display.</td>
</tr>
<tr>
<td>+100</td>
<td>Toggles forward 100 inputs or outputs in the display.</td>
</tr>
<tr>
<td>Go to</td>
<td>The number of the input or output being searched for can be entered.</td>
</tr>
</tbody>
</table>
4.15.4 Displaying analog inputs/outputs

**Procedure**

1. In the main menu, select **Display > Inputs/outputs > Analog I/O**.
2. To display a specific input/output:
   - Click on the **Go to** button. The **Go to**: box is displayed.
   - Enter the number and confirm with the Enter key.
   
The display jumps to the input/output with this number.

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Value</strong></td>
<td>Toggles the selected input/output between TRUE and FALSE. Precondition: The enabling switch is pressed.&lt;br&gt;This button is not available in AUT EXT mode, and is only available for inputs if simulation is activated.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The name of the selected input or output can be changed.</td>
</tr>
</tbody>
</table>

4.15.5 Displaying inputs/outputs for Automatic External

**Procedure**

- In the main menu, select **Display > Inputs/outputs > Automatic External**.

**Description**

![Automatic External inputs (detail view)](image)

Fig. 4-27: Automatic External inputs (detail view)
The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Config.</td>
<td>Switches to the configuration of the Automatic External interface.</td>
</tr>
<tr>
<td>Inputs/Outputs</td>
<td>Toggles between the windows for inputs and outputs.</td>
</tr>
<tr>
<td>Details/Normal</td>
<td>Toggles between the Details and Normal views.</td>
</tr>
</tbody>
</table>

### 4.15.6 Displaying cyclical flags

**Procedure**

1. In the main menu, select **Display > Variable > Cyclical flags**. The **Cyclical flags** window is opened.
2. To display a specific flag:
   - Click on the **Go to** button. The **Go to** box is displayed.
   - Enter the number and confirm with the Enter key.
   - The display jumps to the flag with this number.
### Description

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-100</td>
<td>Toggles back 100 flags in the display.</td>
</tr>
<tr>
<td>+100</td>
<td>Toggles forward 100 flags in the display.</td>
</tr>
<tr>
<td>Go to</td>
<td>The number of the flag being searched for can be entered.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the selected flag can be modified.</td>
</tr>
</tbody>
</table>

#### Fig. 4-29: Cyclical flags

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of the flag</td>
</tr>
<tr>
<td>2</td>
<td>Value of the flag. The icon is red if a flag is set.</td>
</tr>
<tr>
<td>3</td>
<td>Name of the flag</td>
</tr>
<tr>
<td>4</td>
<td>The conditions linked to the setting of a cyclical flag are indicated here.</td>
</tr>
</tbody>
</table>

#### 4.15.7 Displaying flags

**Procedure**

1. In the main menu, select **Display > Variable > Flags**. The **Flags** window is opened.
2. To display a specific flag:
   - Click on the **Go to** button. The **Go to** box is displayed.
   - Enter the number and confirm with the Enter key.
   - The display jumps to the flag with this number.
Description

The following buttons are available:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of the flag</td>
</tr>
<tr>
<td>2</td>
<td>Value of the flag. The icon is red if a flag is set.</td>
</tr>
<tr>
<td>3</td>
<td>Name of the flag</td>
</tr>
</tbody>
</table>

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-100</td>
<td>Toggles back 100 flags in the display.</td>
</tr>
<tr>
<td>+100</td>
<td>Toggles forward 100 flags in the display.</td>
</tr>
<tr>
<td>Go to</td>
<td>The number of the flag being searched for can be entered.</td>
</tr>
<tr>
<td>Value</td>
<td>Toggles the selected flag between TRUE and FALSE. Precondition: The enabling switch is pressed. This button is not available in AUT EXT mode.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the selected flag can be modified.</td>
</tr>
</tbody>
</table>

4.15.8 Displaying counters

Procedure

1. In the main menu, select **Display > Variable > Counter**. The **Counter** window is opened.
2. To display a specific counter:
   - Click on the **Go to** button. The **Go to** box is displayed.
   - Enter the number and confirm with the Enter key.
   - The display jumps to the counter with this number.
4 Operation

Description

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to</td>
<td>The number of the counter being searched for can be entered.</td>
</tr>
<tr>
<td>Value</td>
<td>A value can be entered for the selected counter.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the selected counter can be modified.</td>
</tr>
</tbody>
</table>

4.15.9 Displaying timers

Procedure

1. In the main menu, select **Display > Variable > Timer**. The **Timer** window is opened.
2. To display a specific timer:
   - Click on the **Go to** button. The **Go to**: box is displayed.
   - Enter the number and confirm with the Enter key.
   - The display jumps to the timer with this number.
Description

The following buttons are available:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to</td>
<td>The number of the timer being searched for can be entered.</td>
</tr>
<tr>
<td>State</td>
<td>Toggles the selected timer between TRUE and FALSE. Precondition: The enabling switch is pressed.</td>
</tr>
<tr>
<td>Value</td>
<td>A value can be entered for the selected timer.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the selected timer can be modified.</td>
</tr>
</tbody>
</table>

**4.15.10 Displaying calibration data**

**Procedure**

1. In the main menu, select **Start-up > Calibrate > Calibration points** and the desired menu item:
   - Tool type
   - Base type
   - External axis
2. Enter the number of the tool, base or external kinematic system.

The calibration method and the calibration data are displayed.
### 4.15.11 Displaying information about the robot and robot controller

**Procedure**  
- In the main menu, select **Help > Info**.

**Description**  
The information is required, for example, when requesting help from KUKA Customer Support.

The tabs contain the following information:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Info** | ■ Robot controller type  
■ Robot controller version  
■ User interface version  
■ Kernel system version |
| **Robot** | ■ Robot name  
■ Robot type and configuration  
■ Service life  
  The operating hours meter is running as long as the drives are switched on. Alternatively, the operating hours can also be displayed via the variable $ROBURTIME.  
■ Number of axes  
■ List of external axes  
■ Machine data version |
| **System** | ■ Control PC name  
■ Operating system version  
■ Storage capacities |
| **Options** | Additionally installed options and technology packages |
| **Comments** | Additional comments |
| **Modules** | Names and versions of important system files  
  The **Export** button exports the contents of the **Modules** tab to the file C:\KRC\ROBOTER\LOG\FILEVERSIONS.TXT. |

### 4.15.12 Displaying/editing robot data

**Precondition**  
- T1 or T2 operating mode  
- No program is selected.

**Procedure**  
- In the main menu, select **Start-up > Robot data**.
Description

The buttons are not available in the user group “User”.

**Fig. 4-33: Robot data window**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Serial number</td>
</tr>
<tr>
<td>2</td>
<td>Operating hours. The operating hours meter is running as long as the drives are switched on. Alternatively, the operating hours can also be displayed via the variable $ROBRUNTIME.</td>
</tr>
<tr>
<td>3</td>
<td>Machine data name</td>
</tr>
<tr>
<td>4</td>
<td>Robot name. The robot name can be changed.</td>
</tr>
</tbody>
</table>
| 5    | Robot controller data can be archived to a network path.  
     | (>> 6.8.3 "Archiving on the network" Page 155)  
     | The archive path is defined here. |
| 6    | If archiving to the network requires a user name and password, these can be entered here. It is then no longer necessary to enter them every time for archiving. |
| 7    | This box is only displayed if the check box **Incorporate robot name into archive name.** is not activated.  
     | A name for the archive file can be defined here. |
| 8    | **Check box active:** The robot name is used as the name for the archive file. If no robot name is defined, the name **archive** is used.  
     | **Check box not active:** A separate name can be defined for the archive file. |
5 Start-up and recommissioning

5.1 Start-up wizard

Description
Start-up can be carried out using the Start-up wizard. This guides the user through the basic start-up steps.

Precondition
- No program is selected.
- Operating mode T1

Procedure
- Select Start-up > Start-up wizard in the main menu.

5.2 Checking the machine data

Description
The correct machine data must be loaded. This must be checked by comparing the loaded machine data with the machine data on the rating plate.

If machine data are reloaded, the version of the machine data must correspond exactly to the KSS version. This is ensured if the machine data supplied together with the KSS release are used.

⚠️ WARNING
The industrial robot must not be moved if incorrect machine data are loaded. Death, severe injuries or considerable damage to property may otherwise result. The correct machine data must be loaded.

![Fig. 5-1: Rating plate](image)

Precondition
- T1 or T2 operating mode
- No program is selected.

Procedure
1. In the main menu, select Start-up > Robot data. The Robot Data window is opened.
2. Compare the following entries:
   - In the Robot data window: the entry in the Machine data box
   - On the rating plate on the base of the robot: the entry in the line $STRAFONAME():="#..... "

5.3 Jogging the robot without a higher-level safety controller

Description

To jog the robot without a higher-level safety controller, Start-up mode must first be activated. The robot can then be jogged in T1 mode. If SafeOperation or SafeRangeMonitoring is used, the robot can also be jogged in CRR.

If the RoboTeam option is used, it is only possible to activate Start-up mode and jog the robot using the local smartPAD.

The robot controller automatically deactivates Start-up mode in the following cases:

- If no operator action has been carried out within 30 min of activation.
- If the smartPAD is switched to passive mode or disconnected from the robot controller.
- If the Ethernet safety interface is used: when a connection to a higher-level safety controller is established.
- If the X11 interface is used: when some input signals no longer have the state “logic zero”.

In Start-up mode, the system switches to the following simulated input image:

- The external EMERGENCY STOP is not active.
- The safety gate is open.
- No safety stop 1 has been requested.
- No safety stop 2 has been requested.
- No safe operational stop has been requested.
- Only for VKR C4: E2 is closed.

If SafeOperation or SafeRangeMonitoring is used, Start-up mode also influences other signals.

Precondition

- If the Ethernet safety interface is used: no connection to a higher-level safety controller
- If the X11 interface is used: all input signals have the state “logic zero”.
- Operating mode T1 or CRR
- In the case of VKR C4: no E2/E7 signals are activated via a USB stick or retrofit interface.
- In the case of RoboTeam: the local smartPAD is used.

Procedure

- In the main menu, select Start-up > Service > Start-up mode.
5.4 Checking the activation of the positionally accurate robot model

**Description**
If a positionally accurate robot is used, it must be checked that the positionally accurate robot model is activated.

In the case of positionally accurate robots, position deviations resulting from workpiece tolerances and elastic effects of the individual robots are compensated for. The positionally accurate robot positions the programmed TCP anywhere in the Cartesian workspace within the tolerance limits. The model parameters of the positionally accurate robot are determined at a calibration station and permanently saved on the robot (RDC).

**Functions**
A positionally accurate robot has the following functions:
- Increased positioning accuracy, approximately by the factor 10
- Increased path accuracy
- Simplified transfer of programs if the robot is exchanged (no reteaching)
- Simplified transfer of programs after offline programming with WorkVisual (no reteaching)

**Procedure**
1. In the main menu, select Help > Info.
2. Check on the Robot tab that the positionally accurate robot model is activated. (= specification Positionally accurate robot).

5.5 Mastering

**Overview**
Every robot must be mastered. Only if the robot has been mastered can it move to programmed positions and be moved using Cartesian coordinates. During mastering, the mechanical position and the electronic position of the robot are aligned. For this purpose, the robot is moved to a defined mechanical position, the mastering position. The encoder value for each axis is then saved.

The mastering position is similar, but not identical, for all robots. The exact positions may even vary between individual robots of a single robot type.
5.5.1 Mastering methods

The mastering methods that can be used for a robot depend on the type of gauge cartridge with which it is equipped. The types differ visually in terms of the size of their protective caps.
### 5.5.2 Moving axes to the pre-mastering position

#### Description

The axes must be moved to the pre-mastering position before every mastering operation. To do so, each axis is moved so that the mastering marks line up.

**Fig. 5-3: Moving an axis to the pre-mastering position**

The following figure shows where on the robot the mastering marks are situated. Depending on the specific robot model, the positions may deviate slightly from those illustrated.

<table>
<thead>
<tr>
<th>Type of gauge cartridge</th>
<th>Mastering methods</th>
</tr>
</thead>
</table>
| Gauge cartridge for EMD (Electronic Mastering Device)  
Protective cap with fine thread, M20 | Mastering with the EMD  
(>>> 5.5.3 "Mastering with the EMD" Page 90)  
Mastering with the dial gauge  
(>>> 5.5.4 "Mastering with the dial gauge" Page 95)  
Reference mastering  
In the case of robots with EMD gauge cartridges, reference mastering is only used for mastering after certain maintenance work.  
(>>> 5.5.6 "Reference mastering" Page 97) |
| Gauge cartridge for MEMD (Micro Electronic Mastering Device)  
Protective cap with fine thread, M8 | For A1 to A5: mastering with the MEMD  
For A6: mastering to the mark  
(>>> 5.5.7 "Mastering with the MEMD and mark" Page 98) |
Precondition

- The jog mode “Jog keys” is active.
- Operating mode T1

**NOTICE**

If A4 and A6 are moved to the pre-mastering position, ensure that the energy supply system – if present – is in its correct position and not rotated through 360°.

Robots that are mastered with the MEMD have no pre-mastering position for A6. Only A1 to A5 have to be moved to the pre-mastering position.

Procedure

1. Select **Axes** as the coordinate system for the jog keys.
2. Hold down the enabling switch.
   Axes A1 to A6 are displayed next to the jog keys.
3. Press the Plus or Minus jog key to move an axis in the positive or negative direction.
4. Move each axis, starting from A1 and working upwards, so that the mastering marks line up.

5.5.3 Mastering with the EMD

Overview

In EMD mastering, the axis is automatically moved by the robot controller to the mastering position. Mastering is carried out first without and then with a load. It is possible to save mastering data for different loads.
5.5.3.1 First mastering (with EMD)

Precondition

- There is no load on the robot; i.e. there is no tool, workpiece or supplementary load mounted.
- All axes are in the pre-mastering position.
- No program is selected.
- Operating mode T1

Procedure

**NOTICE** The EMD must always be screwed onto the gauge cartridge without the signal cable attached. Only then may the signal cable be attached to the EMD. Otherwise, the signal cable could be damaged.

Similarly, when removing the EMD, the signal cable must always be removed from the EMD first. Only then may the EMD be removed from the gauge cartridge.

After mastering, remove the signal cable from connection X32. Failure to do so may result in interference signals or damage.

1. Select **Start-up > Master > EMD > With load correction > First mastering** in the main menu.
   
   A window opens. All axes to be mastered are displayed. The axis with the lowest number is highlighted.

2. Remove the cover from connection X32.
3. Connect the signal cable to X32.

4. Remove the protective cap of the gauge cartridge on the axis highlighted in the window. (Turned around, the EMD can be used as a screwdriver.)

5. Screw the EMD onto the gauge cartridge.
6. Attach the signal cable to the EMD, aligning the red dot on the connector with the groove in the EMD.

7. Press **Master**.

8. Press an enabling switch and the Start key.
   When the EMD has passed through the reference notch, the mastering position is calculated. The robot stops automatically. The values are saved. The axis is no longer displayed in the window.

9. Remove the signal cable from the EMD. Then remove the EMD from the gauge cartridge and replace the protective cap.

10. Repeat steps 4 to 9 for all axes to be mastered.

11. Close the window.

12. Remove signal cable from connection X32.

**5.5.3.2 Teach offset (with EMD)**

**Description**  
Teach offset is carried out with a load. The difference from the first mastering is saved.

If the robot is operated with different loads, Teach offset must be carried out for every load. In the case of grippers used for picking up heavy workpieces, Teach offset must be carried out for the gripper both with and without the workpiece.
Precondition
- Same ambient conditions (temperature, etc.) as for first mastering.
- The load is mounted on the robot.
- All axes are in the pre-mastering position.
- No program is selected.
- Operating mode T1

Procedure

### NOTICE
The EMD must always be screwed onto the gauge cartridge without the signal cable attached. Only then may the signal cable be attached to the EMD. Otherwise, the signal cable could be damaged. Similarly, when removing the EMD, the signal cable must always be removed from the EMD first. Only then may the EMD be removed from the gauge cartridge. After mastering, remove the signal cable from connection X32. Failure to do so may result in interference signals or damage.

1. Select **Start-up > Master > EMD > With load correction > Teach offset** in the main menu.
2. Enter tool number. Confirm with **Tool OK**.
   A window opens. All axes for which the tool has not yet been taught are displayed. The axis with the lowest number is highlighted.
3. Remove the cover from connection X32 and connect the signal cable.
4. Remove the protective cap of the gauge cartridge on the axis highlighted in the window. (Turned around, the EMD can be used as a screwdriver.)
5. Screw the EMD onto the gauge cartridge.
6. Attach the signal cable to the EMD, aligning the red dot on the connector with the groove in the EMD.
7. Press **Learn**.
8. Press an enabling switch and the Start key.
   When the EMD has passed through the reference notch, the mastering position is calculated. The robot stops automatically. A window opens. The deviation of this axis from the first mastering is indicated in degrees and increments.
9. Click on **OK** to confirm. The axis is no longer displayed in the window.
10. Remove the signal cable from the EMD. Then remove the EMD from the gauge cartridge and replace the protective cap.
11. Repeat steps 4 to 10 for all axes to be mastered.
12. Close the window.
13. Remove signal cable from connection X32.

### 5.5.3.3 Check load mastering with offset (with EMD)

**Description**
- **Area of application:**
  - Checking first mastering
  - Restoring first mastering if it has been lost (e.g. following exchange of motor or collision). Since an offset that has been taught is retained, even if mastering is lost, the robot controller can calculate the first mastering.

**Precondition**
- Same ambient conditions (temperature, etc.) as for first mastering.
- A load for which **Teach offset** has been carried out is mounted on the robot.
5 Start-up and recommissioning

- All axes are in the pre-mastering position.
- No program is selected.
- Operating mode T1

**Procedure**

**NOTICE** The EMD must always be screwed onto the gauge cartridge without the signal cable attached. Only then may the signal cable be attached to the EMD. Otherwise, the signal cable could be damaged.

Similarly, when removing the EMD, the signal cable must always be removed from the EMD first. Only then may the EMD be removed from the gauge cartridge.

After mastering, remove the signal cable from connection X32. Failure to do so may result in interference signals or damage.

1. In the main menu, select **Start-up > Master > EMD > With load correction > Master load > With offset**.
2. Enter tool number. Confirm with **Tool OK**.
   
   A window opens. All axes for which an offset has been taught with this tool are displayed. The axis with the lowest number is highlighted.
3. Remove the cover from connection X32 and connect the signal cable.
4. Remove the protective cap of the gauge cartridge on the axis highlighted in the window. (Turned around, the EMD can be used as a screwdriver.)
5. Screw the EMD onto the gauge cartridge.
6. Attach the signal cable to the EMD, aligning the red dot on the connector with the groove in the EMD.
7. Press **Check**.
8. Hold down an enabling switch and press the Start key.
   
   When the EMD has passed through the reference notch, the mastering position is calculated. The robot stops automatically. The difference from “Teach offset” is displayed.
9. If required, press **Save** to save the values. The old mastering values are deleted.
   
   To restore a lost first mastering, always save the values.

**Axes A4, A5 and A6 are mechanically coupled. This means:**
- If the values for A4 are deleted, the values for A5 and A6 are also deleted.
- If the values for A5 are deleted, the values for A6 are also deleted.

10. Remove the signal cable from the EMD. Then remove the EMD from the gauge cartridge and replace the protective cap.
11. Repeat steps 4 to 10 for all axes to be mastered.
12. Close the window.
13. Remove signal cable from connection X32.

**5.5.4 Mastering with the dial gauge**

**Description** In dial mastering, the axis is moved manually by the user to the mastering position. Mastering is always carried out with a load. It is not possible to save mastering data for different loads.
Precondition

- The load is mounted on the robot.
- All axes are in the pre-mastering position.
- The jog mode “Jog keys” is active and the coordinate system Axis has been selected.
- No program is selected.
- Operating mode T1

Procedure

1. In the main menu, select Start-up > Master > Dial. A window opens. All axes that have not been mastered are displayed. The axis that must be mastered first is selected.
2. Remove the protective cap from the gauge cartridge on this axis and mount the dial gauge on the gauge cartridge. Using the Allen key, loosen the screws on the neck of the dial gauge. Turn the dial so that it can be viewed easily. Push the pin of the dial gauge in as far as the stop. Using the Allen key, tighten the screws on the neck of the dial gauge.
3. Reduce jog override to 1%.
4. Jog axis from “+” to “-”. At the lowest position of the reference notch, recognizable by the change in direction of the pointer, set the dial gauge to 0. If the axis inadvertently overshoots the lowest position, jog the axis backwards and forwards until the lowest position is reached. It is immaterial whether the axis is moved from “+” to “-” or from “-” to “+”.
5. Move the axis back to the pre-mastering position.
6. Move the axis from “+” to “-” until the pointer is about 5-10 scale divisions before zero.
7. Switch to incremental jogging.
8. Move the axis from “+” to “-” until zero is reached.

If the axis overshoots zero, repeat steps 5 to 8.

9. Press Master. The axis that has been mastered is removed from the window.
10. Remove the dial gauge from the gauge cartridge and replace the protective cap.
11. Switch back from incremental jogging to the normal jog mode.
12. Repeat steps 2 to 11 for all axes to be mastered.
13. Close the window.

Fig. 5-10: Dial gauge
5.5.5 Mastering external axes

**Description**
- KUKA external axes can be mastered using either the EMD or the dial gauge.
- Non-KUKA external axes can be mastered using the dial gauge. If mastering with the EMD is desired, the external axis must be fitted with gauge cartridges.

**Procedure**
- The procedure for mastering external axes is the same as that for mastering robot axes. Alongside the robot axes, the configured external axes now also appear in the axis selection window.

**Fig. 5-11: Selection list of axes to be mastered**

Mastering in the case of industrial robots with more than 2 external axes: if the system contains more than 8 axes, it may be necessary to connect the signal cable of the EMD to the second RDC.

5.5.6 Reference mastering

**Description**
Reference mastering is suitable if maintenance work is due on a correctly mastered robot and it is to be expected that the robot will lose its mastering. Examples:
- Exchange of RDC
- Exchange of motor

The robot is moved to the $MAMES position before the maintenance work is commenced. Afterwards, the axis values of this system variable are reassigned to the robot by means of reference mastering. The state of the robot is then the same as before the loss of mastering. Taught offsets are retained. No EMD or dial gauge is required.

In the case of reference mastering, it is irrelevant whether or not there is a load mounted on the robot. Reference mastering can also be used for external axes.
Preparation

- Move the robot to the $MAMES position before commencing the maintenance work. To do so, program a point PTP $MAMES and move the robot to it. This is only possible in the user group “Expert”!

**WARNING**
The robot must not move to the default HOME position instead of to $MAMES. $MAMES may be, but is not always, identical to the default HOME position. Only in the $MAMES position will the robot be correctly mastered by means of reference mastering. If the robot is reference mastered at any position other than $MAMES, this may result in injury and material damage.

Precondition

- No program is selected.
- Operating mode T1
- The position of the robot was not changed during the maintenance work.
- If the RDC has been exchanged: the robot data have been transferred from the hard drive to the RDC (this can only be done in the user group “Expert”!

Procedure

1. In the main menu, select Start-up > Master > Reference.
   The option window Reference mastering is opened. All axes that have not been mastered are displayed. The axis that must be mastered first is selected.
2. Press Master. The selected axis is mastered and removed from the option window.
3. Repeat step 2 for all axes to be mastered.

5.5.7 Mastering with the MEMD and mark

Overview

In MEMD mastering, the axis is automatically moved by the robot controller to the mastering position. Mastering is carried out first without and then with a load. It is possible to save mastering data for different loads.

A6 is not mastered using the MEMD, but with the aid of a mark. The procedure is described in the sections describing MEMD mastering.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>First mastering</td>
</tr>
<tr>
<td></td>
<td>(&gt;&gt;&gt; 5.5.7.1 &quot;First mastering (with MEMD)&quot; Page 99)</td>
</tr>
<tr>
<td></td>
<td>First mastering is carried out without a load.</td>
</tr>
</tbody>
</table>
5 Start-up and recommissioning

5.5.7.1 First mastering (with MEMD)

Precondition

- There is no load on the robot; i.e. there is no tool, workpiece or supplementary load mounted.
- A1 to A5 are in the pre-mastering position.

**MEMD**

The thinner cable is the signal cable. It connects the MEMD to the MEMD box.

The thicker cable is the EtherCAT cable. It is connected to the MEMD box and to the robot at X32.

### Table

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2 | **Teach offset**  
   (>>> 5.5.7.2 "Teach offset (with MEMD)" Page 102)  
   "Teach offset" is carried out with a load. The difference from the first mastering is saved. |
| 3 | If required: **Master load with offset**  
   (>>> 5.5.7.3 "Check load mastering with offset (with MEMD)" Page 103)  
   "Load mastering with offset" is carried out with a load for which an offset has already been taught.  
   Area of application:  
   - Checking first mastering  
   - Restoring first mastering if it has been lost (e.g. following exchange of motor or collision). Since an offset that has been taught is retained, even if mastering is lost, the robot controller can calculate the first mastering. |

---

**Notice** Leave the signal cable connected to the MEMD box and disconnect it as little as possible. The pluggability of the M8 sensor connector is limited. Frequent connection/disconnection can result in damage to the connector.

---

Fig. 5-12: MEMD case

1  MEMD box  
2  Screwdriver  
3  MEMD  
4  Cables

The thinner cable is the signal cable. It connects the MEMD to the MEMD box.

The thicker cable is the EtherCAT cable. It is connected to the MEMD box and to the robot at X32.
- No program is selected.
- Operating mode T1

**Procedure**

1. In the main menu, select **Start-up > Master > EMD > With load correction > First mastering**.
   
   A window opens. All axes to be mastered are displayed. The axis with the lowest number is highlighted.

2. Remove the cover from connection X32.

3. Connect the EtherCAT cable to X32 and to the MEMD box.

4. Remove the protective cap of the gauge cartridge on the axis highlighted in the window.
5 Start-up and recommissioning

5. Screw the MEMD onto the gauge cartridge.

6. Press **Master**.

7. Press an enabling switch and the Start key.
   When the MEMD has passed through the reference notch, the mastering position is calculated. The robot stops automatically. The values are saved. The axis is no longer displayed in the window.

8. Remove the MEMD from the gauge cartridge and replace the protective cap.

9. Repeat steps 4 to 8 for all axes to be mastered, except A6.

10. Close the window.

11. Move A6 to the mastering position:
    A6 has very fine marks in the metal. Align these marks exactly with one another.
12. In the main menu, select Start-up > Master > Reference. The option window Reference mastering is opened. A6 is displayed and is selected.

13. Press Master. A6 is mastered and removed from the option window.

14. Close the window.

15. Disconnect the EtherCAT cable from X32 and the MEMD box.

5.5.7.2 Teach offset (with MEMD)

**Description**

Teach offset is carried out with a load. The difference from the first mastering is saved. If the robot is operated with different loads, Teach offset must be carried out for every load. In the case of grippers used for picking up heavy workpieces, Teach offset must be carried out for the gripper both with and without the workpiece.

**Precondition**

- Same ambient conditions (temperature, etc.) as for first mastering.
- The load is mounted on the robot.
- A1 to A5 are in the pre-mastering position.
- No program is selected.
- Operating mode T1

**Procedure**

1. Select Start-up > Master > EMD > With load correction > Teach offset in the main menu.
2. Enter tool number. Confirm with Tool OK.

---

**Notice**

Leave the signal cable connected to the MEMD box and disconnect it as little as possible. The pluggability of the M8 sensor connector is limited. Frequent connection/disconnection can result in damage to the connector.

---

When moving to the mastering position, it is important to look at the fixed mark in a straight line from in front. If the mark is observed from the side, the movable mark cannot be aligned accurately enough. This results in incorrect mastering.
A window opens. All axes for which the tool has not yet been taught are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.
4. Connect the EtherCAT cable to X32 and to the MEMD box.
5. Remove the protective cap of the gauge cartridge on the axis highlighted in the window.
6. Screw the MEMD onto the gauge cartridge.
7. Press Learn.
8. Press an enabling switch and the Start key.
   When the MEMD has passed through the reference notch, the mastering position is calculated. The robot stops automatically. A window opens. The deviation of this axis from the first mastering is indicated in degrees and increments.
9. Click on OK to confirm. The axis is no longer displayed in the window.
10. Remove the MEMD from the gauge cartridge and replace the protective cap.
11. Repeat steps 5 to 10 for all axes to be mastered, except A6.
12. Close the window.
13. Move A6 to the mastering position:
   A6 has very fine marks in the metal. Align these marks exactly with one another.

WARNING When moving to the mastering position, it is important to look at the fixed mark in a straight line from in front. If the mark is observed from the side, the movable mark cannot be aligned accurately enough. This results in incorrect mastering.

   The option window Reference mastering is opened. A6 is displayed and is selected.
15. Press Master. A6 is mastered and removed from the option window.
16. Close the window.
17. Disconnect the EtherCAT cable from X32 and the MEMD box.

**5.5.7.3 Check load mastering with offset (with MEMD)**

**Description**

Area of application:

- Checking first mastering
- Restoring first mastering if it has been lost (e.g. following exchange of motor or collision). Since an offset that has been taught is retained, even if mastering is lost, the robot controller can calculate the first mastering.

**NOTICE** Leave the signal cable connected to the MEMD box and disconnect it as little as possible. The pluggability of the M8 sensor connector is limited. Frequent connection/disconnection can result in damage to the connector.

**An axis can only be checked if all axes with lower numbers have been mastered.**

**The value determined for A6 is not displayed, i.e. first mastering cannot be checked. It is possible to restore lost first mastering, however.**

**Precondition**

- Same ambient conditions (temperature, etc.) as for first mastering.
A load for which Teach offset has been carried out is mounted on the robot.

A1 to A5 are in the pre-mastering position.

No program is selected.

Operating mode T1

Procedure

1. In the main menu, select Start-up > Master > EMD > With load correction > Master load > With offset.
2. Enter tool number. Confirm with Tool OK.
   A window opens. All axes for which an offset has been taught with this tool are displayed. The axis with the lowest number is highlighted.
3. Remove the cover from connection X32.
4. Connect the EtherCAT cable to X32 and to the MEMD box.
5. Remove the protective cap of the gauge cartridge on the axis highlighted in the window.
6. Screw the MEMD onto the gauge cartridge.
7. Press Check.
8. Hold down an enabling switch and press the Start key.
   When the MEMD has passed through the reference notch, the mastering position is calculated. The robot stops automatically. The difference from “Teach offset” is displayed.
9. If required, press Save to save the values. The old mastering values are deleted.
   To restore a lost first mastering, always save the values.
10. Remove the MEMD from the gauge cartridge and replace the protective cap.
11. Repeat steps 5 to 10 for all axes to be mastered, except A6.
12. Close the window.
13. Move A6 to the mastering position:
   A6 has very fine marks in the metal. Align these marks exactly with one another.
   The option window Reference mastering is opened. A6 is displayed and is selected.
15. Press Master to restore lost first mastering. A6 is removed from the option window.
16. Close the window.
17. Disconnect the EtherCAT cable from X32 and the MEMD box.

Axes A4, A5 and A6 are mechanically coupled. This means:

- If the values for A4 are deleted, the values for A5 and A6 are also deleted.
- If the values for A5 are deleted, the values for A6 are also deleted.

When moving to the mastering position, it is important to look at the fixed mark in a straight line from in front. If the mark is observed from the side, the movable mark cannot be aligned accurately enough. This results in incorrect mastering.

When moving to the mastering position, it is important to look at the fixed mark in a straight line from in front. If the mark is observed from the side, the movable mark cannot be aligned accurately enough. This results in incorrect mastering.

   The option window Reference mastering is opened. A6 is displayed and is selected.
15. Press Master to restore lost first mastering. A6 is removed from the option window.
16. Close the window.
17. Disconnect the EtherCAT cable from X32 and the MEMD box.

NOTICE Leave the signal cable connected to the MEMD box and disconnect it as little as possible. The pluggability of the M8 sensor connector is limited. Frequent connection/disconnection can result in damage to the connector.
5.5.8 Manually unmastering axes

Description
The mastering values of the individual axes can be deleted. The axes do not move during unmastering.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also deleted.
If the values for A5 are deleted, the values for A6 are also deleted.

Precondition
- No program is selected.
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Master > Unmaster. A window opens.
2. Select the axis to be unmastered.
3. Press Unmaster. The mastering data of the axis are deleted.
4. Repeat steps 2 and 3 for all axes to be unmastered.
5. Close the window.

5.6 Modifying software limit switches

There are 2 ways of modifying the software limit switches:
- Enter the desired values manually.
- Or automatically adapt the limit switches to one or more programs.
  The robot controller determines the minimum and maximum axis positions occurring in the program. These values can then be set as software limit switches.

Precondition
- “Expert” user group
- T1, T2 or AUT mode

Procedure
Modifying software limit switches manually:
1. In the main menu, select Start-up > Service > Software limit switch. The Software limit switch window is opened.
2. Modify the limit switches as required in the columns Negative and Positive.
3. Save the changes with Save.

Adapting software limit switches to a program:
1. In the main menu, select Start-up > Service > Software limit switch. The Software limit switch window is opened.
2. Click on Auto detection. The following message is displayed: Auto detection is running.
3. Start the program to which the limit switches are to be adapted. Execute the program completely and then cancel it.
  The maximum and minimum position reached by each axis is displayed in the Software limit switch window.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also deleted.
If the values for A5 are deleted, the values for A6 are also deleted.

NOTICE
The software limit switches of an unmastered robot are deactivated. The robot can hit the end stop buffers, thus damaging the robot and making it necessary to exchange the buffers. An unmastered robot must not be jogged, if at all avoidable. If it must be jogged, the jog override must be reduced as far as possible.
4. Repeat step 3 for all programs to which the limit switches are to be adapted. The maximum and minimum position reached by each axis in all executed programs is displayed in the **Software limit switch** window.

5. Once all desired programs have been executed, press **End** in the **Software limit switch** window.

6. Press **Save** to save the determined values as software limit switches.

7. If required, modify the automatically determined values manually.

    Recommendation: Reduce the determined minimum values by 5°. Increase the determined maximum values by 5°. This margin prevents the axes from reaching the limit switches during program execution and thus triggering a stop.

8. Save the changes with **Save**.

**Description Software limit switch window:**

**Fig. 5-18: Before automatic determination**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current negative limit switch</td>
</tr>
<tr>
<td>2</td>
<td>Current position of the axis</td>
</tr>
<tr>
<td>3</td>
<td>Current positive limit switch</td>
</tr>
</tbody>
</table>
5 Start-up and recommissioning

5.7 Calibration

5.7.1 Tool calibration

Description During tool calibration, the user assigns a Cartesian coordinate system (TOOL coordinate system) to the tool mounted on the mounting flange.

The TOOL coordinate system has its origin at a user-defined point. This is called the TCP (Tool Center Point). The TCP is generally situated at the working point of the tool.

In the case of a fixed tool, the type of calibration described here must not be used. A separate type of calibration must be used for fixed tools. (>>> 5.7.3 "Fixed tool calibration" Page 118)
Advantages of tool calibration:
- The tool can be moved in a straight line in the tool direction.
- The tool can be rotated about the TCP without changing the position of the TCP.
- In program mode: The programmed velocity is maintained at the TCP along the path.

A maximum of 16 TOOL coordinate systems can be saved. Variable: TOOL_DATA[1…16].

The following data are saved:
- X, Y, Z:
  Origin of the TOOL coordinate system relative to the FLANGE coordinate system
- A, B, C:
  Orientation of the TOOL coordinate system relative to the FLANGE coordinate system

Fig. 5-20: TCP calibration principle

Overview
Tool calibration consists of 2 steps:
5 Start-up and recommissioning

If the calibration data are already known, they can be entered directly.

5.7.1.1 TCP calibration: XYZ 4-point method

### Description

The following methods are available:

- **XYZ 4-point**
  - (>>> 5.7.1.1 "TCP calibration: XYZ 4-point method" Page 109)
- **XYZ Reference**
  - (>>> 5.7.1.2 "TCP calibration: XYZ Reference method" Page 111)

The XYZ 4-point method cannot be used for palletizing robots.

The TCP of the tool to be calibrated is moved to a reference point from 4 different directions. The reference point can be freely selected. The robot controller calculates the TCP from the different flange positions.

The 4 flange positions at the reference point must be sufficiently different from one another.
Precondition

- The tool to be calibrated is mounted on the mounting flange.
- Operating mode T1

Procedure

1. In the main menu, select Start-up > Calibrate > Tool > XYZ 4-point.
2. Assign a number and a name for the tool to be calibrated. Confirm with Next.
3. Move the TCP to a reference point. Press Calibrate. Answer the request for confirmation with Yes.
4. Move the TCP to the reference point from a different direction. Press Calibrate. Answer the request for confirmation with Yes.
5. Repeat step 4 twice.
6. Enter the payload data. (This step can be skipped if the payload data are entered separately instead.)
   (>>> 5.8.3 "Entering payload data" Page 132)
7. Confirm with Next.
8. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press Meas. points. Then return to the previous view by pressing Back.
9. Either: press Save and then close the window via the Close icon.
   Or: press ABC 2-point or ABC World. The previous data are automatically saved and a window is opened in which the orientation of the TOOL coordinate system can be defined.
   (>>> 5.7.1.4 "Defining the orientation: ABC 2-point method" Page 112)
   (>>> 5.7.1.3 "Defining the orientation: ABC World method" Page 112)
5.7.1.2 TCP calibration: XYZ Reference method

Description
In the case of the XYZ Reference method, a new tool is calibrated with a tool that has already been calibrated. The robot controller compares the flange positions and calculates the TCP of the new tool.

Precondition
- A previously calibrated tool is mounted on the mounting flange.
- Operating mode T1

Preparation
Calculate the TCP data of the calibrated tool:
1. In the main menu, select **Start-up > Calibrate > Tool > XYZ Reference**.
2. Enter the number of the calibrated tool.
3. The tool data are displayed. Note the X, Y and Z values.
4. Close the window.

Procedure
1. In the main menu, select **Start-up > Calibrate > Tool > XYZ Reference**.
2. Assign a number and a name for the new tool. Confirm with **Next**.
3. Enter the TCP data of the calibrated tool. Confirm with **Next**.
4. Move the TCP to a reference point. Press **Calibrate**. Answer the request for confirmation with **Yes**.
5. Move the tool away and remove it. Mount the new tool.
6. Move the TCP of the new tool to the reference point. Press **Calibrate**. Answer the request for confirmation with **Yes**.
7. Enter the payload data. (This step can be skipped if the payload data are entered separately instead.)
   (>>> 5.8.3 "Entering payload data" Page 132)
8. Confirm with **Next**.
9. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press **Meas. points**. Then return to the previous view by pressing **Back**.
10. Either: press **Save** and then close the window via the **Close** icon.

Or: press **ABC 2-point** or **ABC World**. The previous data are automatically saved and a window is opened in which the orientation of the TOOL coordinate system can be defined.
   (>>> 5.7.1.4 "Defining the orientation: ABC 2-point method" Page 112)
   (>>> 5.7.1.3 "Defining the orientation: ABC World method" Page 112)
5.7.1.3 Defining the orientation: ABC World method

Description
The axes of the TOOL coordinate system are aligned parallel to the axes of the WORLD coordinate system. This communicates the orientation of the TOOL coordinate system to the robot controller.

There are 2 variants of this method:
- **5D**: Only the tool direction is communicated to the robot controller. By default, the tool direction is the X axis. The directions of the other axes are defined by the system and cannot be detected easily by the user.
  - Area of application: e.g. MIG/MAG welding, laser cutting or waterjet cutting
- **6D**: The directions of all 3 axes are communicated to the robot controller.
  - Area of application: e.g. for weld guns, grippers or adhesive nozzles

Precondition
- The tool to be calibrated is mounted on the mounting flange.
- The TCP of the tool has already been measured.
- Operating mode T1

Procedure
1. In the main menu, select **Start-up > Calibrate > Tool > ABC World**.
2. Enter the number of the tool. Confirm with **Next**.
3. Select a variant in the box **5D/6D**. Confirm with **Next**.
4. If **5D** is selected:
   - Align +XTOOL parallel to -ZWORLD. (+XTOOL = tool direction)
If **6D** is selected:
   - Align the axes of the TOOL coordinate system as follows.
     - +XTOOL parallel to -ZWORLD. (+XTOOL = tool direction)
     - +YTOOL parallel to +YWORLD
     - +ZTOOL parallel to +XWORLD
5. Press **Calibrate**. Answer the request for confirmation with **Yes**.
6. Enter the payload data. (This step can be skipped if the payload data are entered separately instead.)
   (>>> 5.8.3 "Entering payload data" Page 132)
7. Confirm with **Next**.
8. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press **Meas. points**. Then return to the previous view by pressing **Back**.
9. Press **Save**.

5.7.1.4 Defining the orientation: ABC 2-point method

Description
The axes of the TOOL coordinate system are communicated to the robot controller by moving to a point on the X axis and a point in the XY plane.

This method is used if it is necessary to define the axis directions with particular precision.
Precondition

- The tool to be calibrated is mounted on the mounting flange.
- The TCP of the tool has already been measured.
- Operating mode T1

The following procedure applies if the tool direction is the default tool direction (= X axis). If the tool direction has been changed to Y or Z, the procedure must also be changed accordingly.

Procedure

1. In the main menu, select Start-up > Calibrate > Tool > ABC 2-point.
2. Enter the number of the mounted tool. Confirm with Next.
3. Move the TCP to any reference point. Press Calibrate. Answer the request for confirmation with Yes.
4. Move the tool so that the reference point on the X axis has a negative X value (i.e. move against the tool direction). Press Calibrate. Answer the request for confirmation with Yes.
5. Move the tool so that the reference point in the XY plane has a negative Y value. Press Calibrate. Answer the request for confirmation with Yes.

The following two steps are eliminated if the procedure is not called via the main menu, but by means of the ABC 2-point button after TCP calibration.
6. Enter the payload data. (This step can be skipped if the payload data are entered separately instead.)
   (>>> 5.8.3 "Entering payload data" Page 132)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press Meas. points. Then return to the previous view by pressing Back.

9. Press Save.

### 5.7.1.5 Numeric input

**Description**
The tool data can be entered manually.

Possible sources of data:
- CAD
- Externally calibrated tool
- Tool manufacturer specifications

> In the case of palletizing robots with 4 axes, e.g. KR 180 PA, the tool data must be entered numerically. The XYZ and ABC methods cannot be used as reorientation of these robots is highly restricted.

**Precondition**
- The following values are known:
  - X, Y and Z relative to the FLANGE coordinate system
  - A, B and C relative to the FLANGE coordinate system
- Operating mode T1

**Procedure**
1. In the main menu, select Start-up > Calibrate > Tool > Numeric input.
2. Assign a number and a name for the tool to be calibrated. Confirm with Next.
3. Enter the tool data. Confirm with Next.
4. Enter the payload data. (This step can be skipped if the payload data are entered separately instead.)
   (>>> 5.8.3 "Entering payload data" Page 132)
5. If online load data verification is available (this depends on the robot type): configure as required.
   (>>> 5.8.5 "Online load data check" Page 133)
6. Confirm with Next.
7. Press Save.

### 5.7.2 Base calibration

**Description**
During base calibration, the user assigns a Cartesian coordinate system (BASE coordinate system) to a work surface or the workpiece. The BASE coordinate system has its origin at a user-defined point.

> If the workpiece is mounted on the mounting flange, the type of calibration described here must not be used. A separate type of calibration must be used for workpieces mounted on the mounting flange.
   (>>> 5.7.3 "Fixed tool calibration" Page 118)

Advantages of base calibration:
- The TCP can be jogged along the edges of the work surface or workpiece.
Points can be taught relative to the base. If it is necessary to offset the base, e.g. because the work surface has been offset, the points move with it and do not need to be retaught.

A maximum of 32 BASE coordinate systems can be saved. Variable: BASE_DATA[1…32].

Overview
There are 2 ways of calibrating a base:
- 3-point method (>>> 5.7.2.1 "3-point method" Page 115)
- Indirect method (>>> 5.7.2.3 "Indirect method" Page 117)

If the calibration data are already known, they can be entered directly.

5.7.2.1 3-point method

Description
The robot moves to the origin and 2 further points of the new base. These 3 points define the new base.

Precondition
- A previously calibrated tool is mounted on the mounting flange.
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > Base > ABC 3-point.
2. Assign a number and a name for the base. Confirm with Next.
3. Enter the number of the mounted tool. Confirm with Next.
4. Move the TCP to the origin of the new base. Press Calibrate. Answer the request for confirmation with Yes.
5. Move the TCP to a point on the positive X axis of the new base. Press Calibrate. Answer the request for confirmation with Yes.
6. Move the TCP to a point in the XY plane with a positive Y value. Press Calibrate. Answer the request for confirmation with Yes.
7. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press Meas. points. Then return to the previous view by pressing Back.
8. Press Save.

5.7.2.2 Indirect method

Description

The indirect method is used if it is not possible to move to the origin of the base, e.g. because it is inside a workpiece or outside the workspace of the robot.

The TCP is moved to 4 points in the base, the coordinates of which must be known. The robot controller calculates the base from these points.

Fig. 5-25: Indirect method

Precondition

- A calibrated tool is mounted on the mounting flange.
- The coordinates of 4 points in the new base are known, e.g. from CAD data. The 4 points are accessible to the TCP.
- Operating mode T1

Procedure

1. In the main menu, select Start-up > Calibrate > Base > Indirect.
2. Assign a number and a name for the base. Confirm with Next.
3. Enter the number of the mounted tool. Confirm with Next.
4. Enter the coordinates of a known point in the new base and move the TCP to this point. Press **Calibrate**. Answer the request for confirmation with **Yes**.

5. Repeat step 4 three times.

6. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press **Meas. points**. Then return to the previous view by pressing **Back**.

7. Press **Save**.

### 5.7.2.3 Indirect method

**Description**

The indirect method is used if it is not possible to move to the origin of the base, e.g. because it is inside a workpiece or outside the workspace of the robot.

The TCP is moved to 4 points in the base, the coordinates of which must be known. The robot controller calculates the base from these points.

**Fig. 5-26: Indirect method**

### Precondition

- A calibrated tool is mounted on the mounting flange.
- The coordinates of 4 points in the new base are known, e.g. from CAD data. The 4 points are accessible to the TCP.
- Operating mode T1

### Procedure

1. In the main menu, select **Start-up > Calibrate > Base > Indirect**.
2. Assign a number and a name for the base. Confirm with **Next**.
3. Enter the number of the mounted tool. Confirm with **Next**.
4. Enter the coordinates of a known point in the new base and move the TCP to this point. Press **Calibrate**. Confirm with **Next**.
5. Repeat step 4 three times.
6. Press **Save**.
5.7.3 Fixed tool calibration

Overview

Calibration of a fixed tool consists of 2 steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Calibration of the TCP of the fixed tool</td>
</tr>
<tr>
<td></td>
<td>The TCP of a fixed tool is called an external TCP.</td>
</tr>
<tr>
<td></td>
<td>If the calibration data are already known, they can be entered directly.</td>
</tr>
<tr>
<td>2</td>
<td>Calibration of the workpiece</td>
</tr>
<tr>
<td></td>
<td>The following methods are available:</td>
</tr>
<tr>
<td></td>
<td>■ Direct method</td>
</tr>
<tr>
<td></td>
<td>■ Indirect method</td>
</tr>
</tbody>
</table>

The robot controller saves the external TCP as the BASE coordinate system and the workpiece as the TOOL coordinate system. A maximum of 32 BASE coordinate systems and 16 TOOL coordinate systems can be saved.

5.7.3.1 Calibrating an external TCP

Description

First of all, the TCP of the fixed tool is communicated to the robot controller. This is done by moving a calibrated tool to it.

Then, the orientation of the coordinate system of the fixed tool is communicated to the robot controller. For this purpose, the coordinate system of the calibrated tool is aligned parallel to the new coordinate system. There are 2 variants:

- **5D**: Only the tool direction of the fixed tool is communicated to the robot controller. By default, the tool direction is the X axis. The orientation of the other axes is defined by the system and cannot be detected easily by the user.
- **6D**: The orientation of all 3 axes is communicated to the robot controller.
### Precondition
- A previously calibrated tool is mounted on the mounting flange.
- Operating mode T1

![Fig. 5-27: Moving to the external TCP](image)

![Fig. 5-28: Aligning the coordinate systems parallel to one another](image)

### Procedure
1. In the main menu, select **Start-up > Calibrate > Fixed tool > Tool**.
2. Assign a number and a name for the fixed tool. Confirm with **Next**.
3. Enter the number of the calibrated tool. Confirm with **Next**.
4. Select a variant in the box **5D/6D**. Confirm with **Next**.
5. Move the TCP of the calibrated tool to the TCP of the fixed tool. Press **Calibrate**. Answer the request for confirmation with **Yes**.
6. If 5D is selected:

   - The following procedure applies if the tool direction is the default tool direction (= X axis). If the tool direction has been changed to Y or Z, the procedure must also be changed accordingly.
Align \( +X_{\text{BASE}} \) parallel to \( -Z_{\text{FLANGE}} \).
(i.e. align the mounting flange perpendicular to the tool direction of the fixed tool.)

If 6D is selected:
Align the mounting flange so that its axes are parallel to the axes of the fixed tool:
- \( +X_{\text{BASE}} \) parallel to \( -Z_{\text{FLANGE}} \)
  (i.e. align the mounting flange perpendicular to the tool direction.)
- \( +Y_{\text{BASE}} \) parallel to \( +Y_{\text{FLANGE}} \)
- \( +Z_{\text{BASE}} \) parallel to \( +X_{\text{FLANGE}} \)

7. Press Calibrate. Answer the request for confirmation with Yes.
8. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press Meas. points. Then return to the previous view by pressing Back.
9. Press Save.

5.7.3.2 Entering the external TCP numerically

Precondition
- The following numerical values are known, e.g. from CAD data:
  - Distance between the TCP of the fixed tool and the origin of the WORLD coordinate system \((X, Y, Z)\)
  - Rotation of the axes of the fixed tool relative to the WORLD coordinate system \((A, B, C)\)
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric input.
2. Assign a number and a name for the fixed tool. Confirm with Next.
3. Enter data. Confirm with Next.
4. Press Save.

5.7.3.3 Workpiece calibration: direct method

Description
The origin and 2 further points of the workpiece are communicated to the robot controller. These 3 points uniquely define the workpiece.

Fig. 5-29
5 Start-up and recommissioning

5.7.3.4 Workpiece calibration: indirect method

The robot controller calculates the workpiece on the basis of 4 points whose coordinates must be known. The robot does not move to the origin of the workpiece.
Precondition
- A previously calibrated fixed tool is mounted.
- The workpiece to be calibrated is mounted on the mounting flange.
- The coordinates of 4 points of the new workpiece are known, e.g. from CAD data. The 4 points are accessible to the TCP.
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece > Indirect calibration.
2. Assign a number and a name for the workpiece. Confirm with Next.
3. Enter the number of the fixed tool. Confirm with Next.
4. Enter the coordinates of a known point on the workpiece and move this point to the TCP of the fixed tool. Press Calibrate. Answer the request for confirmation with Yes.
5. Repeat step 4 three times.
6. Enter the load data of the workpiece. (This step can be skipped if the load data are entered separately instead.)
   (>>> 5.8.3 "Entering payload data" Page 132)
7. Confirm with Next.
8. If required, coordinates and orientation of the calibrated points can be displayed in increments and degrees (relative to the FLANGE coordinate system). For this, press Meas. points. Then return to the previous view by pressing Back.
9. Press Save.

5.7.4 Renaming the tool/base

Precondition
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > Tool or Base > Change name.
2. Select the tool or base and press Name.
3. Enter the new name and confirm with Save.
5.7.5 Linear unit

The KUKA linear unit is a self-contained, one-axis linear unit mounted on the floor or ceiling. It is used for linear traversing of the robot and is controlled by the robot controller as an external axis.

The linear unit is a ROBROOT kinematic system. When the linear unit is moved, the position of the robot in the WORLD coordinate system changes. The current position of the robot in the WORLD coordinate system is defined by the vector $ROBROOT.C$.

$ROBROOT.C$ consists of:

- $ERSYSROOT$ (static component)
  Root point of the linear unit relative to $WORLD$. The root point is situated by default at the zero position of the linear unit and is not dependent on $MAMES$.

- #ERSYS (dynamic component)
  Current position of the robot on the linear unit relative to the $ERSYSROOT$

5.7.5.1 Checking whether the linear unit needs to be calibrated

Description

The robot is standing on the flange of the linear unit. Ideally, the ROBROOT coordinate system of the robot should be identical to the FLANGE coordinate system of the linear unit. In reality, there are often slight discrepancies which mean that positions cannot be moved to correctly. Calibration allows mathematical correction of these discrepancies. (Rotations about the direction of motion of the linear unit cannot be corrected. They do not, however, cause errors when moving to positions.)

If there are no discrepancies, the linear unit does not need to be calibrated. The following procedure can be used to determine whether calibration is required.

Precondition

- The machine data of the linear unit have been configured and loaded into the robot controller.
- A previously calibrated tool is mounted on the mounting flange.
- No program is open or selected.
- Operating mode T1

Procedure

1. Align the TCP against a freely selected point and observe it.
2. Execute a Cartesian (not axis-specific!) motion with the linear unit.
   - If the TCP stops: the linear unit does not require calibration.
   - If the TCP moves: the linear unit does require calibration.
   (>>> 5.7.5.2 "Calibrating the linear unit" Page 124)

If the calibration data are already known (e.g. from CAD), they can be entered directly. (>>> 5.7.5.3 "Entering the linear unit numerically" Page 125)

5.7.5.2 Calibrating the linear unit

Description

During calibration, the TCP of a tool that has already been calibrated is moved to a reference point 3 times.

- The reference point can be freely selected.
- The position of the robot on the linear unit from which the reference point is approached must be different all 3 times. The 3 positions must be far enough apart.

The correction values determined by the calibration are factored into the system variable $ETx_TFLA3.

Precondition

- The machine data of the linear unit have been configured and loaded into the robot controller.
- A previously calibrated tool is mounted on the mounting flange.
- No program is open or selected.
- Operating mode T1

Procedure

1. In the main menu, select Start-up > Calibrate > External kinematic system > Linear unit.
   The robot controller detects the linear unit automatically and displays the following data:
   - Ext. kinematic system no.: number of the external kinematic system (1 … 6) ($EX_KIN)
   - Axis: number of the external axis (1 … 6) ($ETx_AX)
   - Name of the external kinematic system ($ETx_NAME)
   (If the robot controller is unable to determine these values, e.g. because the linear unit has not yet been configured, calibration cannot be continued.)

2. Move the linear unit with the jog key “+”.
3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.
4. Move the TCP to the reference point.
5. Press Calibrate.
6. Repeat steps 4 and 5 twice, but move the linear unit first each time in order to address the reference point from different positions.
7. Press Save. The calibration data are saved.
8. The system asks whether the positions that have already been taught are to be corrected.
   - If no positions have been taught prior to the calibration, it makes no difference whether the question is answered with Yes or No.
   - If positions have been taught prior to the calibration:
     Answering Yes will cause positions with base 0 to be corrected automatically. Other positions will not be corrected!
     Answering No will cause no positions to be corrected.
### 5.7.5.3 Entering the linear unit numerically

#### Precondition
- The machine data of the linear unit have been configured and loaded into the robot controller.
- No program is open or selected.
- The following numerical values are known, e.g. from CAD data:
  - Distance between the robot base flange and the origin of the ERSYS-ROOT coordinate system (X, Y, Z)
  - Orientation of the robot base flange relative to the ERSYSROOT coordinate system (A, B, C)
- Operating mode T1

#### Procedure
1. In the main menu, select **Start-up > Calibrate > External kinematic system > Linear unit (numeric)**.
   
The robot controller detects the linear unit automatically and displays the following data:
   - **Ext. kinematic system no.:** number of the external kinematic system (1 ... 6)
   - **Axis:** number of the external axis (1 ... 6)
   - **Name of the kinematic system**
     
     (If the robot controller is unable to determine these values, e.g. because the linear unit has not yet been configured, calibration cannot be continued.)
2. Move the linear unit with the jog key “+”.
3. Specify whether the linear unit is moving to “+” or “-”. Confirm with **Next**.
4. Enter data. Confirm with **Next**.
5. Press **Save**. The calibration data are saved.
6. The system asks whether the positions that have already been taught are to be corrected.
   - If no positions have been taught prior to the calibration, it makes no difference whether the question is answered with **Yes** or **No**.
   - If positions have been taught prior to the calibration:
     
     Answering **Yes** will cause positions with base 0 to be corrected automatically. Other positions will not be corrected!
     
     Answering **No** will cause no positions to be corrected.

---

**NOTICE**

After calibration of a linear unit, the following safety measures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if required.
2. Test programs in T1.

Damage to property may otherwise result.
5.7.6  Calibrating an external kinematic system

Description
Calibration of the external kinematic system is necessary to enable the motion of the axes of the kinematic system to be synchronized and mathematically coupled with the robot axes. An external kinematic system can be a turn-tilt table or positioner, for example.

Overview
Calibration of an external kinematic system consists of 2 steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Calibrate the root point of the external kinematic system.  
(>>> 5.7.6.1 "Calibrating the root point" Page 126)  
If the calibration data are already known, they can be entered directly.  
(>>> 5.7.6.2 "Entering the root point numerically" Page 127) |
| 2    | If there is a workpiece on the external kinematic system: calibrate the base of the workpiece.  
(>>> 5.7.6.3 "Workpiece base calibration" Page 128)  
If the calibration data are already known, they can be entered directly.  
(>>> 5.7.6.4 "Entering the workpiece base numerically" Page 130)  
If there is a tool mounted on the external kinematic system: calibrate the external tool.  
(>>> 5.7.6.5 "Calibrating an external tool" Page 130)  
If the calibration data are already known, they can be entered directly.  
(>>> 5.7.6.6 "Entering the external tool numerically" Page 131) |

5.7.6.1  Calibrating the root point

Description
In order to be able to move the robot with a mathematical coupling to a kinematic system, the robot must know the precise location of the kinematic system. This location is determined by means of root point calibration.

The TCP of a tool that has already been calibrated is moved to a reference point on the kinematic system 4 times. The position of the reference point must be different each time. This is achieved by moving the axes of the kinematic system. The robot controller uses the different positions of the reference point to calculate the root point of the kinematic system.

In the case of external kinematic systems from KUKA, the reference point is configured in the system variable $ETx_TPINF in the machine data. This contains the position of the reference point relative to the FLANGE coordinate system of the kinematic system. \((x = \text{number of the kinematic system})\). The reference point is also marked on the kinematic system. During calibration, this reference point must be addressed.

In the case of non-KUKA external kinematic systems, the reference point must be configured in the machine data.
The robot controller saves the coordinates of the root point as the BASE coordinate system.

Fig. 5-33: Root point calibration principle

Precondition
- The machine data of the kinematic system have been configured and loaded into the robot controller.
- The number of the external kinematic system is known.
- A previously calibrated tool is mounted on the mounting flange.
- If $ET_x_{_TPINFL}$ is to be modified: user group “Expert”
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > External kinematic system > Root point.
2. Select the number of the BASE coordinate system the root point is to be saved as. Confirm with Next.
3. Enter the number of the external kinematic system.
4. Assign a name for the external kinematic system. Confirm with Next.
5. Enter the number of the reference tool. Confirm with Next.
6. The value of $ET_x_{_TPINFL}$ is displayed.
   - If the value is not correct: the value can be modified here in the user group “Expert”.
   - If the value is correct: confirm with Next.
7. Move the TCP to the reference point.
9. Repeat steps 7 and 8 three times. Each time, move the kinematic system first so that the reference point is approached from different positions.
10. Press Save.

5.7.6.2 Entering the root point numerically

Precondition
- The following numerical values are known, e.g. from CAD data:
  - Distance between the origin of the ROOT coordinate system and the origin of the WORLD coordinate system (X, Y, Z)
Orientation of the ROOT coordinate system relative to the WORLD coordinate system (A, B, C)
- The number of the external kinematic system is known.
- Operating mode T1

**Procedure**
1. In the main menu, select **Start-up > Calibrate > External kinematic system > Root point (numeric)**.
2. Select the number of the BASE coordinate system the root point is to be saved as. Confirm with **Next**.
3. Enter the number of the external kinematic system.
4. Assign a name for the external kinematic system. Confirm with **Next**.
   (The name is automatically also assigned to the BASE coordinate system.)
5. Enter the data of the ROOT coordinate system. Confirm with **Next**.
6. Press **Save**.

**5.7.6.3 Workpiece base calibration**

**Description**
During this calibration, the user assigns a BASE coordinate system to a workpiece located on the kinematic system. This BASE coordinate system is relative to the FLANGE coordinate system of the kinematic system. The base is thus a moving base that moves in the same way as the kinematic system.

It is not strictly necessary to calibrate a base. If none is calibrated, the FLANGE coordinate system of the kinematic system is taken as the base.

During calibration, the TCP of a calibrated tool is moved to the origin and 2 other points of the desired base. These 3 points define the base. Only one base can be calibrated per kinematic system.
5 Start-up and recommissioning

Precondition

- The machine data of the kinematic system have been configured and loaded into the robot controller.
- A previously calibrated tool is mounted on the mounting flange.
- The root point of the external kinematic system has been calibrated.
- The number of the external kinematic system is known.
- Operating mode T1

Procedure

1. In the main menu, select **Start-up > Calibrate > External kinematic system > Offset.**
2. Enter the number of the BASE coordinate system the root point was saved as. The name of the BASE coordinate system is displayed. Confirm with **Next.**
3. Enter the number of the external kinematic system. The name of the external kinematic system is displayed. Confirm with **Next.**
4. Enter the number of the reference tool. Confirm with Next.
5. Move the TCP to the origin of the workpiece base. Press Calibrate and confirm with Next.
6. Move the TCP to a point on the positive X axis of the workpiece base. Press Calibrate and confirm with Next.
7. Move the TCP to a point in the XY plane with a positive Y value. Press Calibrate and confirm with Next.
8. Press Save.

5.7.6.4 Entering the workpiece base numerically

Precondition
- The following numerical values are known, e.g. from CAD data:
  - Distance between the origin of the workpiece base and the origin of the FLANGE coordinate system of the kinematic system (X, Y, Z)
  - Rotation of the axes of the workpiece base relative to the FLANGE coordinate system of the kinematic system (A, B, C)
- The root point of the external kinematic system has been calibrated.
- The number of the external kinematic system is known.
- Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > External kinematic system > Offset (numeric).
2. Enter the number of the BASE coordinate system the root point was saved as. The name of the BASE coordinate system is displayed. Confirm with Next.
3. Enter the number of the external kinematic system. The name of the external kinematic system is displayed. Confirm with Next.
4. Enter data. Confirm with Next.
5. Press Save.

5.7.6.5 Calibrating an external tool

Description
During calibration of the external tool, the user assigns a coordinate system to the tool mounted on the kinematic system. This coordinate system has its origin in the TCP of the external tool and is relative to the FLANGE coordinate system of the kinematic system.

First of all, the user communicates to the robot controller the TCP of the tool mounted on the kinematic system. This is done by moving a calibrated tool to the TCP.

Then, the orientation of the coordinate system of the tool is communicated to the robot controller. For this purpose, the user aligns the coordinate system of the calibrated tool parallel to the new coordinate system. There are 2 variants:

- **5D**: The user communicates the tool direction to the robot controller. By default, the tool direction is the X axis. The orientation of the other axes is defined by the system and cannot be influenced by the user.
  - The system always defines the orientation of the other axes in the same way. If the tool subsequently has to be calibrated again, e.g. after a crash, it is therefore sufficient to define the tool direction again. Rotation about the tool direction need not be taken into consideration.
- **6D**: The user communicates the direction of all 3 axes to the robot controller.
The robot controller saves the coordinates of the external tool as the BASE coordinate system.

**Precondition**
- The machine data of the kinematic system have been configured and loaded into the robot controller.
- A previously calibrated tool is mounted on the mounting flange.
- The root point of the external kinematic system has been calibrated.
- The number of the external kinematic system is known.
- Operating mode T1

**Procedure**
1. In the main menu, select **Start-up** > **Calibrate** > **Fixed tool** > **External kinematic offset**.
2. Enter the number of the BASE coordinate system the root point was saved as. The name of the BASE coordinate system is displayed. Confirm with **Next**.
3. Enter the number of the external kinematic system. The name of the external kinematic system is displayed. Confirm with **Next**.
4. Enter the number of the reference tool. Confirm with **Next**.
5. Select a variant in the box **5D/6D**. Confirm with **Next**.
6. Move the TCP of the calibrated tool to the TCP of the external tool. Press **Calibrate** and confirm with **Next**.
7. If **5D** is selected:
   - Align \( +X_{\text{BASE}} \) parallel to \( -Z_{\text{FLANGE}} \).
   - (i.e. align the mounting flange perpendicular to the tool direction of the external tool.)
   - If **6D** is selected:
     - Align the mounting flange so that its axes are parallel to the axes of the external tool:
       - \( +X_{\text{BASE}} \) parallel to \( -Z_{\text{FLANGE}} \)
       - (i.e. align the mounting flange perpendicular to the tool direction of the external tool.)
       - \( +Y_{\text{BASE}} \) parallel to \( +Y_{\text{FLANGE}} \)
       - \( +Z_{\text{BASE}} \) parallel to \( +X_{\text{FLANGE}} \)
8. Press **Calibrate** and confirm with **Next**.
9. Press **Save**.

5.7.6.6 **Entering the external tool numerically**

**Precondition**
- The following numerical values are known, e.g. from CAD data:
  - Distance between the TCP of the external tool and the origin of the FLANGE coordinate system of the kinematic system \((X, Y, Z)\)
  - Rotation of the axes of the external tool relative to the FLANGE coordinate system of the kinematic system \((A, B, C)\)
Operating mode T1

Procedure
1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric input.
2. Assign a number and a name for the external tool. Confirm with Next.
3. Enter data. Confirm with Next.
4. Press Save.

5.8 Load data

The load data are factored into the calculation of the paths and accelerations and help to optimize the cycle times. The load data must be entered in the robot controller.

Sources
Load data can be obtained from the following sources:
- Software option KUKA.LoadDataDetermination (only for payloads on the flange)
- Manufacturer information
- Manual calculation
- CAD programs

5.8.1 Checking loads with KUKA.Load

All load data (payload and supplementary loads) must be checked with the KUKA.Load software. Exception: If the payload is checked with KUKA.LoadDataDetermination, it is not necessary to check it with KUKA.Load.

A sign-off sheet can be generated for the loads with KUKA.Load. KUKA.Load can be downloaded free of charge, complete with the documentation, from the KUKA website www.kuka.com.

More information is contained in the KUKA.Load documentation.

5.8.2 Calculating payloads with KUKA.LoadDataDetermination

Description
KUKA.LoadDataDetermination can be used to calculate payloads exactly and transfer them to the robot controller.

Precondition
- T1 or T2 operating mode
- No program is selected.

Procedure
- In the main menu, select Start-up > Service > Load data determination.

More information is contained in the KUKA.LoadDataDetermination documentation.

5.8.3 Entering payload data

Description
The payload data must be entered in the robot controller and assigned to the correct tool.

Exception: If the payload data have already been transferred to the robot controller by KUKA.LoadDataDetermination, no manual entry is required.
5 Start-up and recommissioning

Precondition
- The payload data have been checked with KUKA.Load or KUKA.Load-Determination and the robot is suitable for these payloads.

Procedure
1. In the main menu, select Start-up > Calibrate > Tool > Payload data.
2. Enter the number of the tool in the box Tool no. Confirm with Next.
3. Enter the payload data:
   - Box M: Mass
   - Boxes X, Y, Z: Position of the center of gravity relative to the flange
   - Boxes A, B, C: Orientation of the principal inertia axes relative to the flange
   - Boxes JX, JY, JZ: Mass moments of inertia
     (JX is the inertia about the X axis of the coordinate system that is rotated relative to the flange by A, B and C. JY and JZ are the analogous inertia about the Y and Z axes.)
   Or, if the default values for this robot type are to be used: press Default.
4. If online load data verification is available (this depends on the robot type): configure as required.
   (>>> 5.8.5 "Online load data check" Page 133)
5. Confirm with Next.
6. Press Save.

5.8.4 Entering supplementary load data

Description
The supplementary load data must be entered in the robot controller.

Reference systems of the X, Y and Z values for each supplementary load:

<table>
<thead>
<tr>
<th>Load</th>
<th>Reference system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplementary load A1</td>
<td>ROBROOT coordinate system A1 = 0°</td>
</tr>
<tr>
<td>Supplementary load A2</td>
<td>ROBROOT coordinate system A2 = -90°</td>
</tr>
<tr>
<td>Supplementary load A3</td>
<td>FLANGE coordinate system A4 = 0°, A5 = 0°, A6 = 0°</td>
</tr>
</tbody>
</table>

Precondition
- The supplementary loads have been verified with KUKA.Load and are suitable for this robot type.

Procedure
1. In the main menu, select Setup > Measure > Supplementary load data.
2. Enter the number of the axis on which the supplementary load is to be mounted. Confirm with Continue.
3. Enter the load data. Confirm with Continue.
4. Press Save.

5.8.5 Online load data check

Configuration
OLDC can be configured as follows:
- During manual entry of the tool data
  (>>> 5.7.1.5 "Numeric input" Page 114)
- During separate entry of the payload data
  (>>> 5.8.3 "Entering payload data" Page 132)
The following boxes are displayed in the same window in which the payload data are also entered:

![Configuration of the online load data verification](image)

**Fig. 5-35: Online load data check**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | **TRUE:** OLDC is activated for the tool displayed in the same window. The defined reactions are carried out in the case of an overload or underload.  
**FALSE:** OLDC is deactivated for the tool displayed in the same window. There is no reaction in the case of an overload or underload. |
| 2    | The overload reaction can be defined here.  
- **None:** No reaction.  
- **Warning:** The robot controller generates the following status message: *Check of robot load (Tool {No.}) calculated overload.*  
- **Stop robot:** The robot controller generates an acknowledgement message with the same content as that generated under **Warning.** The robot stops with a STOP 2. |
| 3    | The underload reaction can be defined here. The possible reactions are analogous to those for an overload. |

The reactions can be modified in the KRL program using the system variable $LDC_CONFIG.

### 5.9 Exporting/importing long texts

**Description**

If names have been assigned to inputs/outputs, flags, etc., these names (so-called "long texts") can be exported to a file. It is also possible to import a file with long text names. In this way, the long texts do not need to be re-entered manually for each robot after reinstallation.

**Precondition**

- USB memory stick

For import only:

- The long text names are present on the stick in a TXT or CSV file.
- The file structure is suitable for importing.

If the file to be imported was generated by means of a long text export, it is automatically suitable. If the file is to be created manually, it is advisable first to assign a few dummy long text names in the robot controller, perform an export and adopt the structure of the exported file.

**Procedure**

1. Plug the USB stick into the cabinet or smartPAD.
2. In the main menu, select **Start-up > Service > Long texts**. The **Long texts** window is opened.
3. Select the **Export** or **Import** tab as required. Make the desired settings.
4. Press the **Export** or **Import** button.
When the import is finished, the message *Import successful.* is displayed. When the export is finished, the message *Export successful.* is displayed.

**“Export” tab**

![Export Tab Diagram](image_url)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the destination for the exported file.</td>
</tr>
<tr>
<td>2</td>
<td>Specify the desired file name. A suffix corresponding to the language selected is automatically appended to the name.</td>
</tr>
<tr>
<td>3</td>
<td>Select the language from which the long texts are to be exported. If, for example, the smartHMI is set to “English” and “Italiano” is selected here, a file with the suffix “it” is created. It contains the long texts that have been stored on the Italian smartHMI. It is also possible to select <strong>All languages</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>Select the desired file format.</td>
</tr>
<tr>
<td>5</td>
<td>Starts the export.</td>
</tr>
</tbody>
</table>

**“Import” tab**

![Import Tab Diagram](image_url)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Specify where the stick with the import file is plugged in.</td>
</tr>
<tr>
<td>2</td>
<td>Specify the name of the import file, but without the language suffix.</td>
</tr>
<tr>
<td>3</td>
<td>Specify the language matching the language suffix of the import file.</td>
</tr>
</tbody>
</table>
The Maintenance handbook functionality is available in the KUKA System Software. The maintenance handbook enables logging of the maintenance work. The logged maintenance work can be displayed in an overview.

The robot controller uses messages to indicate when maintenance is due:

- A message is generated one month before the maintenance work is due. This message can be acknowledged.
- At the end of the month, the robot controller generates a message indicating that the maintenance is now due. This message cannot be acknowledged. Additionally, LED4 on the Controller System Panel flashes (= first LED from the left in the bottom row).

Only when the corresponding maintenance work has been logged does the robot controller reset the message and the LED stops flashing.

The due dates are determined by the maintenance intervals specified in the KUKA maintenance agreements. The intervals are counted from the initial start-up of the robot controller. The operating hours of the robot are counted.

### 5.10.1 Logging maintenance

**Description**

It is not possible to log multiple maintenance activities of the same kind on one day.

Once saved, changes can no longer be made.

**Precondition**

- “Expert” user group

**Procedure**

1. In the main menu, select **Start-up > Service > Maintenance handbook**. The **Maintenance handbook** window is opened.
2. Select the **Maintenance input** tab and enter the maintenance details. Entries must be made in all boxes.
3. Press **Save**. A request for confirmation is displayed.
4. If all entries are correct, answer the request for confirmation with **Yes**.

The entries are now saved. Switching to the **Maintenance overview** tab causes the maintenance to be displayed there.
Start-up and recommissioning

5.10.2 Displaying a maintenance log

Description

The logged maintenance work can be displayed in an overview.

If the KUKA System Software is updated (e.g. from KSS 8.3.1 to KSS 8.3.2), this overview is retained.

Maintenance types

By default, the following maintenance types can be selected:

- Basic inspection
- In-line wrist maintenance
- Main axis maintenance
- Gear backlash measurement
- Minor electrical maintenance
- Major electrical maintenance
- Data backup with spare hard drive
- Repair

These maintenance types correspond to those in the KUKA maintenance agreements. Depending on the options used (e.g. linear axis or technology packages), other maintenance types may be available for selection.
When archiving is carried out, the maintenance logs are also archived. If, when the data are restored, other maintenance work has been logged on the robot controller in the meantime, these logs are not overwritten; instead, the restored logs are added to the overview.

**Procedure**

1. In the main menu, select **Start-up > Service > Maintenance handbook**. The **Maintenance handbook** window is opened.
2. Select the **Maintenance overview** tab.

![Fig. 5-39: Maintenance overview](image-url)
6 Program management

6.1 Navigator file manager

Overview

Fig. 6-1: Navigator

1 Header 3 File list
2 Directory structure 4 Status bar

Description

In the Navigator, the user manages programs and system-specific files.

Header

- Left-hand area: the selected filter is displayed.
  (>>> 6.1.1 "Selecting filters" Page 140)
- Right-hand area: the directory or drive selected in the directory structure is displayed.

Directory structure

Overview of directories and drives. Exactly which directories and drives are displayed depends on the user group and configuration.

File list

The contents of the directory or drive selected in the directory structure are displayed. The manner in which programs are displayed depends on the selected filter.

The file list has the following columns:
Status bar

The status bar can display the following information:

- Selected objects
- Action in progress
- User dialogs
- User entry prompts
- Requests for confirmation

6.1.1 Selecting filters

**Description**

This function is not available in the user group “User”.

The filter defines how programs are displayed in the file list. The following filters are available:

- **Detail**
  Programs are displayed as SRC and DAT files. (Default setting)
- **Modules**
  Programs are displayed as modules.

**Precondition**

- “Expert” user group

**Procedure**

1. Select the menu sequence **Edit** > **Filter**.
2. Select the desired filter in the left-hand section of the Navigator.
3. Confirm with **OK**.

6.1.2 Creating a new folder

**Precondition**

- The Navigator is displayed.

**Procedure**

1. In the directory structure, select the folder in which the new folder is to be created, e.g. the folder **R1**.
   
   Not all folders allow the creation of new folders within them. In the user groups “Operator” and “User”, new folders can only be created in the folder **R1**.
   
2. Press **New**.
3. Enter a name for the folder and confirm it with **OK**.
6.1.3 Creating a new program

**Description**
It is not possible to select a template in the user group “User”. By default, a program of type “Module” is created.

**Precondition**
- The Navigator is displayed.

**Procedure**
1. In the directory structure, select the folder in which the program is to be created, e.g. the folder **Program**. (Not all folders allow the creation of programs within them.)
2. Press **New**.
3. Only in the user group “Expert”:
   - The **Template selection** window is opened. Select the desired template and confirm with **OK**.
4. Enter a name for the program and confirm it with **OK**.

6.1.4 Renaming a file

**Precondition**
- The Navigator is displayed.

**Procedure**
1. In the directory structure, select the folder in which the file is located.
2. Select the file in the file list.
3. Select **Edit > Rename**.
4. Overwrite the file name with the new name and confirm with **OK**.

6.2 Selecting or opening a program

**Overview**
A program can be selected or opened. Instead of the Navigator, an editor is then displayed with the program.

- **Selecting and deselecting a program** Page 142
- **Opening a program** Page 143

It is possible to toggle backwards and forwards between the program display and the Navigator.

- **Toggling between the Navigator and the program** Page 143

**Differences**

**Program is selected:**
- The block pointer is displayed.
- The program can be started.
- The program can be edited to a certain extent.
  - Selected programs are particularly suitable for editing in the user group “User”.
  - Example: KRL instructions covering several lines (e.g. LOOP ... END-LOOP) are not permissible.
  - When the program is deselected, modifications are accepted without a request for confirmation. If impermissible modifications are programmed, an error message is displayed.

**Program is opened:**
- The program cannot be started.
- The program can be edited.
  - Opened programs are particularly suitable for editing in the user group “Expert”.
  - A request for confirmation is generated when the program is closed. Modifications can be accepted or rejected.
6.2.1 Selecting and deselecting a program

If a selected program is edited in the user group “Expert”, the cursor must then be removed from the edited line and positioned in any other line! Only in this way is it certain that the editing will be applied when the program is deselected again.

Precondition
- T1, T2 or AUT mode

Procedure
1. Select the program in the Navigator and press Select. The program is displayed in the editor. It is irrelevant whether a module, an SRC file or a DAT file is selected. It is always the SRC file that is displayed in the editor.
2. Start or edit the program.
3. Deselect the program again: Select Edit > Cancel program. Or: In the status bar, touch the Robot interpreter status indicator. A window opens. Select Cancel program.

When the program is deselected, modifications are accepted without a request for confirmation!

If the program is running, it must be stopped before it can be deselected.

Description
If a program is selected, this is indicated by the Robot interpreter status indicator.

(>>> 6.5.6 “Robot interpreter status indicator” Page 148)

Fig. 6-2: Program is selected

1. Block pointer
2. Cursor
3. Program path and file name
6.2.2 Opening a program

**Precondition**
- T1, T2 or AUT mode

A program can be opened in AUT EXT mode, but not edited.

**Procedure**
1. Select the program in the Navigator and press **Open**. The program is displayed in the editor.
   - If a module has been selected, the SRC file is displayed in the editor. If an SRC file or DAT file has been selected, the corresponding file is displayed in the editor.
2. Edit the program.
3. Close the program.
4. To accept the changes, answer the request for confirmation with **Yes**.

**Description**

![Program in Editor]

1. Cursor
2. Program path and file name
3. Position of the cursor in the program

**Fig. 6-3: Program is open**

6.2.3 Toggling between the Navigator and the program

**Description**
If a program is selected or open, it is possible to display the Navigator again without having to deselect or close the program. The user can then return to the program.

**Procedure**
- **Program is selected:**
  - Toggling from the program to the Navigator: select the menu sequence **Edit > Navigator**.
  - Toggling from the Navigator to the program: press **PROGRAM**.
6.3 Structure of a KRL program

```
1  DEF my_program( )
2    INI
3
4  PTP HOME  Vel= 100 % DEFAULT
   ...
8  LIN point_5 CONT Vel= 2 m/s CPDAT1 Tool[3] Base[4]
   ...
14 PTP point_1 CONT Vel= 100 % PDAT1 Tool[3] Base[4]
   ...
20 PTP HOME  Vel= 100 % DEFAULT
21
22 END
```

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The DEF line indicates the name of the program. If the program is a function, the DEF line begins with &quot;DEFFCT&quot; and contains additional information. The DEF line can be displayed or hidden. (&gt;&gt;&gt; 6.4.1 &quot;Displaying/hiding the DEF line&quot; Page 145)</td>
</tr>
<tr>
<td>2</td>
<td>The INI line contains initializations for internal variables and parameters.</td>
</tr>
<tr>
<td>4</td>
<td>HOME position (&gt;&gt;&gt; 6.3.1 &quot;HOME position&quot; Page 145)</td>
</tr>
<tr>
<td>8</td>
<td>LIN motion (&gt;&gt;&gt; 8.2.3 &quot;Programming a LIN motion&quot; Page 180)</td>
</tr>
<tr>
<td>14</td>
<td>PTP motion (&gt;&gt;&gt; 8.2.1 &quot;Programming a PTP motion&quot; Page 179)</td>
</tr>
<tr>
<td>20</td>
<td>HOME position</td>
</tr>
<tr>
<td>22</td>
<td>The END line is the last line in any program. If the program is a function, the wording of the END line is &quot;ENDFCT&quot;. The END line must not be deleted!</td>
</tr>
</tbody>
</table>

The first motion instruction in a KRL program must define an unambiguous starting position. The HOME position, which is stored by default in the robot controller, ensures that this is the case.

If the first motion instruction is not the default HOME position, or if this position has been changed, one of the following statements must be used:

- Complete PTP instruction of type POS or E6POS
- Complete PTP instruction of type AXIS or E6AXIS

"Complete" means that all components of the end point must be specified.

**WARNING**

If the HOME position is modified, this affects all programs in which it is used. Injuries or damage to property may result.
In programs that are used exclusively as subprograms, different statements can be used as the first motion instruction.

6.3.1 HOME position

The HOME position is not program-specific. It is generally used as the first and last position in the program as it is uniquely defined and uncritical.

The HOME position is stored by default with the following values in the robot controller:

<table>
<thead>
<tr>
<th>Axis</th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
<th>A5</th>
<th>A6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pos.</td>
<td>0°</td>
<td>-90°</td>
<td>+90°</td>
<td>0°</td>
<td>0°</td>
<td>0°</td>
</tr>
</tbody>
</table>

Additional HOME positions can be taught. A HOME position must meet the following conditions:

- Good starting position for program execution
- Good standstill position. For example, the stationary robot must not be an obstacle.

**WARNING** If the HOME position is modified, this affects all programs in which it is used. Injuries or damage to property may result.

6.4 Displaying/hiding program sections

6.4.1 Displaying/hiding the DEF line

**Description** By default, the DEF line is hidden. Declarations can only be made in a program if the DEF line is visible.

The DEF line is displayed and hidden separately for opened and selected programs. If detail view (ASCII mode) is activated, the DEF line is visible and does not need to be activated separately.

**Precondition**
- User group “Expert”
- Program is selected or open.

**Procedure**
- Select the menu sequence **Edit > View > DEF line**.
  - Check mark activated in menu: DEF line is displayed.
  - Check mark not activated in menu: DEF line is hidden.

6.4.2 Activating detail view

**Description** Detail view (ASCII mode) is deactivated by default to keep the program transparent. If detail view is activated, hidden program lines, such as the FOLD and ENDFOLD lines and the DEF line, are displayed.

Detail view is activated and deactivated separately for opened and selected programs.

**Precondition**
- “Expert” user group

**Procedure**
- Select the menu sequence **Edit > View > Detail view (ASCII)**.
  - Check box activated: Detail view is activated.
  - Check box deactivated: Detail view is deactivated.
6.4.3 Activating/deactivating the line break function

Description
If a line is wider than the program window, the line is broken by default. The part of the line after the break has no line number and is marked with a black, L-shaped arrow. The line break function can be deactivated.

[Program code:]

```plaintext
8 EXT IBGN (IBGN_COMMAND :IN,BOOL :IN,REAL :IN,REAL
, :IN,BOOL :IN,EPOS :OUT)
```

Fig. 6-4: Line break
The line break function is activated and deactivated separately for opened and selected programs.

Precondition
- User group “Expert”
- Program is selected or open.

Procedure
- Select the menu sequence Edit > View > Line break.
  - Check mark activated in menu: line break function is activated.
  - Check mark not activated in menu: line break function is deactivated.

6.5 Starting a program

6.5.1 Selecting the program run mode

Procedure
1. Touch the Program run mode status indicator. The Program run mode window is opened.
2. Select the desired program run mode.
   (>>> 6.5.2 "Program run modes" Page 146)
   The window closes and the selected program run mode is applied.

6.5.2 Program run modes

<table>
<thead>
<tr>
<th>Program run mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go #GO</td>
<td>The program is executed through to the end without stopping.</td>
</tr>
<tr>
<td>Motion Step #MSTEP</td>
<td>The program is executed with a stop after each motion block. The Start key must be pressed again for each motion block. The program is executed without advance processing.</td>
</tr>
<tr>
<td>Single Step #ISTEP</td>
<td>The program is executed with a stop after each program line. Program lines that cannot be seen and blank lines are also taken into consideration. The Start key must be pressed again for each line. The program is executed without advance processing. &lt;br&gt;Single Step is only available to the user group “Expert”.</td>
</tr>
<tr>
<td>Backward #BSTEP</td>
<td>This program run mode is automatically selected if the Start backwards key is pressed.</td>
</tr>
</tbody>
</table>
6.5.3 Advance run

The advance run is the maximum number of motion blocks that the robot controller calculates and plans in advance during program execution. The actual number is dependent on the capacity of the computer. The default value is 3.

The advance run refers to the current position of the block pointer. The advance run is required, for example, in order to be able to calculate approximate positioning motions.

Certain statements trigger an advance run stop. These include statements that influence the periphery, e.g. OUT statements.

6.5.4 Setting the program override (POV)

**Description**

Program override is the velocity of the robot during program execution. The program override is specified as a percentage of the programmed velocity.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green]</td>
<td>Green</td>
<td>Drives ready</td>
</tr>
<tr>
<td>![Gray]</td>
<td>Gray</td>
<td>Drives not ready</td>
</tr>
</tbody>
</table>

In T1 mode, the maximum velocity is 250 mm/s, irrespective of the value that is set.

**Procedure**

1. Touch the **POV/HOV** status indicator. The **Override** window is opened.
2. Set the desired program override. It can be set using either the plus/minus keys or by means of the slide controller.
   - Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%
   - Slide controller: The override can be adjusted in 1% steps.
3. Touch the **POV/HOV** status indicator again. (Or touch the area outside the window.)
   
   The window closes and the selected override value is applied.

**Alternative procedure**

Alternatively, the override can be set using the plus/minus key on the right-hand side of the KCP.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

6.5.5 Switching drives on/off

The status of the drives is indicated in the status bar. The drives can also be switched on or off here.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green]</td>
<td>Green</td>
<td>Drives ready</td>
</tr>
<tr>
<td>![Gray]</td>
<td>Gray</td>
<td>Drives not ready</td>
</tr>
</tbody>
</table>
6.5.6  Robot interpreter status indicator

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="gray.png" alt="Gray Icon" /></td>
<td>Gray</td>
<td>No program is selected.</td>
</tr>
<tr>
<td><img src="yellow.png" alt="Yellow Icon" /></td>
<td>Yellow</td>
<td>The block pointer is situated on the first line of the selected program.</td>
</tr>
<tr>
<td><img src="green.png" alt="Green Icon" /></td>
<td>Green</td>
<td>The program is selected and is being executed.</td>
</tr>
<tr>
<td><img src="red.png" alt="Red Icon" /></td>
<td>Red</td>
<td>The selected and started program has been stopped.</td>
</tr>
<tr>
<td><img src="black.png" alt="Black Icon" /></td>
<td>Black</td>
<td>The block pointer is situated at the end of the selected program.</td>
</tr>
</tbody>
</table>

6.5.7  Starting a program forwards (manual)

**Precondition**
- A program is selected.
- Operating mode T1 or T2

**Procedure**
1. Select the program run mode.
2. Hold the enabling switch down and wait until the status bar indicates “Drives ready”:

![Illuminated Icon](green.png)

**Fig. 6-5**
3. Carry out a BCO run: Press Start key and hold it down until the message “Programmed path reached (BCO)” is displayed in the message window. The robot stops.

**WARNING** A BCO run is always executed as a PTP motion from the actual position to the target position. Observe the motion to avoid collisions. The velocity is automatically reduced during the BCO run.

4. Press Start key and hold it down.
   The program is executed with or without stops, depending on the program run mode.

To stop a program that has been started manually, release the Start key.

6.5.8  Starting a program forwards (automatic)

**Precondition**
- A program is selected.
- Operating mode Automatic (not Automatic External)

**Procedure**
1. Select the program run mode **Go**.
2. Switch on the drives.
3. Carry out a BCO run:
Press Start key and hold it down until the message “Programmed path reached (BCO)” is displayed in the message window. The robot stops.

**WARNING** A BCO run is always executed as a PTP motion from the actual position to the target position. Observe the motion to avoid collisions. The velocity is automatically reduced during the BCO run.

4. Press the Start key. The program is executed.

To stop a program that has been started in Automatic mode, press the STOP key.

### 6.5.9 Carrying out a block selection

**Description** A program can be started at any point by means of a block selection.

**Precondition**
- A program is selected.
- Operating mode T1 or T2

**Procedure**
1. Select the program run mode.
2. Select the motion block at which the program is to be started.
3. Press **Block selection**. The block pointer indicates the motion block.
4. Hold the enabling switch down and wait until the status bar indicates “Drives ready”:

![Drives ready](image)

5. Carry out a BCO run: Press Start key and hold it down until the message “Programmed path reached (BCO)” is displayed in the message window. The robot stops.

**WARNING** A BCO run is always executed as a PTP motion from the actual position to the target position. Observe the motion to avoid collisions. The velocity is automatically reduced during the BCO run.

6. The program can now be started manually or automatically. It is not necessary to carry out a BCO run again.

### 6.5.10 Starting a program backwards

**Description** In the case of backward motion, the robot stops at every point. Approximate positioning is not possible.

**Precondition**
- A program is selected.
- Operating mode T1 or T2

**Procedure**
1. Hold the enabling switch down and wait until the status bar indicates “Drives ready”:

![Drives ready](image)

2. Carry out a BCO run: Press Start key and hold it down until the message “Programmed path reached (BCO)” is displayed in the message window. The robot stops.

**WARNING** A BCO run is always executed as a PTP motion from the actual position to the target position. Observe the motion to avoid collisions. The velocity is automatically reduced during the BCO run.
3. Press Start backwards key.
4. Press Start backwards key again for each motion block.

6.5.11 Resetting a program

Description
In order to restart an interrupted program from the beginning, it must be reset. This returns the program to the initial state.

Precondition
- Program is selected.

Procedure
- Select the menu sequence Edit > Reset program.

Alternative procedure
- In the status bar, touch the Robot interpreter status indicator. A window opens.
  Select Reset program.

6.5.12 Starting Automatic External mode

There is no BCO run in Automatic External mode. This means that the robot moves to the first programmed position after the start at the programmed (not reduced) velocity and does not stop there.

Precondition
- Operating mode T1 or T2
- Inputs/outputs for Automatic External are configured.
- The program CELL.SRC is configured.

Procedure
1. Select the program CELL.SRC in the Navigator. (This program is located in the folder “R1”.)
2. Set program override to 100%. (This is the recommended setting. A different value can be set if required.)
3. Carry out a BCO run:
   Hold down the enabling switch. Then press the Start key and hold it down until the message “Programmed path reached (BCO)” is displayed in the message window.

A BCO run is always executed as a PTP motion from the actual position to the target position. Observe the motion to avoid collisions. The velocity is automatically reduced during the BCO run.

4. Select “Automatic External” mode.
5. Start the program from a higher-level controller (PLC).

To stop a program that has been started in Automatic mode, press the STOP key.

6.6 Editing a program

Overview
- A running program cannot be edited.
- Programs cannot be edited in AUT EXT mode.

If a selected program is edited in the user group “Expert”, the cursor must then be removed from the edited line and positioned in any other line!

Only in this way is it certain that the editing will be applied when the program is deselected again.
<table>
<thead>
<tr>
<th>Action</th>
<th>Possible in user group …?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert comment or stamp</td>
<td>User: Yes</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Delete lines</td>
<td>User: Yes</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Create folds</td>
<td>User: No</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Copy</td>
<td>User: No</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Paste</td>
<td>User: No</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Insert blank lines</td>
<td>User: No</td>
</tr>
<tr>
<td>(press the Enter key)</td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Cut</td>
<td>User: No</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>Find</td>
<td>User: Yes</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td></td>
<td>Possible for all user groups in an open program, even in AUT EXT mode.</td>
</tr>
<tr>
<td>Replace</td>
<td>User: No</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes (program is open, not selected)</td>
</tr>
<tr>
<td>Programming with inline forms</td>
<td>User: Yes</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
<tr>
<td>KRL programming</td>
<td>User: Possible to a certain extent. KRL instructions covering several lines (e.g. LOOP … ENDLOOP) are not permissible.</td>
</tr>
<tr>
<td></td>
<td>Expert: Yes</td>
</tr>
</tbody>
</table>
6.6.1 Inserting a comment or stamp

Precondition
- Program is selected or open.
- Operating mode T1

Procedure
1. Select the line after which the comment or stamp is to be inserted.
2. Select the menu sequence Commands > Comment > Normal or Stamp.
3. Enter the desired data. If a comment or stamp has already been entered previously, the inline form still contains the same entries.
   - In the case of a comment, the box can be cleared using New text ready for entry of a new text.
   - In the case of a stamp, the system time can also be updated using New time and the NAME box can be cleared using New name.
4. Save with Cmd Ok.

Description
Comment

Fig. 6-6: Inline form “Comment”

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Any text</td>
</tr>
</tbody>
</table>

Stamp

A stamp is a comment that is extended to include the system date and time and the user ID.

Fig. 6-7: Inline form “Stamp”

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System date (cannot be edited)</td>
</tr>
<tr>
<td>2</td>
<td>System time</td>
</tr>
<tr>
<td>3</td>
<td>Name or ID of the user</td>
</tr>
<tr>
<td>4</td>
<td>Any text</td>
</tr>
</tbody>
</table>

6.6.2 Deleting program lines

Description
If a program line containing a motion instruction is deleted, the point name and coordinates remain saved in the DAT file. The point can be used in other motion instructions and does not need to be taught again.

Precondition
- Program is selected or open.
- Operating mode T1

Procedure
1. Select the line to be deleted. (The line need not have a colored background. It is sufficient for the cursor to be in the line.)
If several consecutive lines are to be deleted: drag a finger or stylus across the desired area. (The area must now have a colored background.)

2. Select the menu sequence Edit > Delete.
3. Confirm the request for confirmation with Yes.

6.6.3 Additional editing functions

The following additional program editing functions can be called using Edit:

**Copy**
Precondition:
- Program is selected or open.
- “Expert” user group
- Operating mode T1

**Paste**
Precondition:
- Program is selected or open.
- “Expert” user group
- Operating mode T1

**Cut**
Precondition:
- Program is selected or open.
- “Expert” user group
- Operating mode T1

**Find**
Precondition:
- Program is selected or open.

**Replace**
Precondition:
- Program has been opened.
- “Expert” user group
- Operating mode T1

6.7 Printing a program

**Procedure**
1. Select the program in the Navigator. Multiple program selection is also possible.
2. Select the menu sequence Edit > Print.

6.8 Archiving and restoring data

6.8.1 Archiving overview

**Target locations**
Archiving can be performed to the following target destinations:
- USB stick in KCP or robot controller
- Network

**Menu items**
The following menu items are available:
If archiving is carried out using the menu item **All** and there is an existing archive present, this will be overwritten.

If archiving is carried out using a menu item other than **All** or **KrcDiag** and an archive is already available, the robot controller compares its robot name with

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Archives the directories/files</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All</strong></td>
<td>KRC:*.<em>&lt;br&gt;C:KRC\Roboter\Config\User*.</em>&lt;br&gt;C:KRC\Roboter\Config\System\Common\Mada*.<em>&lt;br&gt;C:KRC\Roboter\Init*.</em>&lt;br&gt;C:KRC\Roboter\lr_Spec*.<em>&lt;br&gt;C:KRC\Roboter\Template*.</em>&lt;br&gt;C:KRC\Roboter\Rdc*.<em>&lt;br&gt;C:KRC\User*.</em>&lt;br&gt;C:KRC\Roboter\log\Mastery.log&lt;br&gt;Some additional log data</td>
</tr>
<tr>
<td><strong>Applications</strong></td>
<td>KRC:R1\Program*.<em>&lt;br&gt;KRC:R1\System*.</em>&lt;br&gt;KRC:R1\cell*.<em>&lt;br&gt;KRC:Steuer\config*.</em></td>
</tr>
<tr>
<td><strong>System data</strong></td>
<td>KRC:R1\Mada*.<em>&lt;br&gt;KRC:R1\System*.</em>&lt;br&gt;KRC:R1\TP*.<em>&lt;br&gt;KRC:Steuer\Mada*.</em>&lt;br&gt;C:KRC\Roboter\Config\User*.<em>&lt;br&gt;C:KRC\Roboter\Config\System\Common\Mada*.</em>&lt;br&gt;C:KRC\Roboter\Init*.<em>&lt;br&gt;C:KRC\Roboter\lr_Spec*.</em>&lt;br&gt;C:KRC\Roboter\Template*.<em>&lt;br&gt;C:KRC\Roboter\Rdc*.</em>&lt;br&gt;C:KRC\User*.*</td>
</tr>
<tr>
<td><strong>Log data</strong></td>
<td>C:KRC\Roboter\log*.*&lt;br&gt;Except: Poslog.xsl and files with the extension DMP&lt;br&gt;Some additional log data</td>
</tr>
<tr>
<td><strong>KrcDiag</strong></td>
<td>If it is necessary for an error to be analyzed by KUKA Roboter Gmbh, this menu item can be used to compress the data for sending to KUKA.&lt;br&gt;A screenshot of the current view of the smartHMI is automatically generated for the data packet. For this reason, display error-relevant information on the smartHMI before starting the operation, e.g. expand the message window or display the logbook. What information is useful here depends on the specific circumstances.&lt;br&gt;In addition to the menu sequence <strong>File &gt; Archive</strong>, there are other methods available for compressing these data.</td>
</tr>
</tbody>
</table>

("*.*" means all files and subdirectories.)

(>>> 6.8.6 "Automatically compressing data for error analysis at KUKA" Page 156)
that in the archive. If the names are different, a request for confirmation is generated.

If archiving is carried out repeatedly via KrcDiag, a maximum of 10 archives can be created. Further archives will overwrite the oldest existing archive.

The logbook can also be activated. (>>> 6.8.4 "Archiving the logbook" Page 156)

6.8.2 Archiving to a USB stick

Description
This procedure generates a ZIP file on the stick. By default, this file has the same name as the robot. A different name can be defined for the file, however, under Robot data.

(>>> 4.15.12 "Displaying/editing robot data" Page 83)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving is also carried out automatically to D:\ as well as to the stick. The file INTERN.ZIP is generated here.

Special case KrcDiag:
This menu item generates the folder KRCDiag on the stick. This contains a ZIP file. The ZIP file is also automatically archived in C:\KUKA\KCRCDiag.

NOTICE
A non-bootable USB stick must be used.
Recommendation: Use a non-bootable KUKA stick. Data may be lost if a stick from a different manufacturer is used.

Procedure
1. Connect the USB stick (to KCP or cabinet).
2. In the main menu, select File > Archive > USB (KCP) or USB (cabinet) and then the desired menu item.
3. Confirm the request for confirmation with Yes. The archive is created.
   Once the archiving is completed, this is indicated in the message window.
   Special case KrcDiag: If archiving is carried out using this menu item, a separate window indicates when archiving has been completed. The window is then automatically hidden again.
4. The stick can now be removed.

6.8.3 Archiving on the network

Description
This procedure generates a ZIP file on the network path. By default, this file has the same name as the robot. A different name can be defined for the file, however, under Start-up > Robot data.

The network path to which archiving is to be carried out must be configured in the Robot data window. If a user name and password are required for archiving to this path, these can also be entered here.

(>>> 4.15.12 "Displaying/editing robot data" Page 83)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving is also carried out automatically to D:\ as well as to the network path. The file INTERN.ZIP is generated here.

Special case KrcDiag:
This menu item generates the folder KRCDiag on the network path. This contains a ZIP file. The ZIP file is also automatically archived in C:\KUKA\KCRCDiag.

Precondition
- The network path to which the data are to be archived is configured.
Procedure 1. In the main menu, select File > Archive > Network and then the desired menu item.

2. Confirm the request for confirmation with Yes. The archive is created.

Once the archiving is completed, this is indicated in the message window.

Special case KrcDiag: If archiving is carried out using this menu item, a separate window indicates when archiving has been completed. The window is then automatically hidden again.

6.8.4 Archiving the logbook

Description The file "Logbuch.txt" is generated as an archive in the directory C:\KRC\ROBOTER\LOG.

Procedure

- In the main menu, select File > Archive > Logbook.

The archive is created. Once the archiving is completed, this is indicated in the message window.

6.8.5 Restoring data

Description

![WARNING] Only KSS 8.3 archives may be loaded into KSS 8.3. If other archives are loaded, the following may occur:

- Error messages
- Robot controller is not operable.
- Personal injury and damage to property.

The following menu items are available for restoring data:

- All
- Applications
- System data

If the archived files are not the same version as the files present in the system, an error message is generated during restoration.

Similarly, if the version of the archived technology packages does not match the installed version, an error message is generated.

Precondition

- If data are to be restored from the USB stick: a USB stick with the archive is connected.

The stick can be connected to the KCP or robot controller.

![NOTICE] A non-bootable USB stick must be used.

Recommendation: Use a non-bootable KUKA stick. Data may be lost if a stick from a different manufacturer is used.

Procedure

1. In the main menu, select File > Restore and then the desired subitems.

2. Confirm the request for confirmation with Yes. Archived files are restored to the robot controller. A message indicates completion of the restoration process.

3. If data have been restored from a USB stick: the stick can now be removed.

4. Reboot the robot controller.

6.8.6 Automatically compressing data for error analysis at KUKA

Description If it is necessary for an error to be analyzed by KUKA Roboter GmbH, this procedure can be used to compress the data for sending to KUKA. The procedure
generates a ZIP file in the directory C:\KUKA\KRCDiag. This contains the data required by KUKA Roboter GmbH to analyze an error (including information about system resources, screenshots, and much more).

**Preparation**
A screenshot of the current view of the smartHMI is automatically generated for the data packet.

- For this reason, display error-relevant information on the smartHMI if possible before starting the operation, e.g. expand the message window or display the logbook.

  What information is useful here depends on the specific circumstances.

**Procedure via “Diagnosis”**
- In the main menu, select **Diagnosis > KrcDiag**.

  The data are compressed. Progress is displayed in a window. Once the operation has been completed, this is also indicated in the window. The window is then automatically hidden again.

**Procedure via smartPAD**
This procedure uses keys on the smartPAD instead of menu items. It can thus also be used if the smartHMI is not available, due to Windows problems for example.

**Precondition:**
- The smartPAD is connected to the robot controller.
- The robot controller is switched on.

  The keys must be pressed within 2 seconds. Whether or not the main menu and keypad are displayed in the smartHMI is irrelevant.

1. Press the “Main menu” key and hold it down.
2. Press the keypad key twice.
3. Release the “Main menu” key.

  The data are compressed. Progress is displayed in a window. Once the operation has been completed, this is also indicated in the window. The window is then automatically hidden again.

**Procedure via “Archive”**
Alternatively, the data can also be compressed via **File > Archive > [...]**. In this way, the data can be stored on a USB stick or network path.

(>>>> 6.8 "Archiving and restoring data" Page 153)
7 Basic principles of motion programming

7.1 Overview of motion types

The following motion types can be programmed:

- **Point-to-point motions (PTP)**
  
  (>>> 7.2 "Motion type PTP" Page 159)

- **Linear motions (LIN)**
  
  (>>> 7.3 "Motion type LIN" Page 160)

- **Circular motions (CIRC)**
  
  (>>> 7.4 "Motion type CIRC" Page 160)

- **Spline motions**

  Spline motions have a number of advantages over conventional PTP, LIN and CIRC motions.
  
  (>>> 7.7 "Motion type “Spline”" Page 163)

The start point of a motion is always the end point of the previous motion.

The following motions are known as CP ("Continuous Path") motions.

- LIN, CIRC, CP spline blocks, SLIN, SCIRC

7.2 Motion type PTP

The robot guides the TCP along the fastest path to the end point. The fastest path is generally not the shortest path and is thus not a straight line. As the motions of the robot axes are rotational, curved paths can be executed faster than straight paths.

The exact path of the motion cannot be predicted.

Fig. 7-1: PTP motion
7.3 Motion type LIN

The robot guides the TCP at a defined velocity along a straight path to the end point.

Fig. 7-2: LIN motion

7.4 Motion type CIRC

The robot guides the TCP at a defined velocity along a circular path to the end point. The circular path is defined by a start point, auxiliary point and end point.

Fig. 7-3: CIRC motion
7.5 Approximate positioning

Approximate positioning means that the motion does not stop exactly at the programmed point. Approximate positioning is an option that can be selected during motion programming.

Approximate positioning is not possible if the motion instruction is followed by an instruction that triggers an advance run stop.

**PTP motion**

The TCP leaves the path that would lead directly to the end point and moves along a faster path. During programming of the motion, the maximum distance from the end point at which the TCP may deviate from its original path is defined.

The path of an approximated PTP motion cannot be predicted. It is also not possible to predict which side of the approximated point the path will run.

**LIN motion**

The TCP leaves the path that would lead directly to the end point and moves along a shorter path. During programming of the motion, the maximum distance from the end point at which the TCP may deviate from its original path is defined.

The path in the approximate positioning range is **not** an arc.

**CIRC motion**

The TCP leaves the path that would lead directly to the end point and moves along a shorter path. During programming of the motion, the maximum distance from the end point at which the TCP may deviate from its original path is defined.

The motion always stops exactly at the auxiliary point.

The path in the approximate positioning range is **not** an arc.
7.6 Orientation control LIN, CIRC

Description

The orientation of the TCP can be different at the start point and end point of a motion. There are several different types of transition from the start orientation to the end orientation. A type must be selected when a CP motion is programmed.

The orientation control for LIN and CIRC motions is defined as follows:

- In the option window **Motion parameter**

<table>
<thead>
<tr>
<th>Orientation control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Constant orientation</strong></td>
<td>The orientation of the TCP remains constant during the motion. The programmed orientation is disregarded for the end point and that of the start point is retained.</td>
</tr>
<tr>
<td><strong>Standard</strong></td>
<td>The orientation of the TCP changes continuously during the motion. <strong>Note:</strong> If, with <strong>Standard</strong>, the robot passes through a wrist axis singularity, use <strong>Wrist PTP</strong> instead.</td>
</tr>
<tr>
<td><strong>Wrist PTP</strong></td>
<td>The orientation of the TCP changes continuously during the motion. This is done by linear transformation (axis-specific motion) of the wrist axis angles. <strong>Note:</strong> Use <strong>Wrist PTP</strong> if, with <strong>Standard</strong>, the robot passes through a wrist axis singularity. The orientation of the TCP changes continuously during the motion, but not uniformly. <strong>Wrist PTP</strong> is thus not suitable if a specific orientation must be maintained exactly, e.g. in the case of laser welding.</td>
</tr>
</tbody>
</table>

If a wrist axis singularity occurs with **Standard** and the desired orientation cannot be maintained exactly enough with **Wrist PTP**, the following remedy is recommended:

Re-teach start and/or end point. Select orientations that prevent a wrist axis singularity from occurring and allow the path to be executed with **Standard**.
7 Basic principles of motion programming

7.7 Motion type “Spline”

Spline is a motion type that is suitable for particularly complex, curved paths. Such paths can generally also be generated using approximated LIN and CIRC motions, but spline nonetheless has advantages.

The most versatile spline motion is the spline block. A spline block is used to group together several motions as an overall motion. The spline block is planned and executed by the robot controller as a single motion block.

The motions that may be included in a spline block are called spline segments. They are taught separately.

- A CP spline block can contain SPL, SLIN and SCIRC segments.
- A PTP spline block can contain SPTP segments.

In addition to spline blocks, individual spline motions can also be programmed: SLIN, SCIRC and SPTP.

CIRC motion

The same orientation control options are available for selection for CIRC motions as for LIN motions.

During CIRC motions, the robot controller only takes the programmed orientation of the end point into consideration. The programmed orientation of the auxiliary point is disregarded.

Fig. 7-7: Constant orientation

Fig. 7-8: Standard or Wrist PTP
Advantages of spline blocks

- The path is defined by means of points that are located on the path. The desired path can be generated easily.

- The programmed velocity is maintained better than with conventional motion types. There are few cases in which the velocity is reduced. (>>> 7.7.1 "Velocity profile for spline motions" Page 165)

- Furthermore, special constant velocity ranges can be defined in CP spline blocks.

- The path always remains the same, irrespective of the override setting, velocity or acceleration.

- Circles and tight radii are executed with great precision.

Disadvantages of LIN/CIRC

- The path is defined by means of approximated points that are not located on the path. The approximate positioning ranges are difficult to predict. Generating the desired path is complicated and time-consuming.
In many cases, the velocity may be reduced in a manner that is difficult to predict, e.g. in the approximate positioning ranges and near points that are situated close together.

The path changes if approximate positioning is not possible, e.g. for time reasons.

The path changes in accordance with the override setting, velocity or acceleration.

7.7.1 **Velocity profile for spline motions**

The path always remains the same, irrespective of the override setting, velocity or acceleration.

The robot controller already takes the physical limits of the robot into consideration during planning. The robot moves as fast as possible within the constraints of the programmed velocity, i.e. as fast as its physical limits will allow. This is an advantage over conventional LIN and CIRC motions for which the physical limits are not taken into consideration during planning. It is only during motion execution that these limits have any effect and can cause stops to be triggered.

**Reduction of the velocity**

Prime examples of cases in which the velocity has to fall below the programmed velocity include:

- Tight corners
- Major reorientation
- Large motions of the external axes
- Motion in the vicinity of singularities

Reduction of the velocity due to major reorientation can be avoided with spline segments by selecting the orientation control option **Ignore orientation**.

**Reduction of the velocity to 0**

This is the case for:

- Successive points with the same coordinates.
- Successive SLIN and/or SCIRC segments. Cause: inconstant velocity direction.

In the case of SLIN-SCIRC transitions, the velocity is also reduced to 0 if the straight line is a tangent of the circle, as the circle, unlike the straight line, is curved.

![Fig. 7-11: Exact positioning at P2](image-url)
7.7.2 Block selection with spline motions

Spline block

Block selection can be made to the segments of a spline block.

- CP spline block:
  The BCO run is executed as a conventional LIN motion. This is indicated by means of a message that must be acknowledged.

- PTP spline block:
  The BCO run is executed as a conventional PTP motion. This is not indicated by a message.

Following a block selection, the path is generally the same as if the spline were to be executed during normal program execution.

Exceptions are possible if the spline has never yet been executed prior to the block selection and the block selection is made here to the start of the spline block:

The start point of the spline motion is the last point before the spline block, i.e. the start point is outside the block. The robot controller saves the start point during normal execution of a spline. In this way, it is already known in the case of a block selection being carried out subsequently. If the spline block has never yet been executed, however, the start point is unknown.

If the Start key is pressed after the BCO run, the modified path is indicated by means of a message that must be acknowledged.

Example: modified path in the case of block selection to P1
SCIRC

In the case of block selection to a SCIRC segment for which a circular angle has been programmed, the motion is executed to the end point including the circular angle, provided that the robot controller knows the start point.

If the robot controller does not know the start point, the motion is executed to the programmed end point. In this case, a message is generated, indicating that the circular angle is not being taken into consideration.

In the case of a block selection to an individual SCIRC motion, the circular angle is never taken into consideration.

7.7.3 Modifications to spline blocks

Description
- Modification of the position of the point:
  If a point within a spline block is offset, the path is modified, at most, in the 2 segments before this point and the 2 segments after it.
  Small point offsets generally result in small modifications to the path. If, however, very long segments are followed by very short segments or vice versa, small modifications can have a very great effect.
- Modification of the segment type:
  If an SPL segment is changed into an SLIN segment or vice versa, the path changes in the previous segment and the next segment.

Example 1

Original path:

---

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Header/start of the CP spline block</td>
</tr>
<tr>
<td>3 ... 9</td>
<td>Spline segments</td>
</tr>
<tr>
<td>10</td>
<td>End of the CP spline block</td>
</tr>
</tbody>
</table>
A point is offset relative to the original path:

P3 is offset. This causes the path to change in segments P1 - P2, P2 - P3 and P3 - P4. Segment P4 - P5 is not changed in this case, as it belongs to an SCIRC and a circular path is thus defined.

The type of a segment is changed relative to the original path:

In the original path, the segment type of P2 - P3 is changed from SPL to SLIN. The path changes in segments P1 - P2, P2 - P3 and P3 - P4.
Example 2

Original path:

```
... SPLINE
  SPL (X 100, Y 0, ...)
  SPL (X 102, Y 0)
  SPL (X 104, Y 0)
  SPL (X 204, Y 0)
ENDSPLINE
```

Fig. 7-18: Original path

A point is offset relative to the original path:

P3 is offset. This causes the path to change in all the segments illustrated. Since P2 - P3 and P3 - P4 are very short segments and P1 - P2 and P4 - P5 are long segments, the slight offset causes the path to change greatly.

```
... SPLINE
  SPL (X 100, Y 0, ...)
  SPL (X 102, Y 1)
  SPL (X 104, Y 0)
  SPL (X 204, Y 0)
ENDSPLINE
```

Fig. 7-17: Segment type has been changed
7.7.4  Approximation of spline motions

All spline blocks and all individual spline motions can be approximated with one another. It makes no difference whether they are CP or PTP spline blocks, nor is the motion type of the individual motion relevant.

The motion type of the approximate positioning arc always corresponds to the second motion. In the case of SPTP-SLIN approximation, for example, the approximate positioning arc is of type CP.

Spline motions cannot be approximated with conventional motions (LIN, CIRC, PTP).

Approximation not possible due to time or advance run stops:

If approximation is not possible for reasons of time or due to an advance run stop, the robot waits at the start of the approximate positioning arc.

- In the case of time reasons: the robot moves again as soon as it has been possible to plan the next block.
- In the case of an advance run stop: the end of the current block is reached at the start of the approximate positioning arc. This means that the advance run stop is canceled and the robot controller can plan the next block. Robot motion is resumed.

In both cases, the robot now moves along the approximate positioning arc. Approximate positioning is thus technically possible; it is merely delayed.

This response differs from that for LIN, CIRC or PTP motions. If approximate positioning is not possible for the reasons specified, the motion is executed to the end point with exact positioning.

No approximate positioning in MSTEP and ISTEP:

In the program run modes MSTEP and ISTEP, the robot stops exactly at the end point, even in the case of approximated motions.

In the case of approximate positioning from one spline block to another spline block, the result of this exact positioning is that the path is different in the last segment of the first block and in the first segment of the second block from the path in program run mode GO.

In all other segments of both spline blocks, the path is identical in MSTEP, ISTEP and GO.

7.7.5  Replacing an approximated CP motion with a spline block

Description

In order to replace approximated conventional CP motions with spline blocks, the program must be modified as follows:

- Replace LIN - LiN with SLIN - SPL - SLIN.
Replace LIN - CIRC with SLIN - SPL - SCIRC.
Recommendation: Allow the SPL to project a certain way into the original circle. The SCIRC thus starts later than the original CIRC.

In approximated motions, the corner point is programmed. In the spline block, the points at the start and end of the approximation are programmed instead.

The following approximated motion is to be reproduced:

```
LIN P1 C_DIS
LIN P2
```

Spline motion:

```
SPLINE
SLIN P1A
SPL P1B
SLIN P2
ENDSPLINE
```

P1A = start of approximation, P1B = end of approximation

---

Fig. 7-20: Approximated motion - spline motion

Ways of determining P1A and P1B:
- Execute the approximated path and save the positions at the desired point by means of Trigger.
- Calculate the points in the program with KRL.
- The start of the approximation can be determined from the approximate positioning criterion. Example: If C_DIS is specified as the approximate positioning criterion, the distance from the start of the approximation to the corner point corresponds to the value of $APO.CDIS.

The end of the approximation is dependent on the programmed velocity.

The SPL path does not correspond exactly to the approximate positioning arc, even if P1A and P1B are exactly at the start/end of the approximation. In order to recreate the exact approximate positioning arc, additional points must be inserted into the spline. Generally, one point is sufficient.

Example

The following approximated motion is to be reproduced:

```
$APO.CDIS=20
$VEL.CP=0.5
LIN (Z 10) C_DIS
LIN (Y 60)
```
Spline motion:

```
SPLINE WITH $VEL.CP=0.5
  SLIN {Z 30}
  SPL {Y 30, Z 10}
  SLIN {Y 60}
ENDSPLINE
```

The start of the approximate positioning arc has been calculated from the approximate positioning criterion.

![Graph showing a spline motion example](image)

**Fig. 7-21: Example: Approximated motion - spline motion 1**

The SPL path does not yet correspond exactly to the approximate positioning arc. For this reason, an additional SPL segment is inserted into the spline.

```
SPLINE WITH $VEL.CP=0.5
  SLIN {Z 30}
  SPL {Y 15, Z 15}
  SPL {Y 30, Z 10}
  SLIN {Y 60}
ENDSPLINE
```
With the additional point, the path now corresponds to the approximate positioning arc.

### 7.7.5.1 SLIN-SPL-SLIN transition

In the case of a SLIN-SPL-SLIN segment sequence, it is usually desirable for the SPL segment to be located within the smaller angle between the two straight lines. Depending on the start and end point of the SPL segment, the path may also move outside this area.

The path remains inside if the following conditions are met:
- The extensions of the two SLIN segments intersect.
7.8 Orientation control for CP spline motions

Description

The orientation of the TCP can be different at the start point and end point of a motion. When a CP spline motion is programmed, it is necessary to select how to deal with the different orientations.

The orientation control type is defined in the option window Motion parameters.

<table>
<thead>
<tr>
<th>Orientation control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant orientation</td>
<td>The orientation of the TCP remains constant during the motion. The orientation of the start point is retained. The programmed orientation of the end point is not taken into consideration.</td>
</tr>
<tr>
<td>Default</td>
<td>The orientation of the TCP changes continuously during the motion. At the end point, the TCP has the programmed orientation.</td>
</tr>
<tr>
<td>Wrist PTP</td>
<td>The orientation of the TCP changes continuously during the motion. This is done by linear transformation (axis-specific motion) of the wrist axis angles. <strong>Note:</strong> Use Wrist PTP if, with Default, the robot passes through a wrist axis singularity. The orientation of the TCP changes continuously during the motion, but not uniformly. Wrist PTP is thus not suitable if a specific orientation must be maintained exactly, e.g. in the case of laser welding.</td>
</tr>
<tr>
<td>Ignore orientation</td>
<td>This option is only available for CP spline segments (not for the spline block or for individual spline motions). This option is used if no specific orientation is required at a specific point. (&gt;&gt;&gt; &quot;Ignore orientation&quot; Page 175)</td>
</tr>
</tbody>
</table>

Fig. 7-24: Constant orientation
Ignore orientation

Ignore orientation is used if no specific orientation is required at a specific point. If this option is selected, the robot controller ignores the taught or programmed orientation of the point. Instead, it calculates the optimal orientation for this point on the basis of the orientations of the surrounding points. This reduces the cycle time.

Properties of Ignore orientation:
- In the program run modes MSTEP and ISTEP, the robot stops with the orientations calculated by the robot controller.
- In the case of a block selection to a point with Ignore orientation, the robot adopts the orientation calculated by the robot controller.

Ignore orientation is not allowed for the following segments:
- The last segment in a spline block
- SCIRC segments with the circle orientation control type path-oriented
- Segments followed by a SCIRC segment with path-oriented
- Segments followed by a segment with Constant orientation

SCIRC

The same orientation control options are available for selection for SCIRC motions as for SLIN motions. It is also possible to define for SCIRC motions whether the orientation control is to be space-related or path-related.

<table>
<thead>
<tr>
<th>Orientation control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>base-related</td>
<td>Base-related orientation control during the circular motion</td>
</tr>
<tr>
<td>path-oriented</td>
<td>Path-related orientation control during the circular motion</td>
</tr>
</tbody>
</table>

The option path-oriented is not allowed for the following motions:
- SCIRC segments for which Ignore orientation applies
- SCIRC motions preceded by a spline segment for which Ignore orientation applies

Orientation of the auxiliary point:

During SCIRC motions with the orientation control type Default, the robot controller takes the programmed orientation of the auxiliary point into consideration, but only to a certain extent.

The transition from the start orientation to the end orientation passes through the programmed orientation of the auxiliary point, i.e. the orientation of the auxiliary point is accepted at some point during the transition, but not necessarily at the auxiliary point.
7.8.1 Combinations of “Orientation control” and “Circle orientation control”

Fig. 7-26: Constant orientation control + path-related

Fig. 7-27: Standard + path-related

Fig. 7-28: Constant orientation control + base-related
7.9 Singularities

KUKA robots with 6 degrees of freedom have 3 different singularity positions.

- Overhead singularity
- Extended position singularity
- Wrist axis singularity

A singularity position is characterized by the fact that unambiguous reverse transformation (conversion of Cartesian coordinates to axis-specific values) is not possible, even though Status and Turn are specified. In this case, or if very slight Cartesian changes cause very large changes to the axis angles, one speaks of singularity positions.

**Overhead**

In the overhead singularity, the wrist root point (intersection of axes A4, A5 and A6) is located vertically above axis 1.

The position of axis A1 cannot be determined unambiguously by means of reverse transformation and can thus take any value.

If the end point of a PTP motion is situated in this overhead singularity position, the robot controller may react as follows by means of the system variable $SINGUL_POS[1]$:

- 0: The angle for axis A1 is defined as 0 degrees (default setting).
- 1: The angle for axis A1 remains the same from the start point to the end point.

**Extended position**

In the extended position singularity, the wrist root point (intersection of axes A4, A5 and A6) is located in the extension of axes A2 and A3 of the robot.

The robot is at the limit of its work envelope.

Although reverse transformation does provide unambiguous axis angles, low Cartesian velocities result in high axis velocities for axes A2 and A3.

If the end point of a PTP motion is situated in this extended position singularity, the robot controller may react as follows by means of the system variable $SINGUL_POS[2]$:

- 0: The angle for axis A2 is defined as 0 degrees (default setting).
1: The angle for axis A2 remains the same from the start point to the end point.

Wrist axes

In the wrist axis singularity position, the axes A4 and A6 are parallel to one another and axis A5 is within the range ±0.01812°.

The position of the two axes cannot be determined unambiguously by reverse transformation. There is an infinite number of possible axis positions for axes A4 and A6 with identical axis angle sums.

If the end point of a PTP motion is situated in this wrist axis singularity, the robot controller may react as follows by means of the system variable $SINGUL_POS[3]$:

- 0: The angle for axis A4 is defined as 0 degrees (default setting).
- 1: The angle for axis A4 remains the same from the start point to the end point.
8  Programming for user group “User” (inline forms)

8.1  Names in inline forms

Names for data sets can be entered in inline forms. These include, for example, point names, names for motion data sets, etc.

The following restrictions apply to names:

- Maximum length 23 characters
- No special characters are permissible, with the exception of $.
- The first character must not be a number.

The restrictions do not apply to output names.

Other restrictions may apply in the case of inline forms in technology packages.

8.2  Programming PTP, LIN and CIRC motions

8.2.1  Programming a PTP motion

8 Programming for user group “User” (inline forms)

NOTICE In the case of programs with the following axis motions or positions, the film of lubricant on the gear units of the axes may break down:
- Motions <3°
- Oscillating motions
- Areas of gear units permanently facing upwards

It must be ensured that the gear units have a sufficient supply of oil. For this, in the case of oscillating motions or short motions (<3°), programming must be carried out in such a way that the affected axes regularly move more than 40° (e.g. once per cycle).

In the case of areas of gear units permanently facing upwards, sufficient oil supply must be achieved by programming re-orientations of the in-line wrist. In this way, the oil can reach all areas of the gear units by means of gravity.

Required frequency of re-orientations:
- With low loads (gear unit temperature <+35 °C): daily
- With medium loads (gear unit temperature +35 °C to 55 °C): hourly
- With heavy loads (gear unit temperature >+55 °C): every 10 minutes

Failure to observe this precaution may result in damage to the gear units.

NOTICE When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Move the TCP to the position that is to be taught as the end point.
2. Position the cursor in the line after which the motion instruction is to be inserted.
3. Select the menu sequence Commands > Motion > PTP.
4. Set the parameters in the inline form.
   (>>> 8.2.2 "Inline form “PTP”” Page 180)
5. Save instruction with Cmd Ok.
8.2.2 Inline form “PTP”

Fig. 8-1: Inline form for PTP motions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type PTP</td>
</tr>
</tbody>
</table>
| 2    | Name of the end point  
The system automatically generates a name. The name can be overwritten.  
(>>> 8.1 "Names in inline forms" Page 179)  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.7 "Option window “Frames”" Page 182) |
| 3    | CONT: end point is approximated.  
[Empty box]: the motion stops exactly at the end point. |
| 4    | Velocity  
1 … 100% |
| 5    | Name for the motion data set  
The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.8 "Option window “Motion parameters” (LIN, CIRC, PTP)” Page 183) |

8.2.3 Programming a LIN motion

**NOTICE** When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Move the TCP to the position that is to be taught as the end point.
2. Position the cursor in the line after which the motion instruction is to be inserted.
3. Select the menu sequence **Commands > Motion > LIN**.
4. Set the parameters in the inline form.  
   (>>> 8.2.4 "Inline form “LIN”” Page 181)
5. Save instruction with **Cmd Ok**.
8.2.4 Inline form “LIN”

![Inline form for LIN motions](image)

Fig. 8-2: Inline form for LIN motions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type LIN</td>
</tr>
</tbody>
</table>
| 2    | Name of the end point  
The system automatically generates a name. The name can be overwritten.  
(>>> 8.1 "Names in inline forms" Page 179)  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.7 "Option window “Frames”" Page 182) |
| 3    | CONT: end point is approximated.  
[Empty box]: the motion stops exactly at the end point. |
| 4    | Velocity  
0.001 … 2 m/s |
| 5    | Name for the motion data set  
The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.8 "Option window “Motion parameters” (LIN, CIRC, PTP)” Page 183) |

8.2.5 Programming a CIRC motion

**NOTICE** When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Move the TCP to the position that is to be taught as the auxiliary point.
2. Position the cursor in the line after which the motion instruction is to be inserted.
3. Select the menu sequence **Commands > Motion > CIRC**.
4. Set the parameters in the inline form.  
(>>> 8.2.6 "Inline form “CIRC” Page 182)
5. Press **Teach Aux**.
6. Move the TCP to the position that is to be taught as the end point.
7. Save instruction with **Cmd Ok**.
### 8.2.6 Inline form “CIRC”

**Fig. 8-3: Inline form for CIRC motions**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type <strong>CIRC</strong></td>
</tr>
</tbody>
</table>
| 2    | Name of the auxiliary point  
The system automatically generates a name. The name can be overwritten.  
(>>> 8.1 "Names in inline forms" Page 179) |
| 3    | Name of the end point  
The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.7 "Option window “Frames”" Page 182) |
| 4    | - **CONT**: end point is approximated.  
- **[Empty box]**: the motion stops exactly at the end point. |
| 5    | Velocity  
- 0.001 … 2 m/s |
| 6    | Name for the motion data set  
The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.8 "Option window “Motion parameters” (LIN, CIRC, PTP)” Page 183) |

### 8.2.7 Option window “Frames”

**Fig. 8-4: Option window: Frames**
### 8.2.8 Option window “Motion parameters” (LIN, CIRC, PTP)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Tool selection.  
      | If **True** in the box **External TCP**: workpiece selection.  
      | Range of values: [1] … [16] |
| 2    | Base selection.  
      | If **True** in the box **External TCP**: fixed tool selection.  
      | Range of values: [1] … [32] |
| 3    | Interpolation mode  
      | **False**: The tool is mounted on the mounting flange.  
      | **True**: The tool is a fixed tool. |
| 4    | **True**: For this motion, the robot controller calculates the axis torques. These are required for collision detection.  
      | **False**: For this motion, the robot controller does not calculate the axis torques. Collision detection is thus not possible for this motion. |

---

**Fig. 8-5: Option window “Motion parameters” (LIN, CIRC, PTP)**

1. Acceleration  
   Refers to the maximum value specified in the machine data. The maximum value depends on the robot type and the selected operating mode.
8.3 Programming spline motions

8.3.1 Programming tips for spline motions

- It is only possible to exploit the advantages of the spline motion type to the full if spline blocks are used.
- A spline block should cover only one process (e.g. an adhesive seam). More than one process in a spline block leads to a loss of structural clarity within the program and makes changes more difficult.
- Use SLIN and SCIRC segments in cases where the workpiece necessitates straight lines and arcs. (Exception: use SPL segments for very short straight lines.) Otherwise, use SPL segments, particularly if the points are close together.
- Procedure for defining the path:
  a. First teach or calculate a few characteristic points. Example: points at which the curve changes direction.
  b. Test the path. At points where the accuracy is still insufficient, add more SPL points.
- Avoid successive SLIN and/or SCIRC segments, as this often reduces the velocity to 0.
  Program SPL segments between SLIN and SCIRC segments. The length of the SPL segments must be at least > 0.5 mm. Depending on the actual path, significantly larger SPL segments may be required.
- Avoid successive points with identical Cartesian coordinates, as this reduces the velocity to 0.
- The parameters (tool, base, velocity, etc.) assigned to the spline block have the same effect as assignments before the spline block. The assignment to the spline block has the advantage, however, that the correct parameters are read in the case of a block selection.
- Use the option **Ignore orientation** if no specific orientation is required for a SLIN, SCIRC or SPL segment. The robot controller calculates the optimal orientation for this point on the basis of the orientations of the surrounding points. This improves the cycle time.
- The jerk can be modified. The jerk is the change in acceleration. Procedure:
  a. Use the default values initially.
  b. If vibrations occur at tight corners: reduce values.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | This box is only displayed if it is specified in the inline form that the point is to be approximated.  
Furthest distance before the end point at which approximate positioning can begin  
The maximum permissible value is half the distance between the start point and the end point. If a higher value is entered, this is ignored and the maximum value is used. |
| 3    | This box is only displayed for LIN and CIRC motions.  
Orientation control selection.  
  - **Standard**  
  - **Wrist PTP**  
  - **Constant orientation**  
  (>>> 7.6 "Orientation control LIN, CIRC" Page 162) |
If the velocity drops or the desired velocity cannot be reached: increase values or increase acceleration.

- If the robot executes points on a work surface, a collision with the work surface is possible when the first point is addressed.

Fig. 8-6: Collision with work surface

In order to avoid a collision, observe the recommendations for the SLIN-SPL-SLIN transition.

(>>> 7.7.5.1 "SLIN-SPL-SLIN transition" Page 173)

Fig. 8-7: Avoiding a collision with the work surface

- In the case of PTP spline blocks with multiple SPTP segments, it is possible that the software limit switches may be violated even though the points are within the limits!
  
  In this case, the points must be re-taught, i.e. they must be moved further away from the software limit switches. Alternatively, the software limit switches can be modified, provided that the required machine protection is still assured.

### 8.3.2 Programming a spline block

**Description**

A spline block can be used to group together several motions as an overall motion. The motions that may be included in a spline block are called spline segments. They are taught separately.

A spline block is planned and executed by the robot controller as a single motion block.

- A CP spline block may contain SPL, SLIN and SCIRC segments.
- A PTP spline block may contain SPTP segments.

A spline block that contains no segments is not a motion statement. The number of segments in the block is only limited by the memory capacity. Apart from the segments, a spline block may also contain the following elements:

- Inline commands from technology packages that support the spline functionality
- Comments and blank lines

A spline block must not include any other instructions, e.g. variable assignments or logic statements. A spline block does not trigger an advance run stop.
Precondition

- A program is selected.
- Operating mode T1

Procedure

1. Position the cursor in the line after which the spline block is to be inserted.
2. Select the menu sequence **Commands > Motion**.
   - Then select **SPLINE block** for a CP spline block.
   - Or select **PTP SPLINE block** for a PTP spline block.
3. Set the parameters in the inline form.
   (>>> 8.3.2.1 "Inline form for CP spline block" Page 186)
   (>>> 8.3.2.2 "Inline form "PTP SPLINE block"" Page 187)
4. Press **Cmd OK**.
5. Press **Open/close fold**. Spline segments can now be inserted into the block.

8.3.2.1 Inline form for CP spline block

![Fig. 8-8: Inline form for CP spline block](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name of the spline block. The system automatically generates a name. The name can be overwritten.</td>
</tr>
<tr>
<td></td>
<td>(&gt;&gt;&gt; 8.1 &quot;Names in inline forms&quot; Page 179)</td>
</tr>
<tr>
<td></td>
<td>Position the cursor in this box to edit the motion data. The corresponding option window is opened.</td>
</tr>
<tr>
<td></td>
<td>(&gt;&gt;&gt; 8.3.2.3 &quot;Option window &quot;Frames&quot; (CP and PTP spline block)&quot; Page 187)</td>
</tr>
<tr>
<td>2</td>
<td><strong>CONT</strong>: end point is approximated.</td>
</tr>
<tr>
<td></td>
<td>[Empty box]: the motion stops exactly at the end point.</td>
</tr>
<tr>
<td>3</td>
<td>Cartesian velocity</td>
</tr>
<tr>
<td></td>
<td>0.001 ... 2 m/s</td>
</tr>
<tr>
<td>4</td>
<td>Name for the motion data set. The system automatically generates a name. The name can be overwritten.</td>
</tr>
<tr>
<td></td>
<td>Position the cursor in this box to edit the motion data. The corresponding option window is opened.</td>
</tr>
<tr>
<td></td>
<td>(&gt;&gt;&gt; 8.3.2.4 &quot;Option window &quot;Motion parameters&quot; (CP spline block)&quot; Page 188)</td>
</tr>
</tbody>
</table>
### 8.3.2.2 Inline form “PTP SPLINE block”

![Inline form “PTP SPLINE block”](image)

**Fig. 8-9: Inline form “PTP SPLINE block”**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Name of the spline block. The system automatically generates a name. The name can be overwritten.  
      | (>>> 8.1 "Names in inline forms" Page 179)  
      | Position the cursor in this box to edit the motion data. The corresponding option window is opened.  
      | (>>> 8.3.2.3 "Option window “Frames” (CP and PTP spline block)” Page 187) |
| 2    | **CONT**: end point is approximated.  
      | [Empty box]: the motion stops exactly at the end point. |
| 3    | Axis velocity  
      | 1 ... 100% |
| 4    | Name for the motion data set. The system automatically generates a name. The name can be overwritten.  
      | Position the cursor in this box to edit the motion data. The corresponding option window is opened.  
      | (>>> 8.3.2.5 "Option window “Motion parameters” (PTP spline block)” Page 189) |

### 8.3.2.3 Option window “Frames” (CP and PTP spline block)

![Option window “Frames” (CP and PTP spline block)](image)

**Fig. 8-10: Option window “Frames” (CP and PTP spline block)**
8.3.2.4 Option window “Motion parameters” (CP spline block)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | Tool selection.  
      | Or: If True in the box External TCP: workpiece selection.  
      | ▪ [1] ... [16] |
| 2.   | Base selection.  
      | Or: If True in the box External TCP: fixed tool selection.  
      | ▪ [1] ... [32] |
| 3.   | Interpolation mode  
      | ▪ False: The tool is mounted on the mounting flange.  
      | ▪ True: The tool is a fixed tool. |

**Fig. 8-11: Option window “Motion parameters” (CP spline block)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1.   | Axis velocity. The value refers to the maximum value specified in the machine data.  
      | ▪ 1 ... 100% |
| 2.   | Axis acceleration. The value refers to the maximum value specified in the machine data.  
      | ▪ 1 ... 100% |
| 3.   | Gear jerk. The jerk is the change in acceleration.  
      | The value refers to the maximum value specified in the machine data.  
      | ▪ 1 ... 100% |
| 4.   | Orientation control selection. |
| 5.   | Orientation control reference system selection.  
      | This parameter only affects SCIRC segments (if present). |
| 6.   | This box is only displayed if CONT was selected in the inline form.  
      | Furthest distance before the end point at which approximate positioning can begin.  
      | The maximum distance is that of the last segment in the spline. If there is only one segment present, the maximum distance is half the segment length. If a higher value is entered, this is ignored and the maximum value is used. |
8.3.2.5  Option window “Motion parameters” (PTP spline block)

Fig. 8-12: Option window “Motion parameters” (PTP spline block)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Axis acceleration. The value refers to the maximum value specified in the machine data.</td>
</tr>
<tr>
<td></td>
<td>1 … 100%</td>
</tr>
<tr>
<td>2</td>
<td>This box is only displayed if CONT was selected in the inline form. Furthest distance before the end point at which approximate positioning can begin. The maximum distance is that of the last segment in the spline. If there is only one segment present, the maximum distance is half the segment length. If a higher value is entered, this is ignored and the maximum value is used.</td>
</tr>
<tr>
<td>3</td>
<td>Gear jerk. The jerk is the change in acceleration. The value refers to the maximum value specified in the machine data.</td>
</tr>
<tr>
<td></td>
<td>1 … 100%</td>
</tr>
</tbody>
</table>

8.3.3  Programming segments for a spline block

8.3.3.1  Programming an SPL or SLIN segment

**NOTICE** When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

**Precondition**
- A program is selected.
- Operating mode T1
- The CP spline block fold is open.

**Procedure**
1. Move the TCP to the end point.
2. Position the cursor in the line after which the segment is to be inserted in the spline block.
3. Select the menu sequence **Commands > Motion > SPL** or **SLIN**.
4. Set the parameters in the inline form.
   
   (>>> 8.3.3.3 "Inline form for CP spline segment" Page 190)
5. Press **Cmd OK**.
8.3.3.2 Programming an SCIRC segment

**NOTICE** When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

**Precondition**
- A program is selected.
- Operating mode T1
- The CP spline block fold is open.

**Procedure**
1. Move the TCP to the auxiliary point.
2. Position the cursor in the line after which the segment is to be inserted in the spline block.
3. Select the menu sequence **Commands > Motion > SCIRC**.
4. Set the parameters in the inline form.
   
   >>> 8.3.3.3 "Inline form for CP spline segment" Page 190
5. Press **Teach Aux**.
6. Move the TCP to the end point.
7. Press **Cmd OK**.

8.3.3.3 Inline form for CP spline segment

By default, not all boxes of the inline form are displayed. The boxes can be displayed or hidden using the **Switch parameter** button.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type</td>
</tr>
<tr>
<td></td>
<td>SPL, SLIN or SCIRC</td>
</tr>
<tr>
<td>2</td>
<td>Only for SCIRC: point name for the auxiliary point</td>
</tr>
<tr>
<td></td>
<td>The system automatically generates a name. The name can be overwritten.</td>
</tr>
<tr>
<td></td>
<td>&gt;&gt;&gt; 8.1 &quot;Names in inline forms&quot; Page 179</td>
</tr>
<tr>
<td>3</td>
<td>Point name for the end point. The system automatically generates a name. The name can be overwritten.</td>
</tr>
<tr>
<td></td>
<td>Touch the arrow to edit the point data. The corresponding option window is opened.</td>
</tr>
<tr>
<td></td>
<td>&gt;&gt;&gt; 8.3.3.6 &quot;Option window &quot;Frames&quot; (CP and PTP spline segments)&quot; Page 193</td>
</tr>
</tbody>
</table>
### 8.3.3.4 Programming an SPTP segment

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | Cartesian velocity  
By default, the value that is valid for the spline block is also valid for the segment. A separate value can be assigned here for the segment if required. The value applies only for this segment.  
- **0.001 ... 2 m/s** |
| 5    | Name for the motion data set. The system automatically generates a name. The name can be overwritten.  
By default, the values that are valid for the spline block are also valid for the segment. Separate values can be assigned here for the segment if required. The values apply only for this segment.  
Touch the arrow to edit the data. The corresponding option window is opened.  
(>>> 8.3.3.5 "Inline form for SPTP segment" Page 192) |
| 6    | Only available if the motion type **SCIRC** has been selected.  
Specifies the overall angle of the circular motion. This makes it possible to extend the motion beyond the programmed end point or to shorten it. The actual end point thus no longer corresponds to the programmed end point.  
- Positive circular angle: the circular path is executed in the direction Start point › Auxiliary point › End point.  
- Negative circular angle: the circular path is executed in the direction Start point › End point › Auxiliary point.  
- **-9 999° ... +9 999°**  
If a circular angle less than -400° or greater than +400° is entered, a request for confirmation is generated when the inline form is saved asking whether entry is to be confirmed or rejected. |
| 7    | Name of the data set containing logic parameters. The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the data. The corresponding option window is opened.  
(>>> 8.3.3.9 "Option window "Logic parameters"" Page 195) |

**8.3.3.4 Programming an SPTP segment**

---

**NOTICE** When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

**Precondition**
- A program is selected.  
- Operating mode T1  
- The PTP spline block fold is open.

**Procedure**
1. Move the TCP to the end point.  
2. Position the cursor in the line after which the segment is to be inserted in the spline block.  
3. Select the menu sequence **Commands > Motion > SPTP**.  
4. Set the parameters in the inline form.  
(>>> 8.3.3.5 "Inline form for SPTP segment" Page 192)  
5. Press **Cmd OK**.
8.3.3.5 Inline form for SPTP segment

By default, not all boxes of the inline form are displayed. The boxes can be displayed or hidden using the Switch parameter button.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type SPTP</td>
</tr>
</tbody>
</table>
| 2    | Point name for end point. The system automatically generates a name. The name can be overwritten.  

(>>> 8.1 "Names in inline forms" Page 179)  

Touch the arrow to edit the point data. The corresponding option window is opened.  

(>>> 8.3.3.6 "Option window “Frames” (CP and PTP spline segments)” Page 193) |
| 3    | Axis velocity  

By default, the value that is valid for the spline block is also valid for the segment. A separate value can be assigned here for the segment if required. The value applies only for this segment.  

- 1 … 100% |
| 4    | Name for the motion data set. The system automatically generates a name. The name can be overwritten.  

By default, the values that are valid for the spline block are also valid for the segment. Separate values can be assigned here for the segment if required. The values apply only for this segment.  

Touch the arrow to edit the point data. The corresponding option window is opened.  

(>>> 8.3.3.8 "Option window “Motion parameters” (SPTP)” Page 194) |
| 5    | Name of the data set containing logic parameters. The system automatically generates a name. The name can be overwritten.  

Touch the arrow to edit the data. The corresponding option window is opened.  

(>>> 8.3.3.9 "Option window “Logic parameters”" Page 195) |
8.3.3.6 Option window “Frames” (CP and PTP spline segments)

![Option window “Frames” (CP and PTP spline segments)](image)

Fig. 8-15: Option window “Frames” (CP and PTP spline segments)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 | **True**: For this motion, the robot controller calculates the axis torques. These are required for collision detection.  
**False**: For this motion, the robot controller does not calculate the axis torques. Collision detection is thus not possible for this motion. |

8.3.3.7 Option window “Motion parameters” (CP spline segment)

Motion parameters

![Option window “Motion parameters” (CP spline segment)](image)

Fig. 8-16: Option window “Motion parameters” (CP spline segment)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1 | Axis velocity. The value refers to the maximum value specified in the machine data.  
**1 … 100%** |
| 2 | Axis acceleration. The value refers to the maximum value specified in the machine data.  
**1 … 100%** |
| 3 | Gear jerk. The jerk is the change in acceleration. The value refers to the maximum value specified in the machine data.  
**1 … 100%** |
| 4 | Orientation control selection |
| 5 | Only in the case of SCIRC segments: Orientation control reference system selection |
### Circle configuration

**Fig. 8-17: Option window “Circle configuration” (SCIRC segment)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Only in the case of SCIRC segments: Selection of orientation behavior at auxiliary point</td>
</tr>
<tr>
<td>7</td>
<td>Only in the case of SCIRC segments: This box is only displayed if <code>ANGLE</code> was selected in the inline form. Selection of orientation behavior at end point</td>
</tr>
</tbody>
</table>

### 8.3.3.8 Option window “Motion parameters” (SPTP)

**Fig. 8-18: Option window “Motion parameters” (SPTP)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Axis acceleration. The value refers to the maximum value specified in the machine data.</td>
</tr>
<tr>
<td></td>
<td>1 ( \ldots ) 100%</td>
</tr>
<tr>
<td>2</td>
<td>Approximation distance [mm]</td>
</tr>
<tr>
<td>3</td>
<td>Gear jerk [%]</td>
</tr>
</tbody>
</table>
8.3.3.9 Option window “Logic parameters”

**Trigger**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | This box is not available for SPTP segments. In the case of individual SPTP motions, this box is only displayed if CONT was selected in the inline form.  
Furthest distance before the end point at which approximate positioning can begin.  
The maximum permissible value is half the distance between the start point and the end point. If a higher value is entered, this is ignored and the maximum value is used. |
| 3    | Gear jerk. The jerk is the change in acceleration.  
The value refers to the maximum value specified in the machine data.  
- 1 ... 100% |

**Fig. 8-19: Trigger**

Information about the location of the switching point if the reference point is approximated is contained in the Operating and Programming Instructions for System Integrators. Information about maximum offset limits can also be found there.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | A (further) trigger can be assigned to the motion by means of the button Select action > Add trigger. If it is the first trigger for this motion, this command also causes the Trigger box to be displayed.  
A maximum of 8 triggers per motion are possible.  
(A trigger can be removed again by means of Select action > Remove trigger.) |
| 2    | Reference point of the trigger  
- TRUE: Start point  
- FALSE: End point |
### Conditional stop

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3    | Spatial offset relative to the end or start point  
  - Negative value: Shift towards the start of the motion  
  - Positive value: Shift towards the end of the motion  
  The shift in space can also be taught. In this case, the box **Start point is reference point** is automatically set to **FALSE**.  
  (>>> 8.3.3.10 "Teaching the shift in space for logic parameters" Page 198) |
| 4    | Shift in time relative to **Offset**  
  - Negative value: Shift towards the start of the motion.  
  - Positive value: Trigger is switched after **Time** has elapsed. |
| 5    | Statement that is to be initiated by the trigger. The following are possible:  
  - Assignment of a value to a variable  
    **Note:** There must be no runtime variable on the left-hand side of the assignment.  
  - OUT statement; PULSE statement; CYCFLAG statement  
  - Subprogram call. In this case, the priority must be specified.  
    **Example:** `my_subprogram() PRIO = 81`  
    Priorities 1, 2, 4 to 39 and 81 to 128 are available. Priorities 40 to 80 are reserved for cases in which the priority is automatically assigned by the system. If the priority is to be assigned automatically by the system, the following is programmed:  
    `PRIO = -1`  
    If several triggers call subprograms at the same time, the trigger with the highest priority is processed first, then the triggers of lower priority. 1 = highest priority. |

---

**Fig. 8-20: Conditional stop**

Further information about the conditional stop can be found in this documentation.  
(>>> 8.3.5 "Conditional stop" Page 205)
### Stop condition

1. **Stop condition.** The following are permitted:
   - a global Boolean variable
   - a signal name
   - a comparison
   - a simple logic operation: NOT, OR, AND or EXOR

2. **The conditional stop can refer to either the start point or the end point of the motion.**
   - **TRUE:** Start point
   - **FALSE:** End point

   If the reference point is approximated, the same rules apply as for the PATH trigger.

   **Note:** Information about approximate positioning with the PATH trigger is contained in the Operating and Programming Instructions for System Integrators.

3. **The stop point can be shifted in space.** For this, the desired distance from the start or end point must be specified. If no shift in space is desired, enter "0".
   - Positive value: Shift towards the end of the motion
   - Negative value: Shift towards the start of the motion

   There are limits to the distance the stop point can be offset. The same limits apply as for the PATH trigger.

   The shift in space can also be taught. In this case, the box **Start point is reference point** is automatically set to **FALSE**.

   **Note:** Information about the offset limits with the PATH trigger is contained in the Operating and Programming Instructions for System Integrators.

---

**Constant velocity range** is only available for CP spline segments.

Further information about the constant velocity ranges can be found in this documentation.

(>>> 8.3.6 "Constant velocity range in the CP spline block" Page 208)
8.3.3.10 Teaching the shift in space for logic parameters

Description
Shifts in space can be specified in the option window Logic parameters for trigger, conditional stop and constant velocity range. Instead of entering these offsets numerically, they can also be taught.

If an offset is taught, the box Start point is reference point in the corresponding tab is automatically set to FALSE, as the taught distance refers to the end point of the motion.

Precondition
- A program is selected.
- Operating mode T1
The point for which the offset is to apply has already been taught.

Procedure
1. Move the TCP to the desired position.
2. Position the cursor in the line containing the motion instruction for which the offset is to be taught.
3. Press Change. The inline form for this instruction is opened.
4. Open the option window Logic parameters and select the required tab.
5. Press Select action then one of the following buttons depending on what the offset is to be taught for:
   - Teach trigger path
   - Teach conditional stop path
   - Teach constant velocity range path
   The distance from the end point of the current motion statement is now applied as the value for the offset.
6. Save the change by pressing Cmd OK.

8.3.4 Programming individual spline motions

8.3.4.1 Programming an individual SLIN motion

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Move the TCP to the end point.
2. Position the cursor in the line after which the motion is to be inserted.
3. Select Commands > Motion > SLIN.
4. Set the parameters in the inline form.
   (>>> 8.3.4.2 “Inline form “SLIN”” Page 199)
5. Press Cmd OK.

8.3.4.2 Inline form “SLIN”

When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Move the TCP to the end point.
2. Position the cursor in the line after which the motion is to be inserted.
3. Select Commands > Motion > SLIN.
4. Set the parameters in the inline form.
   (>>> 8.3.4.2 “Inline form “SLIN”” Page 199)
5. Press Cmd OK.

8.3.4.2 Inline form “SLIN” (individual motion)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type <strong>SLIN</strong></td>
</tr>
<tr>
<td>2</td>
<td>Point name for end point. The system automatically generates a name. The name can be overwritten.</td>
</tr>
<tr>
<td>&gt;&gt;&gt; 8.1 “Names in inline forms” Page 179</td>
<td></td>
</tr>
<tr>
<td>Touch the arrow to edit the point data. The corresponding option window is opened.</td>
<td></td>
</tr>
<tr>
<td>&gt;&gt;&gt; 8.2.7 “Option window “Frames”” Page 182</td>
<td></td>
</tr>
</tbody>
</table>
### Option window “Motion parameters” (SLIN)

#### Item Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Axis velocity. The value refers to the maximum value specified in the machine data.  
   - 1 … 100% |
| 2    | Axis acceleration. The value refers to the maximum value specified in the machine data.  
   - 1 … 100% |
| 3    | Gear jerk. The jerk is the change in acceleration.  
   - The value refers to the maximum value specified in the machine data.  
   - 1 … 100% |

Fig. 8-23: Option window “Motion parameters” (SLIN)
8.3.4.4 Programming an individual SCIRC motion

When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Move the TCP to the auxiliary point.
2. Position the cursor in the line after which the motion is to be inserted.
3. Select the menu sequence Commands > Motion > SCIRC.
4. Set the parameters in the inline form.
   
   (>>> 8.3.4.5 "Inline form “SCIRC”" Page 201)
5. Press Teach Aux.
6. Move the TCP to the end point.
7. Press Cmd OK.

8.3.4.5 Inline form “SCIRC”

![Fig. 8-24: Inline form “SCIRC” (individual motion)](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type SCIRC</td>
</tr>
</tbody>
</table>
| 2    | Point name for the auxiliary point.  
The system automatically generates a name. The name can be overwritten.  
(>>> 8.1 "Names in inline forms" Page 179) |
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 3    | Point name for the end point.  
The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.2.7 "Option window “Frames”" Page 182) |
| 4    | CONT: end point is approximated.  
[Empty box]: the motion stops exactly at the end point. |
| 5    | Velocity  
- 0.001 … 2 m/s |
| 6    | Name for the motion data set. The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the point data. The corresponding option window is opened.  
(>>> 8.3.4.6 "Option window “Motion parameters” (SCIRC)” Page 203) |
| 7    | Specifies the overall angle of the circular motion. This makes it possible to extend the motion beyond the programmed end point or to shorten it. The actual end point thus no longer corresponds to the programmed end point.  
- Positive circular angle: the circular path is executed in the direction Start point › Auxiliary point › End point.  
- Negative circular angle: the circular path is executed in the direction Start point › End point › Auxiliary point.  
- - 9 999° … + 9 999°  
If a circular angle less than -400° or greater than +400° is entered, a request for confirmation is generated when the inline form is saved asking whether entry is to be confirmed or rejected. |
| 8    | This box can be displayed or hidden by means of Switch parameter.  
Name of the data set containing logic parameters. The system automatically generates a name. The name can be overwritten.  
Touch the arrow to edit the data. The corresponding option window is opened.  
(>>> 8.3.3.9 "Option window “Logic parameters”” Page 195) |
8.3.4.6 Option window “Motion parameters” (SCIRC)

**Motion parameters**

![Motion parameters](image)

**Fig. 8-25: Motion parameters (SCIRC)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Axis velocity. The value refers to the maximum value specified in the machine data.  
  | 1 … 100% |
| 2    | Axis acceleration. The value refers to the maximum value specified in the machine data.  
  | 1 … 100% |
| 3    | Gear jerk. The jerk is the change in acceleration. The value refers to the maximum value specified in the machine data.  
  | 1 … 100% |
| 4    | Orientation control selection |
| 5    | Orientation control reference system selection |
| 6    | This box is only displayed if CONT was selected in the inline form.  
  Furthest distance before the end point at which approximate positioning can begin.  
  The maximum permissible value is half the distance between the start point and the end point. If a higher value is entered, this is ignored and the maximum value is used. |

**Circle configuration**

![Circle configuration](image)

**Fig. 8-26: Circle configuration (SCIRC)**
8.3.4.7 Programming an individual SPTP motion

**NOTICE** When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Move the TCP to the end point.
2. Position the cursor in the line after which the motion is to be inserted.
3. Select **Commands > Motion > SPTP**.
4. Set the parameters in the inline form.
   (>>> 8.3.4.8 “Inline form “SPTP”” Page 204)
5. Press **Cmd OK**.

8.3.4.8 Inline form “SPTP”

---

**Item** | **Description**
--- | ---
7 | Selection of orientation behavior at auxiliary point
8 | This box is only displayed if **ANGLE** was selected in the inline form.
   Selection of orientation behavior at end point

**Programmed motions**
When programming motions, it must be ensured that the energy supply system is not wound up or damaged during program execution.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Motion type <strong>SPTP</strong></td>
</tr>
<tr>
<td>2</td>
<td>Point name for end point. The system automatically generates a name. The name can be overwritten.</td>
</tr>
</tbody>
</table>
   (>>> 8.1 "Names in inline forms" Page 179)
   Touch the arrow to edit the point data. The corresponding option window is opened.
   (>>> 8.2.7 "Option window “Frames”" Page 182)
| 3 | **CONT**: end point is approximated. |
   **[Empty box]**: the motion stops exactly at the end point. |
| 4 | Velocity |
   **1 … 100%** |
8.3.5 Conditional stop

Description

The "conditional stop" enables the user to define a point on the path at which the robot stops if a certain condition is met. This point is called the "stop point". As soon as the condition is no longer met, the robot resumes its motion. During the runtime, the robot controller calculates the latest point at which the robot must brake in order to be able to stop at the stop point. From this point (braking point) onwards, it monitors whether or not the condition is met.

- If the condition is met at the braking point, the robot brakes in order to stop at the stop point.
  If, however, the condition then switches back to "not met" before the stop point is reached, the robot accelerates again and does not stop.
- If the condition is not met at the braking point, the robot motion is continued without braking.

Essentially, any number of conditional stops can be programmed. A maximum of 10 "braking point → stop point" paths may overlap, however.

While the robot is braking, the robot controller displays the following message in T1/T2 mode: Conditional stop active (line {Line number}).

Programming

Programming with KRL syntax:

- using the statement STOP WHEN PATH

Programming with inline forms:

- In the spline block (CP and PTP) or in the individual spline block:
  in the option window "Logic parameters"
- Before a spline block (CP and PTP):
  via the inline form Spline Stop Condition

8.3.5.1 Inline form “Spline Stop Condition”

This inline form may only be used before a spline block. There may be other statements between the inline form and the spline block, but no motion instructions.
## Inline form “Spline Stop Condition”

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1    | Point to which the conditional stop refers  
|      | - With ONSTART: last point before the spline block  
|      | - Without ONSTART: last point in the spline block  
|      | If the spline is approximated, the same rules apply as for the PATH trigger.  
|      | **Note:** Information about approximate positioning with the PATH trigger is contained in the Operating and Programming Instructions for System Integrators.  
|      | ONSTART can be set or removed using the **Toggle OnStart** button. |
| 2    | The stop point can be shifted in space. For this, the desired distance from the reference point must be specified. If no shift in space is desired, enter “0”.  
|      | - Positive value: Shift towards the end of the motion  
|      | - Negative value: Shift towards the start of the motion  
|      | There are limits to the distance the stop point can be offset. The same limits apply as for the PATH trigger.  
|      | The shift in space can also be taught.  
|      | (>>> "Teach path" Page 206) |
| 3    | Stop condition. The following are permitted:  
|      | - a global Boolean variable  
|      | - a signal name  
|      | - a comparison  
|      | - a simple logic operation: NOT, OR, AND or EXOR |

### Teach path

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Teach path | If an offset is desired, it is not necessary to enter the value into the inline form numerically; the offset can also be taught. This is done via **Teach path**.  
|         | If an offset is taught, ONSTART is automatically removed, if set in the inline form, as the taught distance always refers to the end point of the motion.  
|         | The teaching sequence is the same as that for the option window **Logic parameters**.  
|         | (>>> 8.3.3.10 "Teaching the shift in space for logic parameters" Page 198) |
8.3.5.2 Stop condition: example and braking characteristics

Example

<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PTP P0</td>
</tr>
<tr>
<td>2</td>
<td>SPLINE</td>
</tr>
<tr>
<td>3</td>
<td>SPL P1</td>
</tr>
<tr>
<td>4</td>
<td>STOP WHEN PATH = 50 IF $IN[77]==FALSE</td>
</tr>
<tr>
<td>5</td>
<td>SPL P2</td>
</tr>
<tr>
<td>6</td>
<td>SPL P3</td>
</tr>
<tr>
<td>7</td>
<td>ENDSPLINE</td>
</tr>
</tbody>
</table>

If the input $IN[77]$ is FALSE, the robot stops 50 mm after P2 and waits until $IN[77]$ is TRUE.

Note: The line represents programming in KRL. In the case of inline programming, the program looks different, but the sequence and the braking characteristics are identical.

Fig. 8-29: Example of STOP WHEN PATH

<table>
<thead>
<tr>
<th>Point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP</td>
<td>Braking Point: The robot must start braking here in order to stop at the stop point. From this point onwards, the robot controller monitors whether or not the stop condition is met. The position of BP depends on the velocity and the override setting and cannot be identified by the operator.</td>
</tr>
<tr>
<td>SP</td>
<td>Stop Point</td>
</tr>
<tr>
<td></td>
<td>The distance P2 → SP is 50 mm long.</td>
</tr>
</tbody>
</table>

Braking characteristics

<table>
<thead>
<tr>
<th>Situation at BP</th>
<th>Behavior of the robot</th>
</tr>
</thead>
<tbody>
<tr>
<td>$IN[77] == FALSE</td>
<td>The robot brakes and stops at SP.</td>
</tr>
<tr>
<td>$IN[77] == TRUE</td>
<td>The robot does not brake and does not stop at SP. The program is executed as if the STOP WHEN PATH statement were not present.</td>
</tr>
</tbody>
</table>

1. $IN[77] == FALSE at BP.
2. The input switches to TRUE between BP and SP.
1. The robot brakes at BP.
2. If the input is TRUE, the robot accelerates again and does not stop at SP.

1. $IN[77] == TRUE at BP.
2. The input switches to FALSE between BP and SP.
1. The robot does not brake at BP.
2. If the input is FALSE, the robot stops with a path-maintaining EMERGENCY STOP and comes to a standstill at an unpredictable point.

If the stop condition is not met until the robot has already passed BP, it is too late to stop at SP with a normal braking ramp. In this case, the robot stops with a path-maintaining EMERGENCY STOP and comes to a standstill at an unpredictable point.
If the EMERGENCY STOP causes the robot to stop after SP, the program cannot be resumed until the stop condition is no longer met.

If the path-maintaining EMERGENCY STOP causes the robot to stop before SP, the following occurs when the program is resumed:

- If the stop condition is no longer met, the robot resumes its motion.
- If the stop condition is still met, the robot moves as far as SP and stops there.

8.3.6  Constant velocity range in the CP spline block

Description
In a CP spline block, a range can be defined in which the robot maintains the programmed velocity constant where possible. This range is called the “constant velocity range”.

- 1 constant velocity range can be defined per CP spline block.
- A constant velocity range is defined by a start statement and an end statement.
- The range cannot extend beyond the spline block.
- There is no lower limit to the size of the range.

If it is not possible to maintain the programmed velocity constant, the robot controller indicates this by means of a message during program execution.

Constant velocity range over several segments:
A constant velocity range can extend over several segments with different programmed velocities. In this case, the lowest of the velocities is valid for the whole range.

Even in the segments with a higher programmed velocity, the motion is executed with the lowest velocity in this case. No message is generated indicating that the velocity has not been maintained. This only occurs if the lowest velocity cannot be maintained.

Programming
A constant velocity range can be programmed in the following ways:

- If programming with KRL syntax: by means of the statement CONST_VEL
- If programming with inline forms:
  The start or end of the range is stored in the corresponding CP segment in the option window Logic parameters.

8.3.6.1 Block selection to the constant velocity range

Description
If a block selection to a constant velocity range is carried out, the robot controller ignores the CONST_VEL statement and generates a corresponding message. The motions are executed as if the CONST_VEL statements were not present.

A block selection to the path section defined by the offset values is considered as a block selection to the constant velocity range. The position of CONST_VEL START and CONST_VEL END is irrelevant here!

Example

```plaintext
...  
SPLINE ...  
SLIN P1  
CONST_VEL START = 50  
SLIN P2  
SLIN P3  
SLIN P4  
CONST_VEL END = -50 ONSTART  
SLIN P5  
ENDSPLINE  
...  
```
The constant velocity range starts 50 mm after P2 and ends 50 mm before P4.

CONST_VEL START = 50

CONST_VEL END = -50

Fig. 8-30: Example of block selection

Which block selection is considered as a block selection to the constant velocity range?

<table>
<thead>
<tr>
<th>Block selection to point ...</th>
<th>P2</th>
<th>P3</th>
<th>P4</th>
</tr>
</thead>
<tbody>
<tr>
<td>= in constant velocity range?</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

8.3.6.2 Maximum limits

If the start or end point of the spline block is an exact positioning point:

- The constant velocity range starts at the start point at the earliest.
- The constant velocity range ends at the end point at the latest.

If the offset value is such that these limits would be exceeded, the robot controller automatically reduces the offset and generates the following message:

CONST_VEL {Start/End} = {Offset} cannot be implemented; {New offset} will be used.

The robot controller reduces the offset far enough to create a range in which the constant programmed velocity can be maintained. In other words, it does not necessarily shift the limit exactly to the start or end point of the spline block, but possibly further inwards.

The same message is generated if the range is already in the spline block beforehand, but the defined velocity cannot be maintained due to the offset. In this case, once again, the robot controller reduces the offset.

If the start or end point of the spline block is approximated:

- The constant velocity range starts at the start of the approximate positioning arc of the start point at the earliest.
- The constant velocity range ends at the start of the approximate positioning arc of the end point at the latest.
8.4 Modifying motion parameters

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Position the cursor in the line containing the instruction that is to be changed.
2. Press Change. The inline form for this instruction is opened.
3. Modify parameters.
4. Save changes by pressing Cmd Ok.

8.5 Re-teaching a point

Description
The coordinates of a taught point can be modified. This is done by moving to the new position and overwriting the old point with the new position.

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Move the TCP to the desired position.
2. Position the cursor in the line containing the motion instruction that is to be changed.
3. Press Change. The inline form for this instruction is opened.
4. For PTP and LIN motions: Press Touch Up to accept the current position of the TCP as the new end point.
   - For CIRC motions:
     - Press Teach Aux to accept the current position of the TCP as the new auxiliary point.
     - Or press Teach End to accept the current position of the TCP as the new end point.
5. Confirm the request for confirmation with Yes.
6. Save change by pressing Cmd Ok.
8.6  Programming logic instructions

8.6.1  Inputs/outputs

Digital inputs/outputs
The robot controller can manage up to 8192 digital inputs and 8192 digital outputs. The configuration is customer-specific.

Analog inputs/outputs
The robot controller can manage 32 analog inputs and 32 analog outputs. The configuration is customer-specific.

The inputs/outputs are managed via the following system variables:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital</td>
<td>$IN[1] ... $IN[8192]</td>
</tr>
</tbody>
</table>

$ANIN[... ] indicates the input voltage, adapted to the range between -1.0 and +1.0. The actual voltage depends on the settings of the analog module.

$ANOUT[... ] can be used to set an analog voltage. $ANOUT[... ] can have values from -1.0 to +1.0 written to it. The voltage actually generated depends on the settings of the analog module. If an attempt is made to set voltages outside the range of values, the robot controller displays the following message: Limit {Signal name}

8.6.2  Setting a digital output - OUT

Precondition
- A program is selected.
- Operating mode T1

Procedure
1. Position the cursor in the line after which the logic instruction is to be inserted.
2. Select the menu sequence Commands > Logic > OUT > OUT.
3. Set the parameters in the inline form.
4. Save instruction with Cmd Ok.

8.6.3  Inline form “OUT”

The instruction sets a digital output.

Fig. 8-32: Inline form “OUT”

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output number</td>
</tr>
</tbody>
</table>
| 2    | If a name exists for the output, this name is displayed. Only for the user group “Expert”:
A name can be entered by pressing Long text. The name is freely selectable. |
8.6.4 Setting a pulse output - PULSE

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Position the cursor in the line after which the logic instruction is to be inserted.
2. Select the menu sequence **Commands > Logic > OUT > PULSE**.
3. Set the parameters in the inline form.
   
   (>>> 8.6.5 "Inline form ‘PULSE’" Page 212)
4. Save instruction with **Cmd Ok**.

8.6.5 Inline form “PULSE”

The instruction sets a pulse of a defined length.

![Fig. 8-33: Inline form “PULSE”](image)

**Item** | **Description**
---|---
1 | Output number
2 | If a name exists for the output, this name is displayed.
   - Only for the user group “Expert”:
     - A name can be entered by pressing Long text. The name is freely selectable.
3 | State to which the output is switched
   - TRUE: “High” level
   - FALSE: “Low” level
4 | CONT: Execution in the advance run
   - [Empty box]: Execution with advance run stop
5 | Length of the pulse
   - 0.10 … 3.00 s

8.6.6 Setting an analog output - ANOUT

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Position the cursor in the line after which the instruction is to be inserted.
2. Select **Commands > Analog output > Static or Dynamic**.
3. Set the parameters in the inline form.

   (>>> 8.6.7 "Inline form “ANOUT” (static)" Page 213)
   (>>> 8.6.8 "Inline form “ANOUT” (dynamic)" Page 213)

4. Save instruction with Cmd Ok.

### 8.6.7 Inline form “ANOUT” (static)

This instruction sets a static analog output.

A maximum of 8 analog outputs (static and dynamic together) can be used at any one time. ANOUT triggers an advance run stop.

The voltage is set to a fixed level by means of a factor. The actual voltage level depends on the analog module used. For example, a 10 V module with a factor of 0.5 provides a voltage of 5 V.

![Fig. 8-34: Inline form “ANOUT” (static)](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number of the analog output</td>
</tr>
<tr>
<td></td>
<td>CHANNEL_1 … CHANNEL_32</td>
</tr>
<tr>
<td>2</td>
<td>Factor for the voltage</td>
</tr>
<tr>
<td></td>
<td>0 … 1 (intervals: 0.01)</td>
</tr>
</tbody>
</table>

### 8.6.8 Inline form “ANOUT” (dynamic)

This instruction activates or deactivates a dynamic analog output.

A maximum of 4 dynamic analog outputs can be activated at any one time. ANOUT triggers an advance run stop.

The voltage is determined by a factor. The actual voltage level depends on the following values:

- **Velocity or function generator**
  
  For example, a velocity of 1 m/s with a factor of 0.5 results in a voltage of 5 V.

- **Offset**
  
  For example, an offset of +0.15 for a voltage of 0.5 V results in a voltage of 6.5 V.

![Fig. 8-35: Inline form “ANOUT” (dynamic)](image)
### 8.6.9 Programming a wait time - WAIT

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Position the cursor in the line after which the logic instruction is to be inserted.
2. Select the menu sequence **Commands > Logic > WAIT**.
3. Set the parameters in the inline form.
4. Save instruction with **Cmd Ok**.

#### Inline form “WAIT”

WAIT can be used to program a wait time. The robot motion is stopped for a programmed time. WAIT always triggers an advance run stop.

**Fig. 8-36: Inline form “WAIT”**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wait time</td>
</tr>
<tr>
<td></td>
<td>≥ 0 s</td>
</tr>
</tbody>
</table>

### 8.6.10 Programming a signal-dependent wait function - WAITFOR

**Precondition**
- A program is selected.
- Operating mode T1
8 Programming for user group “User” (inline forms)

**Procedure**

1. Position the cursor in the line after which the logic instruction is to be inserted.
2. Select the menu sequence **Commands > Logic > WAITFOR**.
3. Set the parameters in the inline form.
   (>>> 8.6.12 “Inline form “WAITFOR” Page 215)
4. Save instruction with **Cmd Ok**.

**8.6.12 Inline form “WAITFOR”**

The instruction sets a signal-dependent wait function.
If required, several signals (maximum 12) can be linked. If a logic operation is added, boxes are displayed in the inline form for the additional signals and links.

![Fig. 8-37: Inline form “WAITFOR”](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add external logic operation. The operator is situated between the bracketed expressions.</td>
</tr>
<tr>
<td></td>
<td>- AND</td>
</tr>
<tr>
<td></td>
<td>- OR</td>
</tr>
<tr>
<td></td>
<td>- EXOR</td>
</tr>
<tr>
<td></td>
<td>Add NOT.</td>
</tr>
<tr>
<td></td>
<td>- NOT</td>
</tr>
<tr>
<td></td>
<td>- [Empty box]</td>
</tr>
<tr>
<td></td>
<td>Enter the desired operator by means of the corresponding button.</td>
</tr>
<tr>
<td>2</td>
<td>Add internal logic operation. The operator is situated inside a bracketed expression.</td>
</tr>
<tr>
<td></td>
<td>- AND</td>
</tr>
<tr>
<td></td>
<td>- OR</td>
</tr>
<tr>
<td></td>
<td>- EXOR</td>
</tr>
<tr>
<td></td>
<td>Add NOT.</td>
</tr>
<tr>
<td></td>
<td>- NOT</td>
</tr>
<tr>
<td></td>
<td>- [Empty box]</td>
</tr>
<tr>
<td></td>
<td>Enter the desired operator by means of the corresponding button.</td>
</tr>
<tr>
<td>3</td>
<td>Signal for which the system is waiting</td>
</tr>
<tr>
<td></td>
<td>- IN</td>
</tr>
<tr>
<td></td>
<td>- OUT</td>
</tr>
<tr>
<td></td>
<td>- CYCFLAG</td>
</tr>
<tr>
<td></td>
<td>- TIMER</td>
</tr>
<tr>
<td></td>
<td>- FLAG</td>
</tr>
<tr>
<td>4</td>
<td>Number of the signal</td>
</tr>
</tbody>
</table>
### 8.6.13 Switching on the path - SYN OUT

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Position the cursor in the line after which the logic instruction is to be inserted.
2. Select the menu sequence **Commands** > **Logic** > **OUT** > **SYN OUT**.
3. Set the parameters in the inline form.
   (>>> 8.6.14 "Inline form “SYN OUT”, option “START/END”" Page 216)
   (>>> 8.6.15 "Inline form “SYN OUT”, option “PATH”" Page 219)
4. Save instruction with **Cmd Ok**.

### 8.6.14 Inline form “SYN OUT”, option “START/END”

The switching action can be triggered relative to the start or end point of the motion. The switching action can be delayed or brought forward. The motion can be a LIN, CIRC or PTP motion.

Possible applications include:
- Closing or opening the weld gun during spot welding
- Switching the welding current on/off during arc welding
- Starting or stopping the flow of adhesive in bonding or sealing applications.

![Fig. 8-38: Inline form “SYN OUT”, option “START/END”](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output number</td>
</tr>
</tbody>
</table>
| 2    | If a name exists for the output, this name is displayed.  
   Only for the user group “Expert”:
   A name can be entered by pressing **Long text**. The name is freely selectable. |
| 3    | State to which the output is switched  
   - TRUE  
   - FALSE |
### Example 1

Start point and end point are exact positioning points.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Point to which SYN OUT refers:</td>
</tr>
<tr>
<td></td>
<td>- <strong>START</strong>: Start point of the motion</td>
</tr>
<tr>
<td></td>
<td>- <strong>END</strong>: End point of the motion</td>
</tr>
<tr>
<td>5</td>
<td>Switching action delay</td>
</tr>
<tr>
<td></td>
<td>-1,000 ... +1,000 ms</td>
</tr>
</tbody>
</table>

**Note:** The time specification is absolute, i.e. the switching point varies according to the velocity of the robot.

```
LIN P1 VEL=0.3m/s CPDAT1
LIN P2 VEL=0.3m/s CPDAT2
SYN OUT 1 " State= TRUE at START Delay=20ms
SYN OUT 2 " State= TRUE at END Delay=-20ms
LIN P3 VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
```

![Fig. 8-39](image)

OUT 1 and OUT 2 specify approximate positions at which switching is to occur. The dotted lines indicate the switching limits.

Switching limits:
- **START**: The switching point can be delayed, at most, as far as exact positioning point P3 (+ ms).
- **END**: The switching point can be brought forward, at most, as far as exact positioning point P2 (- ms).

If greater values are specified for the delay, the controller automatically switches at the switching limit.

### Example 2

Start point is exact positioning point, end point is approximated.

```
LIN P1 VEL=0.3m/s CPDAT1
LIN P2 VEL=0.3m/s CPDAT2
SYN OUT 1 " State= TRUE at START Delay=20ms
SYN OUT 2 " State= TRUE at END Delay=-20ms
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
```
OUT 1 and OUT 2 specify approximate positions at which switching is to occur. The dotted lines indicate the switching limits. M = middle of the approximate positioning range.

Switching limits:

- **START**: The switching point can be delayed, at most, as far as the start of the approximate positioning range of P3 (+ ms).
- **END**: The switching point can be brought forward, at most, as far as the start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the approximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switches at the switching limit.

**Example 3**

Start point and end point are approximated

```plaintext
LIN P1 VEL=0.3m/s CPDAT1
LIN P2 CONT VEL=0.3m/s CPDAT2
SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
```

OUT 1 and OUT 2 specify approximate positions at which switching is to occur. The dotted lines indicate the switching limits. M = middle of the approximate positioning range.
Switching limits:

- **START**: The switching point can be situated, at the earliest, at the end of the approximate positioning range of P2.
  The switching point can be delayed, at most, as far as the start of the approximate positioning range of P3 (+ ms).
- **END**: The switching point can be brought forward, at most, as far as the start of the approximate positioning range of P3 (-).
  The switching point can be delayed, at most, as far as the end of the approximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switches at the switching limit.

### 8.6.15 Inline form “SYN OUT”, option “PATH”

The switching action refers to the end point of the motion. The switching action can be shifted in space and delayed or brought forward. The motion can be a LIN or CIRC motion. It must not be a PTP motion.

**Fig. 8-42: Inline form “SYN OUT”, option “PATH”**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output number</td>
</tr>
<tr>
<td>2</td>
<td>If a name exists for the output, this name is displayed. Only for the user group &quot;Expert&quot;: A name can be entered by pressing <strong>Long text</strong>. The name is freely selectable.</td>
</tr>
<tr>
<td>3</td>
<td>State to which the output is switched</td>
</tr>
<tr>
<td>4</td>
<td>PATH: SYN OUT refers to the end point of the motion.</td>
</tr>
<tr>
<td>5</td>
<td>This box is only displayed if PATH has been selected. Distance from the switching point to the end point</td>
</tr>
<tr>
<td>6</td>
<td>Switching action delay</td>
</tr>
</tbody>
</table>

**Note**: The time specification is absolute, i.e. the switching point varies according to the velocity of the robot.

**Example 1**

Start point is exact positioning point, end point is approximated.

```
LIN P1 VEL=0.3m/s CPDAT1
SYN OUT 1 '" State= TRUE at START PATH=20mm Delay=-5ms
LIN P2 CONT VEL=0.3m/s CPDAT2
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
```
OUT 1 specifies the approximate position at which switching is to occur. The dotted lines indicate the switching limits. M = middle of the approximate positioning range.

Switching limits:

- The switching point can be brought forward, at most, as far as exact positioning point P1.
- The switching point can be delayed, at most, as far as the next exact positioning point P4. If P3 was an exact positioning point, the switching point could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller automatically switches at the switching limit.

Example 2

Start point and end point are approximated

```
LIN P1 CONT VEL=0.3m/s CPDAT1
SYN OUT 1 '' State=TRUE at START PATH=20mm Delay=-5ms
LIN P2 CONT VEL=0.3m/s CPDAT2
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
```

OUT 1 specifies the approximate position at which switching is to occur. The dotted lines indicate the switching limits. M = middle of the approximate positioning range.
Switching limits:
- The switching point can be brought forward, at most, as far as the start of the approximate positioning range of P1.
- The switching point can be delayed, at most, as far as the next exact positioning point P4. If P3 was an exact positioning point, the switching point could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller automatically switches at the switching limit.

### 8.6.16 Setting a pulse on the path - SYN PULSE

**Precondition**
- A program is selected.
- Operating mode T1

**Procedure**
1. Position the cursor in the line after which the logic instruction is to be inserted.
2. Select the menu sequence **Commands > Logic > OUT > SYN PULSE**.
3. Set the parameters in the inline form.
   (>>> 8.6.17 "Inline form “SYN PULSE” Page 221)
4. Save instruction with **Cmd Ok**.

### 8.6.17 Inline form “SYN PULSE”

SYN PULSE can be used to trigger a pulse at the start or end point of the motion. The pulse can be shifted in time and/or space, i.e. it does not have to be triggered exactly at the point, but can also be triggered before or after it.

![Fig. 8-45: Inline form “SYN PULSE”](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output number</td>
</tr>
</tbody>
</table>
| 2    | If a name exists for the output, this name is displayed.  
Only for the user group “Expert”:
A name can be entered by pressing **Long text**. The name is freely selectable. |
| 3    | State to which the output is switched  
- TRUE  
- FALSE |
| 4    | Duration of the pulse  
- 0.1 … 3 s |
### Precondition
- A program is selected.
- Operating mode T1

### Procedure
1. Position the cursor in the line containing the instruction that is to be changed.
2. Press Change. The inline form for this instruction is opened.
3. Change the parameters.
4. Save changes by pressing Cmd Ok.

#### Item Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5    | Point to which SYN PULSE refers:  
- START: Start point of the motion  
- END: End point of the motion  
See SYN OUT for examples and switching limits.  
(>>> 8.6.14 "Inline form “SYN OUT”, option “START/END”"  
Page 216)  
- PATH: SYN PULSE refers to the end point. An offset in space is also possible. 
See SYN OUT for examples and switching limits.  
(>>> 8.6.15 "Inline form “SYN OUT”, option “PATH”" Page 219) |
| 6    | Distance from the switching point to the end point  
- -2,000 … +2,000 mm  
This box is only displayed if PATH has been selected. |
| 7    | Switching action delay  
- -1,000 … +1,000 ms  
**Note:** The time specification is absolute. The switching point varies according to the velocity of the robot. |
# 9 Messages

## 9.1 Automatic External error messages

<table>
<thead>
<tr>
<th>No.</th>
<th>Message text</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>P00:1</td>
<td>PGNO_TYPE incorrect value permissible values (1,2,3)</td>
<td>The data type for the program number was entered incorrectly.</td>
</tr>
<tr>
<td>P00:2</td>
<td>PGNO_LENGTH incorrect value Range of values $1 \leq$ PGNO_LENGTH $\leq$ 16</td>
<td>The selected program number length in bits was too high.</td>
</tr>
<tr>
<td>P00:3</td>
<td>PGNO_LENGTH incorrect value permissible values (4,8,12,16)</td>
<td>If BCD format was selected for reading the program number, a corresponding number of bits must also be set.</td>
</tr>
<tr>
<td>P00:4</td>
<td>PGNO_FBIT incorrect value not in the $\text{IN}$ range</td>
<td>The value &quot;0&quot; or a non-existent input was specified for the first bit of the program number.</td>
</tr>
<tr>
<td>P00:7</td>
<td>PGNO_REQ incorrect value not in the $\text{OUT}$ range</td>
<td>The value &quot;0&quot; or a non-existent output was specified for the output via which the program number is to be requested.</td>
</tr>
<tr>
<td>P00:10</td>
<td>Transmission error incorrect parity</td>
<td>Discrepancy detected when checking parity. A transmission error must have occurred.</td>
</tr>
<tr>
<td>P00:11</td>
<td>Transmission error incorrect program number</td>
<td>The higher-level controller has transferred a program number for which there is no CASE branch in the file CELL_SRC.</td>
</tr>
<tr>
<td>P00:12</td>
<td>Transmission error incorrect BCD encoding</td>
<td>The attempt to read the program number in BCD format led to an invalid result.</td>
</tr>
<tr>
<td>P00:13</td>
<td>Incorrect operating mode</td>
<td>The I/O interface output has not been activated, i.e. the system variable $\text{I_O_ACTCONF}$ currently has the value FALSE. This can have the following causes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>\begin{itemize} \item The mode selector switch is not in the “Automatic External” position. \item The signal $\text{I_O_ACT}$ currently has the value FALSE. \end{itemize}</td>
</tr>
<tr>
<td>P00:14</td>
<td>Move to Home position in operating mode T1</td>
<td>The robot has not reached the HOME position.</td>
</tr>
<tr>
<td>P00:15</td>
<td>Incorrect program number</td>
<td>More than one input set with “1 of n”.</td>
</tr>
</tbody>
</table>
10 KUKA Service

10.1 Requesting support

Introduction The KUKA Roboter GmbH documentation offers information on operation and provides assistance with troubleshooting. For further assistance, please contact your local KUKA subsidiary.

Information The following information is required for processing a support request:

- Model and serial number of the robot
- Model and serial number of the controller
- Model and serial number of the linear unit (if applicable)
- Model and serial number of the energy supply system (if applicable)
- Version of the KUKA System Software
- Optional software or modifications
- Archive of the software
  For KUKA System Software V8: instead of a conventional archive, generate the special data package for fault analysis (via KrcDiag).
- Application used
- Any external axes used
- Description of the problem, duration and frequency of the fault

10.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesitate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)
Luis Angel Huergo 13 20
Parque Industrial
2400 San Francisco (CBA)
Argentina
Tel. +54 3564 421033
Fax +54 3564 428877
ventas@costantini-sa.com

Australia Headland Machinery Pty. Ltd.
Victoria (Head Office & Showroom)
95 Highbury Road
Burwood
Victoria 31 25
Australia
Tel. +61 3 9244-3500
Fax +61 3 9244-3501
vic@headland.com.au
www.headland.com.au
France  
KUKA Automatisme + Robotique SAS  
Techvallée  
6, Avenue du Parc  
91140 Villebon S/Yvette  
France  
Tel. +33 1 6931660-0  
Fax +33 1 6931660-1  
commercial@kuka.fr  
www.kuka.fr

India  
KUKA Robotics India Pvt. Ltd.  
Office Number-7, German Centre,  
Level 12, Building No. - 9B  
DLF Cyber City Phase III  
122 002 Gurgaon  
Haryana  
India  
Tel. +91 124 4635774  
Fax +91 124 4635773  
info@kuka.in  
www.kuka.in

Italy  
KUKA Roboter Italia S.p.A.  
Via Pavia 9/a - int.6  
10098 Rivoli (TO)  
Italy  
Tel. +39 011 959-5013  
Fax +39 011 959-5141  
kuka@kuka.it  
www.kuka.it

Japan  
KUKA Robotics Japan K.K.  
YBP Technical Center  
134 Godo-cho, Hodogaya-ku  
Yokohama, Kanagawa  
240 0005  
Japan  
Tel. +81 45 744 7691  
Fax +81 45 744 7696  
info@kuka.co.jp

Canada  
KUKA Robotics Canada Ltd.  
6710 Maritz Drive - Unit 4  
Mississauga  
L5W 0A1  
Ontario  
Canada  
Tel. +1 905 670-8600  
Fax +1 905 670-8604  
info@kukarobotics.com  
www.kuka-robotics.com/canada
<table>
<thead>
<tr>
<th>Country</th>
<th>Address</th>
<th>Telephone</th>
<th>Fax</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poland</td>
<td>KUKA Roboter Austria GmbH</td>
<td>+48 327 30 32 13 or -14</td>
<td>+48 327 30 32 26</td>
<td><a href="mailto:ServicePL@kuka-roboter.de">ServicePL@kuka-roboter.de</a></td>
</tr>
<tr>
<td>Portugal</td>
<td>KUKA Sistemas de Automatización S.A.</td>
<td>+351 265 729780</td>
<td>+351 265 729782</td>
<td><a href="mailto:kuka@mail.telepac.pt">kuka@mail.telepac.pt</a></td>
</tr>
<tr>
<td>Russia</td>
<td>OOO KUKA Robotics Rus</td>
<td>+7 495 781-31-20</td>
<td>+7 495 781-31-19</td>
<td>kuka-robotics.ru</td>
</tr>
<tr>
<td>Sweden</td>
<td>KUKA Svetsanläggningar + Robotar AB</td>
<td>+46 31 7266-200</td>
<td>+46 31 7266-201</td>
<td><a href="mailto:info@kuka.se">info@kuka.se</a></td>
</tr>
<tr>
<td>Switzerland</td>
<td>KUKA Roboter Schweiz AG</td>
<td>+41 44 74490-90</td>
<td>+41 44 74490-91</td>
<td><a href="mailto:info@kuka-roboter.ch">info@kuka-roboter.ch</a></td>
</tr>
</tbody>
</table>
Hungary
KUKA Robotics Hungaria Kft.
Fö út 140
2335 Taksony
Hungary
Tel. +36 24 501609
Fax +36 24 477031
info@kuka-robotics.hu

USA
KUKA Robotics Corporation
51870 Shelby Parkway
Shelby Township
48315-1787
Michigan
USA
Tel. +1 866 873-5852
Fax +1 866 329-5852
info@kukarobotics.com
www.kukarobotics.com

UK
KUKA Automation + Robotics
Hereward Rise
Halesowen
B62 8AN
UK
Tel. +44 121 585-0800
Fax +44 121 585-0900
sales@kuka.co.uk
Index

Symbols
#BSTEP 146
#ISTEP 146
#MSTEP 146
$ANIN 211
$ANOUT 211
$IN 211
$OUT 211
$ROBRUNTIME 83, 84

Numbers
2004/108/EC 40
2006/42/EC 40
3-point method 115
89/336/EEC 40
95/16/EC 40
97/23/EC 40

A
ABC 2-point method 112
ABC World method 112
Accessories 13, 17
Actual position 75
Administrator 59
Advance run 147
ANOUT 212
Applied norms and regulations 40
Approximate positioning 161, 184
Archiving overview 153
Archiving, logbook 156
Archiving, network 155
Archiving, to USB stick 155
ASCII Mode (menu item) 145
Automatic External error messages 223
Automatic mode 37
Auxiliary point 160
Axis range 19
Axis range limitation 28
Axis range monitoring 29

B
Backward motion 149
Base calibration 114
BASE coordinate system 60, 114
Block pointer 142
Block selection 149, 166
Brake defect 32
Brake release device 29
Braking distance 19

C
Calibrating an external kinematic system 126
Calibration 107
Calibration points (menu item) 82
Calibration, base 114
Calibration, external TCP 118
Calibration, fixed tool 118
Calibration, linear unit 124
Calibration, root point, kinematic system 126
Calibration, tool 107
Calibration, TOOL kinematic system 130
Calibration, workpiece 118
Cancel program 142
CE mark 18
CELL.SRC 150
CIRC motion 181
CIRC, motion type 160
Circular angle 191, 202
Cleaning work 38
Cold start 54
Cold start, initial 53, 54
Collision detection 183
Comment 152
Connecting cables 13, 17
Connection manager 44
Constant velocity range 197, 208
Continuous Path 159
Coordinate system for jog keys 48
Coordinate system for Space Mouse 47
Coordinate systems 60
Coordinate systems, angles 61
Coordinate systems, orientation 61
Copy 153
Counterbalancing system 38
Counters, displaying 80
CP motions 159
CP spline block 185
Creating a new folder 140
Creating a new program 141
CRR 19
Cut 153

D
Danger zone 19
Data, restoring 156
Declaration of conformity 18
Declaration of incorporation 17, 18
Decommissioning 39
DEF line (menu item) 145
DEF line, displaying/hiding 145
Deleting mastering 105
Detail view, activating 145
Dial gauge 95
Directory structure 139
Displaying, robot controller information 83
Displaying, robot information 83
Disposal 39
Documentation, industrial robot 11
Drive bus 53

E
EC declaration of conformity 18
Edit (button) 48
Editing a program 150
Editor 141
Electronic Mastering Device 90

Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)
EMC Directive 18, 40
EMD 90
EMERGENCY STOP 44
EMERGENCY STOP device 25, 26, 31
EMERGENCY STOP, external 26, 34
EMERGENCY STOP, local 34
EN 60204-1 41
EN 61000-6-2 41
EN 61000-6-4 41
EN 614-1 41
EN ISO 10218-1 41
EN ISO 12100 41
EN ISO 13849-1 40
EN ISO 13849-2 41
EN ISO 13850 40
Enabling device 27, 31
Enabling switch 45
Enabling switches 27
Energy consumption, measuring 73
error messages, Automatic External 223
Exiting, KSS 51
External axes 17, 20, 75, 83
External kinematic system, calibration 126

F
Faults 32
File list 139
File, renaming 141
Filter 140
Find 153
First mastering 91, 99
Fixed tool, calibration 118
Flags, displaying 78, 79
FLANGE coordinate system 61, 108
Folder, creating 140
Function test 34

G
General safety measures 32
Guard interlock 25

H
Hazardous substances 39
Header 139
Hibernate 54
HOME position 145
HOV 66

I
Identification plate 45
Increment 71
Incremental jogging 71
Indirect method 116, 117
Industrial robot 13, 17
Info (menu item) 83
Inline forms 179
Inputs/outputs, analog 77, 211
Inputs/outputs, Automatic External 77
Inputs/outputs, digital 75, 211
Intended use 14, 17

J
Jerk 188, 189, 193, 195, 200, 203
Jog keys 44, 62, 67
Jog mode 28, 31
Jog mode “Jog keys” 64
Jog mode “Space Mouse” 64
Jog mode, activating 66
Jog override 66
Jogging, axis-specific 61, 67
Jogging, Cartesian 61, 67, 70
Jogging, external axes 72
Jogging, robot 61

K
KCP 19, 32, 43
Keyboard 44
Keyboard key 44
Keypad 50
Kinematics group 48, 64
KUKA Control Panel 43
KUKA Customer Support 83, 225
KUKA smartHMI 47
KUKA smartPAD 19, 43
KUKA.Load 132
KUKA.LoadDataDetermination 132

L
Labeling 30
Language 54
Liability 17
LIN motion 180
LIN, motion type 160
Line break (menu item) 146
Linear unit 17, 123
Load data 132
Long texts, exporting 134
Long texts, importing 134
Loss of mastering 91, 94, 99, 103
Low Voltage Directive 18

M
Machine data 34, 83, 84, 85
Machinery Directive 18, 40
Main menu, calling 50
Maintenance 37, 136
Manipulator 13, 17, 19, 22
Manual mode 36
Mastering 87
Mastering after maintenance work 97
Mastering marks 89
Mastering methods 88
Mechanical axis range limitation 28
Mechanical end stops 28
MEMD 98
Messages 223
Micro Electronic Mastering Device 98
Mode selection 23, 24
Modifying a logic instruction 222
Modifying coordinates 210
Modifying motion parameters 210
Module 56
Monitoring, velocity 28
Motion programming, basic principles 159
Motion types 159
Motor, exchange 97

N
Name, archive 84
Name, control PC 83
Name, robot 83, 84
Navigator 139
Numeric entry, external TCP 120
Numeric entry, external tool 131
Numeric entry, linear unit 125
Numeric entry, root point, kinematic system 127
Numeric input, tool 114

O
Offset 91, 93, 99, 102, 213
Opening a program 141
Operating hours 84
Operating hours meter 84
Operating mode, changing 59
Operation 43
Operator 19, 21, 58
Operator safety 23, 25, 31
Options 13, 17
Orientation control, LIN, CIRC 162
Orientation control, spline 174
OUT 211
Output, analog 212
Output, digital 211
Overload 32
Override 66, 147
Override (menu item) 73
Overview of the industrial robot 13

P
Palletizing robots 109, 114
Panic position 27
Paste 153
Payload data 132
Payload data (menu item) 133
Performance Level 23
Personnel 20
Plant integrator 20
Point-to-point 159
Positionally accurate robot, checking activation 87
Positioner 17, 126
POV 147
Pre-mastering position 89
Pressure Equipment Directive 38, 40
Preventive maintenance work 38
Printing a program 153
Product description 13
PROFlenergy 73
Program lines, deleting 152
Program management 139
Program override 147
Program run mode, selecting 146
Program run modes 146
Program, cancel 142
Program, closing 143
Program, creating 141
Program, opening 141
Program, selecting 141
Program, starting 148
Program, stopping 148, 149, 150
Programmer 58
Programming, inline forms 179
Programming, User 179
Protective equipment 28
PTP motion 179
PTP spline block 185
PTP, motion type 159
PULSE 212
Pulse 212
Pulse, path-related 221

R
Rating plate 85
RDC, exchange 97
Re-teaching 210
Reaction distance 19
Recommissioning 33, 85
Reference mastering 97
Release device 29
Renaming a file 141
Renaming the base 122
Renaming the tool 122
Repair 37
Replace 153
Resetting a program 150
Robot controller 13, 17
Robot data (menu item) 83
ROBROOT coordinate system 60

S
Safe operational stop 19, 27
Safeguards, external 31
Safety 17
Safety controller 24
Safety functions 31
Safety functions, overview 23
Safety instructions 11
Safety STOP 0 19
Safety STOP 1 19
Safety STOP 2 20
Safety STOP 0 19
Safety STOP 1 19
Safety STOP 2 20
Safety stop, external 27, 28
Safety zone 19, 22
Safety, general 17
SCIRC motion, programming 201
SCIRC segment, programming 190
Selecting a program 141
Selecting the base 66

Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)
Selecting the tool 66
Serial number 84
Service life 19, 83
Service, KUKA Roboter 225
Shutdown (menu item) 51
Simulation 37
Single point of control 39
Singularities 177
Singularity, CP spline 174
SLIN motion, programming 199
SLIN segment, programming 189
smartHMI 13, 47
smartPAD 19, 43
Software 13, 17
Software limit switches 28, 31, 105
Software limit switches, modifying 105
Space Mouse 44, 62, 67, 69, 70
Special characters 179
SPL segment, programming 189
Spline block, programming 185
Spline segment 163
Spline, motion type 163
SPOC 39
SPTP motion, programming 204
SPTP segment, programming 191
Stamp 152
Start backwards key 44
Start key 44, 45
Start types 54
Start-up 33, 85
Start-up mode 35
Start-up wizard 85
Starting a program, automatic 148
Starting a program, backwards 149
Starting a program, manual 148
Starting Automatic External mode 150
Starting the KSS 50
Status bar 47, 48, 139
Status keys 44
STOP 0 18, 20
STOP 1 18, 20
STOP 2 18, 20
Stop category 0 20
Stop category 1 20
Stop category 2 20
STOP key 44
Stop reactions 22
Stopping a program 148, 149, 150
Stopping distance 19, 22
Storage 39
Storage capacities 83
Submit interpreter 49
Submit interpreter, status indicator 49
Supplementary load data (menu item) 133
Support request 225
Switching action, path-related 216
Switching on the robot controller 50
SYN OUT 216
SYN PULSE 221
System integrator 18, 20, 21
System requirements 14

T
T1 20
T2 20
Target group 11
TCP 107
TCP, external 118
Teach pendant 13, 17
Teaching 210
Technology packages 13, 83, 179
Terms used, safety 18
Timers, displaying 81
Tool calibration 107
Tool Center Point 107
TOOL coordinate system 60, 107
Tool, external 130
Touch screen 43, 50
Trademarks 12
Training 11
Transportation 33
Trigger, for spline inline form 195
Turn-tilt table 17, 126
Type, robot 83
Type, robot controller 83

U
Unmastering 105
USB connection 45
USB sticks 14
Use, contrary to intended use 17
Use, improper 17
User 19, 20
User group, changing 58
User group, default 58
User interface 47

V
Velocity 66, 147
Velocity monitoring 28
Version, kernel system 83
Version, operating system 83
Version, robot controller 83
Version, user interface 83
Voltage 77, 213, 214

W
WAIT 214
Wait function, signal-dependent 214
Wait time 214
WAITFOR 214
Warnings 11
Working range limitation 28
Workpiece base calibration 128
Workpiece base, numeric entry 130
Workspace 19, 22
Workspace monitoring, bypassing 72
WORLD coordinate system 60

X
XYZ 4-point method 109
XYZ Reference method 111